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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings
of the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this
manual.

Symbols used in manual

f DANGER This indicates a very dangerous procedure that could result in serious injury or
death if not performed properly.

A WARN I N GThis indicates a hazardous procedure that could result in serious injury or death if

not performed properly.

A CAUTION This indicates a hazardous procedure or danger that could result in light-to-severe
injury, or loss related to equipment malfunction, if proper precautions are not taken.

Safety Symbols Used on Equipment and in Manual

The following safety symbols are used inside or on the equipment near operation locations to provide information
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols
and take the necessary precautions BEFORE using the equipment.

This indicates a prohibited operation. The prohibited operation is indicated
symbolically in or near the barred circle.

indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically in or
near the triangle.

O This indicates an obligatory safety precaution. The obligatory operation is

This indicates a note. The contents are described in the box.

(Xé E These indicate that the marked part should be recycled.
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Equipment Certificate

Anritsu Corporation guarantees that this equipment was inspected at
shipment and meets the published specifications.

Anritsu Warranty

o During the warranty period, Anritsu Corporation will repair or exchange this
software free-of-charge if it proves defective when used as described in the
operation manual.

e The warranty period is 6 months from the purchase date.

e The warranty period after repair or exchange will remain 6 months from
the original purchase date, or 30 days from the date of repair or
exchange, depending on whichever is longer.

e This warranty does not cover damage to this software caused by Acts of
God, natural disasters, and misuse or mishandling by the customer.

In addition, this warranty is valid only for the original equipment purchaser. It
is not transferable if the equipment is resold.

Anritsu Corporation shall assume no liability for injury or financial loss of the
customer due to the use of or a failure to be able to use this equipment.

Anritsu Corporation Contact

In the event that this equipment malfunctions, contact an Anritsu Service and
Sales office. Contact information can be found on the last page of the printed
version of this manual, and is available in a separate file on the CD version.
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Notes On Export Management

This product and its manuals may require an Export License/Approval by
the Government of the product's country of origin for re-export from your
country.

Before re-exporting the product or manuals, please contact us to confirm
whether they are export-controlled items or not.

When you dispose of export-controlled items, the products/manuals need
to be broken/shredded so as not to be unlawfully used for military purpose.




Software End-User License Agreement (EULA)

Please read this Software End-User License Agreement (hereafter this EULA) carefully before using
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios,
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment
(hereafter Equipment) for the purposes set out in this EULA.

1. Grant of License and Limitations 3. Limitation of Liability
1. Regardless of whether this Software was a. If a fault (bug) is discovered in this Software,

purchased from or provided free-of-charge by
Anritsu, you agree not to rent, lease, lend, or
otherwise distribute this Software to third
parties and further agree not to disassemble,
recompile, reverse engineer, modify, or create
derivative works of this Software.

. You may make one copy of this Software for
backup purposes only.

. You are not permitted to reverse engineer

preventing operation as described in the
operation manual or specifications whether
or not the customer uses this software as
described in the manual, Anritsu shall at its
own discretion, fix the bug, or exchange the
software, or suggest a workaround,
free-of-charge. However, notwithstanding
the above, the following items shall be

excluded from repair and warranty.

this software. i) If this Software is deemed to be used for

4. This EULA allows you to install one copy of purposes not described in the operation

this Software on one piece of Equipment. manual or specifications.

2. Disclaimers ii) If this Software is used in conjunction with

To the extent not prohibited by law, in no other non-Anritsu-approved software.
event shall Anritsu be liable for personal iii) Recovery of lost or damaged data.
injury, or any incidental, special, indirect or iv) If this Software or the Equipment has been
consequential damages whatsoever, modified, repaired, or otherwise altered
including, without limitation, damages for without Anritsu's prior approval.

loss of profits, loss of data, business v) For any other reasons out of Anritsu's direct

interruption or any other commercial control and responsibility, such as but not

damages or losses, arising out of or related limited to, natural disasters, software virus
to your use or inability to use this Software. infections, etc.

b. Expenses incurred for transport, hotel, daily
allowance, etc., for on-site repairs by Anritsu
engineers necessitated by the above faults
shall be borne by you.

c. The warranty period for faults listed in
article 3a above covered by this EULA shall
be either 6 months from the date of purchase
of this Software or 30 days after the date of

repair, whichever is longer.



4. Export Restrictions

vi

You may not use or otherwise export or
re-export directly or indirectly this Software
except as authorized by Japanese and
United States law. In particular, this
software may not be exported or re-exported
(a) into any Japanese or US embargoed
countries or (b) to anyone on the Japanese or
US Treasury Department's list of Specially
Designated Nationals or the US Department
of Commerce Denied Persons List or Entity
List. By using this Software, you warrant
that you are not located in any such country
or on any such list. You also agree that you
will not use this Software for any purposes
prohibited by Japanese and US law,
including, without limitation, the
development, design and manufacture or
production of missiles or nuclear, chemical or
biological weapons of mass destruction.

Termination

Anritsu shall deem this EULA terminated if
you violate any conditions described herein.
This EULA shall also be terminated if the
conditions herein cannot be continued for
any good reason, such as violation of
copyrights, patents, or other laws and
ordinances.

Reparations

If Anritsu suffers any loss, financial or
otherwise, due to your violation of the terms
of this EULA, Anritsu shall have the right to
seek proportional damages from you.
Responsibility after Termination

Upon termination of this EULA in
accordance with item 5, you shall cease all
use of this Software immediately and shall
as directed by Anritsu either destroy or
return this Software and any backup copies,
full or partial, to Anritsu.

Dispute Resolution

If matters of dispute or items not covered by
this EULA arise, they shall be resolved by
negotiations in good faith between you and
Anritsu.

Court of Jurisdiction

This EULA shall be interpreted in
accordance with Japanese law and any
disputes that cannot be resolved by
negotiation described in Article 8 shall be
settled by the Japanese courts.



Cautions against computer virus infection

Copying files and data

Only files that have been provided directly from Anritsu or generated
using Anritsu equipment should be copied to the instrument.

All other required files should be transferred by means of USB or
CompactFlash media after undergoing a thorough virus check.
Adding software

Do not download or install software that has not been specifically
recommended or licensed by Anritsu.

Network connections

Ensure that the network has sufficient anti-virus security protection in
place.

vii



CE Conformity Marking

Anritsu affixes the CE conformity marking on the following product(s) in
accordance with the Council Directive 93/68/EEC to indicate that they
conform to the EMC and LVD directive of the European Union (EU).

CE marking

1. Product Model
Software: MX370107A Fading IQproducer™

2. Applied Directive and Standards
When the MX370107A Fading IQproducer™ is installed in the
MG3710A/MG3740A, the applied directive and standards of this software
conform to those of the MG3710A/MG3740A main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MX370107A can be used with.

viil



C-tick Conformity Marking

Anritsu affixes the C-tick mark on the following product(s) in accordance with
the regulation to indicate that they conform to the EMC framework of
Australia/New Zealand.

C-tick marking

CN274

1. Product Model
Software: MX370107A Fading IQproducer™

2. Applied Directive and Standards
When the MX370107A Fading IQproducer™ is installed in the MG3710A,
the applied directive and standards of this software conform to those of
the MG3710A main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MX370107A can be used with.
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About This Manual

B Associated Documents

The operation manual configuration of the MX370107A Fading I1Qpro-

ducer™ is shown below.

B If using MG3700A, MG3710A or MG3740A:

MG3700A MG3710A Vector Signal Generator
Vector Signal Generator 4= | \\G3740A Analog Signal Generator
Operation Manual (Mainframe) Or | Operation Manual (Mainframe)

MG3700A /MG3710A Vector Signal Generator
|| MG3740A Analog Signal Generator Operation Manual (IQproducer™)

MX370107A
Fading IQproducer™ Operation Manual

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
This describes basic operations, maintenance procedure, and remote
functions of the MG3700A Vector Signal Generator.
I Or

e MG3710A Vector Signal Generator MG3740A Analog Signal Generator

Operation Manual (Mainframe)
This describes basic operations, maintenance procedure, and remote
functions of the MG3710A Vector Signal Generator and the MG3740A
Analog Signal Generator.

e MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (IQproducer™)

This describes the functions and how to use the IQproducer, which is

Windows software for the Vector Signal Generator and the Analog Signal

Generator.

e Fading IQproducer™ Operation Manual (This document)

This describes basic operations and functions of the Fading IQproduc-
erT™,
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Chapter 1 Overview

This chapter provides an overview of the MX370107A Fading
IQproducer™.

1.1 Product OVEIVIEW ......coeeeiiiiieeeeee e, 1-2
1.2 Product Composition ..........cccceeeeiiiiiiiiiieee e, 1-5
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Chapter 1 Overview

1.1 Product overview

MX370107A Fading IQproducer™ (hereinafter referred to as “this
software”) is software used to read waveform patterns and generate
fading-processed waveform patterns.

This software requires either of the following environment:

*+ MG3710A Vector Signal Generator
+ MG3740A Analog Signal Generator
+ Personal computer (hereinafter, “PC”)

This software generates waveform patterns that support the
specifications of fading with various characteristics. This is made

possible by the editing/customizing of parameters according to its use.

A waveform pattern created by this software can be output using an RF
signal after being downloaded into the MG3700A Vector Signal Generator,
MG3710A Vector Signal Generator or MG3740A Analog Signal Generator
(collectively referred to as “mainframe”, or “this equipment”).

With the MX370107A, fading processing of each channel, correlation
matrix calculation, and AWGN addition can be performed as shown in
the dotted rectangle in the operation flow of Fig. 1.1-1. ASCII format
files created using simulation software in addition to waveform pattern
files created using IQproducer™ can be specified for IQ data files to be

input.

This software can also simulate the propagation environment between
transmission and reception antennas. A configuration example when
using a 2 x 2 MIMO configuration with this software is shown in Fig.
1.1-2. In this example, this software performs fading processing for the
waveform pattern files that correspond to the signals transmitted from
each of the transmission antennas, and outputs the fading-processed
waveform pattern files from two MG3700A/MG3710A/MG3740A units,
simulating the propagation environment between transmission and
reception antennas in 2 x 2 MIMO. Refer to Chapter 3 “Detailed
Description of Functions” for details on this software, and refer to
Appendix C “Connecting Multiple MG3700A/10A/40A Units” for how to
synchronize two or more MG3700A/MG3710A/MG3740A units.




1.1  Product overview

IQproducer™,
Simulation Software

MG3700A/MG3710A

waveform pattern file
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Fig. 1.1-1 Fading processing flow
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Fig.1.1-2 2 x 2 MIMO configuration example




1.2  Product Composition

1.2 Product Composition

The following table lists the model name and specifications of this

software according to the equipment.

Table 1.2-1 Restrictions
Mainframe
MG3700A MG3710A MG3740A

Restriction
Software MX370107A
name
Maximum 64 M sample . 64 M sample .

. 128 M sample*3 128 M sample*3
Size of | 256 M sample . .

. 256 M sample* 256 M sample*+

Waveform 512 M sample*? . "
Patterns 512 M sample*s 512 M sample*s

1024 M sample™s

Transmissio LAN External External

n method of Com, actFlash device such as device such as
Waveform Car dp LAN, LAN,

Patterns USB memory™ USB memory*2
Installation

of this

software to N/A Possible Possible

this
equipment

*1: The ARB memory expansion 512M sample (optional) must be

installed into the MG3700A to use waveform patterns that exceed
256 M samples.

*2: Transferring waveform patterns is not required if the waveform

patterns are created on the equipment using this software.

*3: The Combination of Baseband Signal (optional) must be installed
into the MG3710A/MG3740A to use waveform patterns of maximum
128 M samples.

*4: The ARB memory expansion 256M sample (optional) must be
installed into the MG3710A/MG3740A to use waveform patterns of
maximum 256 M samples.
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*5:

*6:

To use waveform patterns of maximum 512 M samples, either of the
following must be installed:

MG3710A

e ARB memory expansion 1024 M sample (optional)

¢ ARB memory expansion 256 M (optional) and Combination of
Baseband Signal (optional)

MG3740A

e ARB memory expansion 256 M (optional) and Combination of
Baseband Signal (optional)

The ARB memory expansion 1024M sample (optional) must be

installed into the MG3710A to use waveform patterns of maximum
1024 M samples.

ENotes on waveform pattern conversion

The waveform patterns generated with this software varies according to

the main unit type. If using the waveform pattern to the different main

unit, you need to convert the waveform pattern.

For details about how to convert a waveform pattern, see Section 4.5
“File Conversion on Convert Screen” in the MG3700A/MG3710A Vector
Signal Generator MG3740A Analog Signal Generator Operation Manual
(IQproducer™),




Chapter 2 Preparation

This chapter describes the operating environment for this software.

2.1 Operating Environment.............ccoooviiiieeie e, 2-2
2.2 Installation/Uninstallation........................... 2-3
2.3  Starting up and exiting the software ..............c........... 2-4

2.3.1 Starting Software: When installed on PC ...... 2-4
2.3.3 Starting Software: When installed on

MGSBT710A ... 2-7
2.3.4 Exiting Software...........ccccceeeeiiiiiiiiiieeee e, 2-9
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Chapter 2 Preparation

2.1 Operating Environment

The following environment is required for operating this software.

(1) PC that meets the following conditions

0S

Windows XP/Windows Vista/Windows 7

CPU

Pentium III 1 GHz equivalent or faster

Memory

512 MB or more

Hard disk space

5 GB or more free space in the drive where
this software is to be installed.

The free hard disk space necessary to create
waveform pattern varies depending on the
waveform pattern size. The free disk space of
27 GB or greater is required to create four
maximum (512 Msample) waveform patterns.

(2) If viewing on PC, displays with a resolution of 1024 x 768 pixels are

best viewed using a small font setting.




2.2 Installation/Uninstallation

2.2 Installation/Uninstallation

This software is included in the IQproducer™ installer. It is
automatically installed by installing the IQproducer™ that is supplied
with this equipment or this software. When using a waveform pattern
created using this software in the equipment, the license file must be
installed in advance.

M Installing/Uninstalling 1Qproducer™

Refer to section 2 “Installation/Uninstallation” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (IQproducer™).
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M Installing/Uninstalling IQproducer™ license file
For how to install license file to MG3700A/MG3710A, refer to the
following manual:

e MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™)
5.1 “Installing License File”

For how to uninstall license file from MG3700A/MG3710A, refer to each
one of the following manuals:

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
3.10.10 “Install”

e MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
9.4.4 “Install”




Chapter 2 Preparation

2.3 Starting up and exiting the software

This section explains how to start and stop this software.

Note:
The following explanation assumes the use of Windows XP. The

screen image may differ slightly if not using Windows XP.

2.3.1 Starting Software: When installed on PC

Start this software using the following procedure.
The example assumes that it is a PC operation.

<Procedure>
1. Click Start on the task bar, and point to All Programs. Next, point to
Anritsu Corporation, point to IQproducer, and then click

IQproducer.

v Internet
Internet Explorer
» _9 My Pictures
«| E-mail
- Outlook Express .
@) SetProgram Access and Defaults

Notepad A Windows Catalog

% Windows Update

g’ 8 ICproducer ) Accessories k

— l@ Games v
[ﬁ Calculator ) Startup b

4 & Internet Explarer

g Paint 2 psn

= (5] Outlook Express

| an-5 Keyt ;

@ M-atreen keyl . Remote Assistance
&3 Windows Media Player

'3 Windows Messenger

Al Progrars L - o IQpraducer

I*) Stark J

Figure 2.3.1-1 Program selection screen

2. When IQproducer™ starts, the Select instrument screen is

displayed.
This Select instrument screen is used to select either MG3700A,

MG3710A or MG3740A. This following explanation assumes that
you have selected MG3700.




2.8 Starting up and exiting the software

Select instrument

Select instrument

" MG3T10
" MG3T40
" MS269x
" ns2830

™ Dontshow this window next time

oK

Figure 2.3.1-2 Select Instrument Screen

Notes:
1. This software does not support MS269xA and MS2830A.
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2. To hide this screen and to start with the selected mainframe's

screen from the next time, select the Don't show this window
next time check box.

3. The common platform screen is displayed when OK is clicked in the
Select instrument screen.

The common platform screen is a screen used to select each function
of the IQproducer™.

 1Qproducer for MG3700 (SE1E]

System(Cellular)

System(Non-Cellular)

General Purpose Simulation & Utility ‘

E i B P
D) DD 5 SCD)
w5 ko b7 il ﬁ

LTE FDD LTETDD HSDPAIHSUPA HSDPA/HSUPA Uplink TD-SCDMA
Downlink
W-COMA W-COMA M [DEIDO XGaRMS|
Downlint Upiinki D R
fé% g@ 5 <1 %Ei
'W-CDMA Downlink 'W-CDMA Uplink 1xEVDO FWD 1xEVDO RVS XG-PHS
(Standard) (Standard)

Change Instrument. HELP EXIT

Figure 2.3.1-3 Common Platform Screen

4. Click the General Purpose tab on the common platform screen, to
show the General Purpose selection screen that supports each
telecommunication system.
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A Japroducer for MGB700 BoX

System(Cellular) System(Non-Cellular) General Purpose

Simulation & Utiity |

B A

Convert Clipping

Fading

Change Instrument | HELP ‘ EXIT ‘

Figure 2.3.1-4 General Purpose Selection Screen

5. Click Fading to display the main screen. For details of the main
screen, refer to Chapter 3 “Detailed Description of Functions”.
Note:
If Change Instrument is clicked, the Select instrument screen will
appear each time the software is loaded.




2.8 Starting up and exiting the software

2.3.2 Starting Software: When installed on MG3710A/MG3740A

Start this software using the following procedure.

<Procedure>

1. Press on the MG3710A/MG3740A front panel to display the
common platform screen.

Note:

The common platform screen does not appear when pressing

if Option 020/120 are not installed in the MG3740A.

The common platform screen is a screen used to select each function
of the IQproducer™.

A Iproducer for MG37 10 E el
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=
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System(Cellular) Simulation & Utility ’

System(Non-Cellular) | General Purpose

il i g
D DD SCDI
| - v PR ﬂ
LTE FDD LTE TDD HSDPA/HSUPA HSDPA/HSUPA Uplink TD-SCDMA
Downlink
W-COMA w—colwQ m Vi 15,
Dowilin Uplinkye D s
& Rl 2lers VD o4
W-CDMA Downlink W-CDMA Uplink 1XEVDO FWD 1xEVDO RVS XG-PHS
(Standard) (Standard)
Interface Settings HELP EXIT

Figure 2.3.2-1 Common Platform Screen

2.  Click the General Purpose tab on the common platform screen, to
show the General Purpose selection screen that supports each

telecommunication system.

A 1Gproducer for MG3710 e

System(Cellular) ‘ System(Non-Celllar) ~ General Purpose | Simulation & Utilty |

= I |

Convert Clipping
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Figure 2.3.2-2 General Purpose Selection Screen
3. Click Fading to display the main screen. For details of the main
screen, refer to Chapter 3 “Detailed Description of Functions”.
Note:

When this software is installed on MG3710A/MG3740A, Change
Instrument displays instead of Interface Settings. Clicking
Interface Settings displays the Interface Setting dialog box.

Interface Settings x|

Row Socket Port Number 49152

Wait Time 10

me

Default . Cancel

Figure 2.3.2-3 Interface Settings Dialog Box

Here, you can configure interface-related settings of IQproducer
and MG3710A/MG3740A. To return to factory defaults, click
Default.

e  Row Socket Port Number

Sets Row Socket port number. Set the same value as that for
MG3710A/MG3740A.

e  Wait Time

Sets the wait time between commands.




2.8 Starting up and exiting the software

2.3.3 Exiting Software

Stop this software using the following procedure.

B \When exiting only this software
To exit only this software without closing the Common Platform screen,

or other IQproducer™ tools, do one of these below:

e Click the Exit button ( |&] ) on the tool bar.

e Select Exit from the File menu.
e Click the [X| button on the upper right screen.

Edit  Transfer & Sett

Select Option »
Becall Parameter File
Save Parameter File
Exit
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Figure 2.3.3-1 Exiting Software

The operation of the three screen buttons is explained below.

Exit x|

Do wou want to save the changes?

ez | il |

Figure 2.3.3-2 Exit Confirmation Window

e Yes Saves current parameters to file and stops this
software.
¢ No Stops this software without saving current

parameters to file.
e Cancel or X| Cancels the process and returns to the main screen.

When stopping this software using the Yes button, the saved parameters

are read at the next start and reset for each parameter.

B \When exiting entire IQproducer™ application
To exit all tools of IQproducer™ that are running, select Exit on the
Common Platform Screen. In this case, a dialog is displayed to confirm

stopping of each running tool.
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A I0producer for MG3700

System(Cellular) | Syster(Non-Cellular) | General Purpose

Simulation & Uty ‘

@
LTE FDD LTE TDD HSDPAIHSUPA  HSDPAHSUPA Uplink TD-SCDMA
Downlink
W-CDMA- W-CDMA, XEVDO,
Doﬁnlmk. Uj D RV
3 A A%l
W-CDMA Downlink W-CDMA Uplink 1XEVDO FWD 1XEVDO RVS XG-PHS
(Standard) (Standard)

Change Instrument. ‘ HELP ‘ ; EXIT ?

Figure 2.3.3-3 Exiting IQproducer™

2-10.



Chapter 3 Detailed Description of Functions

This chapter provides detailed descriptions of this software.

Notes:

3.1

3.2
3.3

3.4
3.5

The examples and screens used throughout this chapter are

based on t

he assumption that the IQproducer™ is activated

with the MG3700A.

The MG3710A, MG3740A functions are described as notes in

each item.
Screen DetailS ......ocveveiiiiiie e 3-2
3.1.1 Main SCreen ......ooviiiiiiieiee e 3-2
3.1.2 Common tab wWindow............ccceveiviiiieeiiiiieee 3-9
3.1.3 Channel tab window ............ccceviiniiieiininenn. 3-27
3.1.4 Moving Propagation tab window .................... 3-35
3.1.5 Birth-Death Propagation tab window.............. 3-37
3.1.6 High Speed Train tab window ........................ 3-40
3.1.7 Export File WindOw ..........cccceiiiieiiiniiineee, 3-44
3.1.8 Calculation Window..........cccceeviviveeeniiireeeeen, 3-50
3.1.9 Calculation & Load ...........ccoevvvieeiiiiiieieiiann. 3-52
3.1.10 Calculation & Play ..........cccocveeiiiieeeeiiiireeee, 3-53
Saving/Reading Parameters...........ccccceivieeiiiiienenns 3-54
Waveform Pattern Generation Procedure.................. 3-57
3.3.1 1 x 1 SISO waveform generation.................... 3-57
3.3.2 Moving Propagation waveform generation..... 3-62
3.3.3 Birth-Death Propagation waveform
generation.........cccceiiiiiiiiie e 3-67
3.3.4 High Speed Train waveform generation......... 3-72
3.3.5 2 x 2 MIMO waveform generation.................. 3-77
Displaying Graph ... 3-85
Marker OUEPUL..........eeviiiiiiiiiiieee e, 3-89
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Chapter 8 Detailed Description of Functions

3.1 Screen Details

3.1.1 Main screen

On common platform screen, select the General Purpose tab, and then
select Fading to display the main screen.

Figure 3.1.1-1 shows the main screen of this software. The main screen
consists of the menu, toolbar, Common tab window, Channel tab window,
Birth-Death Propagation tab window, Moving Propagation tab window,
and High Speed Train tab window. The number and type of tabs to be
displayed differ depending on the settings on the Common tab window.

For details on each of the tab windows, refer to the corresponding

sections.

%2 Fading [Qproducer for MG3700 (=13

Eile Edit Transter Setting  Simulation

oy Byl e ol N 4 afl &3 H
'm

Tx Antenna 1 I

Thput Fils : [

i -

[0OODOBOOED — [Daked
te - ’7 [MHz]

RF Frequency

Sampl

Tx Rx

Reterenca |

Delete

AWGN Bandwidth : [MHz]
Ghannel v
T e T =

Tx Antenna 1 Rx Antenna 1 Pattern Leneth [ms]

R Ainterina Gonfiguration

Rox Antenna 1 }

5G Master/Slave Setting :

[~ AWGN
Channel Setting

FINGN Bandwidth : |

Ghannel ]

[MHz]

Fading Profile

[4B]

Moving Speed

Doppler Frequency Marker 2

Marker 3 [

[

|

|

z
Random Seed: | Pattern Sync Marker - [Not Use

Figure 3.1.1-1

Main screen

Menu

Toolbar

Channel setting tab

Tx Antenna Configuration
field

Common setting tab

System Configuration
field

Rx Antenna Configuration
field

Channel Setting field

32



3.1 Screen Details

Screen transition
Figure 3.1.1-2 shows screen transition of this software. For details on
each of the screens, refer to the sections shown below the corresponding

screen.
zl
@ " == = Flease "OK” button to read the fils shomn belo:
. : 7 O G am e [ . .
@ B ol @ ST A @ oA R Input file specified
" T et Ofineation Impart file type: ASCT3
=] e 1 data file name: Pration¥ 0producer¥F adine¥Data¥ TEST Tt
[ — |
o =) = @ data file name Ston¥loproducer¥F adine¥ D a¥ EST 0.6
(i bl Marker data file name: [ation¥Gproducer¥F adine¥Dats¥ TEST Mt
Saroine Rt [T 1wl
™ R Peak value: 1634000000
= " S IO il
e r&—Y P RS value: 16340000
Tx Antenna | R Antenna 1 Patten Lersth ns] Leneth: 2560000

e [OKY[Cancel] button

58 Mostr/Slve Settne

™ AN
Charrel Settg
AN Barchidt ]
Chemnelt
on el

oot [T pam i —
e e Vi Gancel
—= 8 Read confirmation screen
Main screen (Refer to Section 3.1.2
(Refer to Section 3.1.1 “Main screen.”) “Common setting tab window.”)
Calculation [Cancel] Calculation completed: [OK] button
button button During calculation: [Cancel] button
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Export File
Export Fath |C¥Frogram Files¥Anritsu Gorporation¥ldproc [
Package: |
Full Path | Files¥fnritzu Gorporation¥I0producer¥Fading¥Data Creating Parameter File.. ;l
Export File Mame: | Calculating fading wavetorm
Scaling
= RMS Valug  Qutput Gain

[~ Auto Setting [~ @\
kg [OK] button

Comment:
|RF Frequency=1000.00000000 MHz

[AWGN - OFF = Rt

Calculation screen
oo el | (Refer to Section 3.1.8

“Calculation window.”)

Export File window
(Refer to 3.1.7 “Export File window.”)

Figure 3.1.1-2 Overview of screen transition




Chapter 8 Detailed Description of Functions

B The [File] menu contains the following items.

Edit  Transfer Setting  Simulation

Select Option With Option21 (Memaory 512M sample=]

Becall Parameter File ® Without Option21 (Memory 512M samples)
Save Parameter File P— - —
Exit

Figure 3.1.1-3 Screen when File is selected

e Select Option
m  When using MG3700A

Select whether the ARB memory expansion option
256Msamples is installed. Selecting With Option21 (Memory
512M samples) supports creation of larger waveform patterns.
If the ARB memory expansion option is not installed, the
generated waveform pattern may not be able to be used.
Waveform patterns cannot be created with a size greater than
256Msamples or when Without Option21 (Memory 512M
samples) is selected. Select either according to the presence of
ARB memory expansion option.

Table 3.1.1-1 Available Options for MG3700A

Items ARB Memory Expansion
With Option21 (Memory 512M
samples)

Without Option21 (Memory
512M samples):

1 GB x 2 memory

512 MB x 2 Memories

m  When using MG3710A or MG3740A
The presence/absence of the ARB Memory Expansion (option)

and Baseband Signal Combination Function (option) is selected.
Selecting the ARB Memory Expansion (option) and the
Baseband Signal Combination Function (option) generates a
bigger waveform pattern, while selecting the Baseband Signal
Combination Function (option) generates a waveform pattern.
If an uninstalled option is selected, sometimes the created

waveform pattern may not be usable.

Set the combination of installed options based on the following
setting items.




3.1 Screen Details

Table 3.1.1-2 Available Options for MG3710A or MG3740A

Items Combinations of Options
Memory 64M samples None
Memory 64M samples X 2 Option48 and Option 78
Memory 256M samples Option45 or Option 75
Option 45 and Option 48
Memory 256M samples X 2 or
Option 75 and Option 78
Option46
Memory 1024M samples* or
Option 76
Option 46 and Option 48
Memory 1024M samples x 2* or
Option 76 and Option 78

*: Option 46 and Option 76 are not available for MG3740A and do not
appear on the display.

The maximum size of the generated waveform pattern for each

of the setting items is shown below.

Table 3.1.1-3 Waveform Pattern Maximum Size

Items Maximum Size

Memory 64M samples 64M samples
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Memory 64M samples x 2
(With Option48, 78)

Memory 256M samples 256M samples

Memory 256M samples X 2
(With Option48, 78)

Memory 1024M samples* 1024M samples

Memory 1024M samples x 2%
(With Option48, 78)

128M samples

512M samples

1024M samples

*: Does not support MG3740A.

¢ Recall Parameter File
Loads the parameter files saved by the [Save Parameter File] menu.
When the parameter file is loaded, the settings when it was loaded
are recovered.

e Save Parameter File

Saves the current setting parameters to a file.

° Exit

Exits from this software.
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B The [Edit] menu contains the following items.

=8 Transfer Setting  Sim

Galculation

Glippine

Figure 3.1.1-4 Screen when Edit is selected

. Calculation

Generates a waveform pattern.

° Calculation & Load

Note:

This function is available only when this software is used on
MG3710A or MG3740A.

After waveform generation is finished, the created waveform
pattern is loaded into the MG3710A or MG3740A waveform

memory.

. Calculation & Play

Note:

This function is available only when this software is used on
MG3710A or MG3740A.

After waveform generation is finished, the created waveform
pattern is loaded and selected at the MG3710A or MG3740A

waveform memory.

. Copy Channel 1 To All

Copies the Channel 1 settings to all other channels.

. Clipping

Displays the Clipping screen. In this screen, the generated

waveform patterns can be clipped and filtered.




3.1 Screen Details

B The [Transfer Setting] menu contains the following item.

IEGE EREEATTEE  Simulation

Transfer Setting Wizard l

Figure 3.1.1-5 Screen when Transfer Setting is selected

e Transfer Setting Wizard

Displays the Transfer Setting Wizard screen. In this screen, a series
of operations including connection between PC and the
MG3700A/MG3710A/MG3740A, waveform pattern transfer to the
MG3700A/MG3710A/MG3740A internal hard disk, and waveform

pattern loading from the hard disk to an arbitrary waveform

K

memory are performed.

B The [Simulation] menu contains the following items.

| simioton [

CCDF
EFT
Time Domain

Figure 3.1.1-6 Screen when Simulation is selected

e CCDF
Displays the CCDF Graph Monitor screen. In this screen, the CCDF

of the generated waveform pattern is displayed in a graph.

suonoun,j Jo uorpdrIosa(] pafrereq

e FFT

Displays the FFT Graph Monitor screen. In this screen, the
FFT-processed spectrum of the generated waveform pattern is
displayed in a graph.

. Time Domain

Displays the Time Domain Graph Monitor screen. In this screen, the
time-domain waveform of the generated waveform pattern is
displayed in a graph.
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B The Tool buttons contains the following items.
Note:
Calculation & Load and Calculation & Play are available
only when this software is used on MG3710A or MG3740A.

Recall Parameter File
Save Parameter File
Calculation

Calculation & Load

#/fe s

Calculation & Play

fisd Transfer & Setting Wizard
44 ccor

] Time Domain

=
L=
2

5 m

Clipping

Exit

Clicking a tool button operates the same as the corresponding

commands in the menu.




3.1 Screen Details

3.1.2 Common tab window

The Common tab window is shown in Figure 3.1.2-1. The Common tab
window consists of the System Configuration, Tx Antenna Configuration,
Channel Setting, and Rx Antenna Configuration fields.

3—_ Fading IQproducer. for MG3700 E‘El@

Eile Edit Transfer Setting  Simulation

o Byl de A u & K

System Gonfiguration Tx Antenna Gontiguration
Channel Gonfiguration Tx Antenna 1 | 3
Thput File : [ Reference. . .
. Tx Antenna Configuration
i - Delete | .
RF Frequency [MHz1 fleld U
ling Rate s [TO00000D MMl o)
Tx Rx -
AWGN Bandwidth [MHz]
Ghannel v 'Q_‘?
Y +——rb—Y et | = System Configuration field =
Tx Antenna 1 Rx Antenna 1 Pattern Length [ms] Q.|
R Antenna Configuration U
Fex Anterna 1 | 8
SG Master/Slave Setting Q
bd o
[ AWGHN . .
——— Rx Antenna Configuration =3
ANGHN Bandwidth | [MHz] . e
Chanre | field )
G/N: [ [4E] (=}
Fading Profile: |
er i [ =]
Moving Speed: | Tem/h] =
Doppler Frequency : | [Hz] L 'ﬁ
7 Marker 3 [ g
Random Seed: | Pattem Sync Marker - [Nt Use =] Channel Setting field o
.
=]
=]
1]

Figure 3.1.2-1 Common tab window
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3.1.2.1 Tab configuration

The tabs to be displayed differ depending on the Channel Configuration
and Fading Profile settings on the Common tab window. Table 3.1.2.1-1
shows the correspondence between the Channel Configuration and
Fading Profile settings and the tabs to be displayed.

Table 3.1.2.1-1 Settings on Common tab window and displayed tabs

Channel Configuration Fading Profile Tab Displayed

Moving Propagation Moving Propagation setting tab
1 1 SISO Birth-Death Propagation | Birth-Death Propagation setting tab

High Speed Train High Speed Train setting tab

Other than the above Channel 1 setting tab
1 x 2 SIMO Arbitrary Channel 1 and Channel 2 setting tabs
1 x 3 SIMO Arbitrary Channel 1 to Channel 3 setting tabs
1 x 4 SIMO Arbitrary Channel 1 to Channel 4 setting tabs
2 x 1 MISO Arbitrary Channel 1 and Channel 2 setting tabs
2 x 2 MIMO Arbitrary Channel 1 to Channel 4 setting tabs
2 x 3 MIMO Arbitrary Channel 1 to Channel 6 setting tabs
2 x 4 MIMO Arbitrary Channel 1 to Channel 8 setting tabs
3 x 1 MISO Arbitrary Channel 1 to Channel 3 setting tabs
3 x 2 MIMO Arbitrary Channel 1 to Channel 6 setting tabs
3 x 3 MIMO Arbitrary Channel 1 to Channel 9 setting tabs
3 x 4 MIMO Arbitrary Channel 1 to Channel 12 setting tabs
4 x 1 MISO Arbitrary Channel 1 to Channel 4 setting tabs
4 x 2 MIMO Arbitrary Channel 1 to Channel 8 setting tabs
4 x 3 MIMO Arbitrary Channel 1 to Channel 12 setting tabs
4 x 4 MIMO Arbitrary Channel 1 to Channel 16 setting tabs

3-10



3.1 Screen Details

The number of tabs displayed in the Tx Antenna Configuration and Rx

Antenna Configuration fields also changes depending on the Channel

Configuration setting. Table 3.1.2.1-2 shows the correspondence between
the Channel Configuration setting and the tabs to be displayed in the Tx

Antenna Configuration and Rx Antenna Configuration fields.

Table 3.1.2.1-2 Tabs displayed in Tx Antenna Configuration and Rx Antenna Configuration fields

Channel Configuration Tx Antenna Configuration Rx Antenna Configuration
1 x 1 SISO Tx Antenna 1 Rx Antenna 1
1 x 2 SIMO Tx Antenna 1 Rx Antenna 1 and Rx Antenna 2
1 x 3 SIMO Tx Antenna 1 Rx Antenna 1 to Rx Antenna 3
1 x 4 SIMO Tx Antenna 1 Rx Antenna 1 to Rx Antenna 4
2 x 1 MISO Tx Antenna 1 and Tx Antenna 2 | Rx Antenna 1
2 x 2 MIMO Tx Antenna 1 and Tx Antenna 2 | Rx Antenna 1 and Rx Antenna 2
2 x 3 MIMO Tx Antenna 1 and Tx Antenna 2 | Rx Antenna 1 to Rx Antenna 3
2 x 4 MIMO Tx Antenna 1 and Tx Antenna 2 | Rx Antenna 1 to Rx Antenna 4
3 x 1 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1
3 x 2 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 and Rx Antenna 2
3 x 3 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 to Rx Antenna 3
3 x 4 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 to Rx Antenna 4
4 x 1 MISO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1
4 x 2 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 and Rx Antenna 2
4 x 3 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 to Rx Antenna 3
4 x 4 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 to Rx Antenna 4

3-11
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Chapter 8 Detailed Description of Functions

3.1.2.2 Common parameters

System Configuration field

This section describes the parameters provided in the Common tab
window.

Channel Configuration
[Overview] Sets the number of I/O antennas.

[Default] 1 x 1 SISO

[Setting range] 1 x 1 SISO, 1 x 2 SIMO, 1 x 3 SIMO, 1 x 4 SIMO, 2 x 1
MISO, 2 x 2 MIMO, 2 x 3 MIMO, 2 x 4 MIMO, 3 x 1
MISO, 3 x 2 MIMO, 3 x 3 MIMO, 3 x 4 MIMO, 4 x 1
MISO, 4 x 2 MIMO, 4 x 3 MIMO, 4 x 4 MIMO

Channel configurations 1 x 1 SISO to 4 x 4 MIMO can be selected in
Channel Configuration. Each channel configuration is described below.

(1 x 1 SISO)

Communication is performed using a single antenna at each of the
transmission and reception stations in this configuration.

Figure 3.1.2.2-1 is displayed when 1 x 1 SISO is selected in Channel

Configuration.

Tx Rx
AWGN
Channel v
_Y- &Y _
Tx Antenna 1 Rx Antenna 1

Figure 3.1.2.2-1 1 x 1 SISO configuration

(1 x 2 SIMO)

Communication is performed using a single antenna at the transmission
station and two antennas at the reception station in this configuration.
Figure 3.1.2.2-2 is displayed when 1 x 2 SIMO is selected in Channel
Configuration. In this case, two waveform patterns corresponding to the

two Rx antenna modulation signals are generated.

Tx Rx
AWGH
Channel v
‘ »D—»
2
Tx Antenna 1 \ . Rx fAntenna 1
&Y _
Rx Antenna 2

Figure 3.1.2.2-2 1 x 2 SIMO configuration
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3.1 Screen Details

(1 x 3 SIMO)

Communication is performed using a single antenna at the transmission
station and three antennas at the reception station in this configuration.
Figure 3.1.2.2-3 is displayed when 1 x 3 SIMO is selected in Channel
Configuration. In this case, three waveform patterns corresponding to
the three Rx antenna modulation signals are generated.

Tx Rx
AWGN
Channel v

Y9 >
3 v Rx Antenna 1

Tx Antenna 1 \ b _.SL

v Rx Antenna 2
&V _

Rx Antenna 3

Figure 3.1.2.2-3 1 x 3 SIMO configuration

(1 x 4 SIMO)

Communication is performed using a single antenna at the transmission
station and four antennas at the reception station in this configuration.
Figure 3.1.2.2-4 is displayed when 1 x 4 SIMO is selected in Channel
Configuration. In this case, four waveform patterns corresponding to the
four Rx antenna modulation signals are generated.

Tx Rx
AWGH

Y+ >®&—>Y _

4
Tx fAntenna 1 2 \ . Rx Antenna 1
&Y _

- Rx Antenna 2
&Y _
- Rx Antenna 3
&Y _

Rx Antenna 4
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Figure 3.1.2.2-4 1 x 4 SIMO configuration
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(2 x 1 MISO)

Communication is performed using two antennas at the transmission
station and a single antenna at the reception station in this
configuration.

Figure 3.1.2.2-5 is displayed when 2 x 1 MISO is selected in Channel
Configuration.

Tx Rx
AWGHN
Channel

v
Tx Antenna 1 / Rx Antenna 1
Y-

Tx Antenna 2

Figure 3.1.2.2-5 2 x 1 MISO configuration

(2 x 2 MIMO)

Communication is performed using two antennas at each of the
transmission and reception stations in this configuration.

Figure 3.1.2.2-6 is displayed when 2 x 2 MIMO is selected in Channel
Configuration. In this case, two waveform patterns corresponding to the

two Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
' »®—>7_
Y= b
Tx Antenna 1 v Rx Antenna 1
3
Y= &Y
Tx Antenna 2 Rx Antenna 2

Figure 3.1.2.2-6 2 x 2 MIMO configuration

(2 x 3 MIMO)

Communication is performed using two antennas at the transmission
station and three antennas at the reception station in this configuration.
Figure 3.1.2.2-7 is displayed when 2 x 3 MIMO is selected in Channel
Configuration. In this case, three waveform patterns corresponding to

the three Rx antenna modulation signals are generated.

Tx Rx
AWGN
Channel v
' ~® Y
Y= b
Tx Antenna 1 3 v Rx Antenna 1
4
_Y=: &—Y
6
Tx Antenna 2 v Rx Antenna 2
&—Y
Rx Antenna 3

Figure 3.1.2.2-7 2 x 3 MIMO configuration
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3.1 Screen Details

(2 x 4 MIMO)

Communication is performed using two antennas at the transmission
station and four antennas at the reception station in this configuration.
Figure 3.1.2.2-8 is displayed when 2 x 4 MIMO is selected in Channel
Configuration. In this case, four waveform patterns corresponding to the

four Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
f - R T
Tx Antenna 1 4 v Rx Antenna 1
% d—Y
Tx Antenna 2 v Rx Antenna 2
&Y _
v Rx Antenna 3
&—>Y
Rx Antenna 4

Figure 3.1.2.2-8 2 x 4 MIMO configuration

(3 x 1 MISO)

Communication is performed using three antennas at the transmission
station and a single antenna at the reception station in this
configuration.

Figure 3.1.2.2-9 is displayed when 3 x 1 MISO is selected in Channel

Configuration.

)
[}
ﬁ
2]
|'—_I:
@
ol
)
D
)]
Q
]
bd o
=}
=
o
=}
o
=
=
c
=}
Q
=
o
=}
[)]

Tx Rx
AWGN
Ghannel v
_Y- &Y _
Tx Antenna 1 Rx Antenna 1

_Y~
Tx Antenna 2 R

Tx Antenna 3

Figure 3.1.2.2-9 3 x 1 MISO configuration
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(3 x 2 MIMO)

Communication is performed using three antennas at the transmission
station and two antennas at the reception station in this configuration.
Figure 3.1.2.2-10 is displayed when 3 x 2 MIMO is selected in Channel
Configuration. In this case, two waveform patterns corresponding to the

two Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
' >®&—Y
Y= b
Tx Antenna 1 v Rx Antenna 1
Y &—Y
Tx Antenna 2 Rx Antenna 2

e

Tx Antenna 3

Figure 3.1.2.2-10 3 x 2 MIMO configuration

(3 x 3 MIMO)

Communication is performed using three antennas at each of the
transmission and reception stations in this configuration.

Figure 3.1.2.2-11 is displayed when 3 x 3 MIMO is selected in Channel
Configuration. In this case, three waveform patterns corresponding to

the three Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
' ~®—>Y_
Y= ®
Tx Antenna 1 v Rx Antenna 1
4
T < B—» f
Tx Antenna 2 v Rx Antenna 2
1.8
_Ys »&—Y
Tx Antenna 3 Rx Antenna 3

Figure 3.1.2.2-11 3 x 3 MIMO configuration
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(3 x 4 MIMO)

Communication is performed using three antennas at the transmission
station and four antennas at the reception station in this configuration.
Figure 3.1.2.2-12 is displayed when 3 x 4 MIMO 1is selected in Channel
Configuration. In this case, four waveform patterns corresponding to the

four Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
Y+ >® Y
Tx Antenna 1 4 v Rx Antenna 1
Y- ®—Y
Tx Antenna 2 v Rx Antenna 2
_Y5 &—Y
Tx Antenna 3 v Rx Antenna 3
&Y
Rx Antenna 4

Figure 3.1.2.2-12 3 x 4 MIMO configuration

(4 x 1 MISO)

Communication is performed using four antennas at the transmission
station and a single antenna at the reception station in this
configuration.

Figure 3.1.2.2-13 is displayed when 4 x 1 MISO is selected in Channel

Configuration.
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Tx Rx
AWGN
Ghannel v
_Y- &Y _
Tx Antenna 1 Rx Antenna 1

2

>

Tx Antenna 2

LQ‘.,

Tx Antenna 3 4

Y

Tx Antenna 4

Figure 3.1.2.2-13 4 x 1 MISO configuration
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(4 x 2 MIMO)

Communication is performed using four antennas at the transmission
station and two antennas at the reception station in this configuration.
Figure 3.1.2.2-14 is displayed when 4 x 2 MIMO is selected in Channel
Configuration. In this case, two waveform patterns corresponding to the

two Rx antenna modulation signals are generated.

Tx Rx
Ghannel
j\l AWGN
Tx Antenna 1 2 -
~ &—>Y
Y=
Tx Antenna 2 v Rx Antenna 1
5
Y= &—Y
Tx Antenna 3 7 Rx Antenna 2
8

Ty~

Tx Antenna 4

Figure 3.1.2.2-14 4 x 2 MIMO configuration

(4 x 3 MIMO)

Communication is performed using four antennas at the transmission
station and three antennas at the reception station in this configuration.
Figure 3.1.2.2-15 is displayed when 4 x 3 MIMO 1is selected in Channel
Configuration. In this case, three waveform patterns corresponding to

the three Rx antenna modulation signals are generated.

Tx Rx
AWGN
Ghannel v
_Y+ >®—Y
3
Tx Antenna 1 v Rx Antenna 1
4
_Ys &—Y_
Tx Antenna 2 Rx Antenna 2

12

L
8
_Ys &—Y_
Tx Antenna 3 / L

Tx Antenna 4

Figure 3.1.2.2-15 4 x 3 MIMO configuration
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3.1 Screen Details

(4 x 4 MIMO)

Communication is performed using four antennas at each of the

transmission and reception stations.
Figure 3.1.2.2-16 is displayed when 4 x 4 MIMO is selected in Channel

Configuration. In this case, four waveform patterns corresponding to the

four Rx antenna modulation signals are generated.

Tx

Ghannel

Tx Antenna 4

Figure 3.1.2.2-16

Rx
AWGH
¥
~d—Y_
v Rx Antenna 1
&Y _
v Rx Antenna 2
&Y
v Rx Antenna 3
»D—Y
Rx Antenna 4

4 x 4 MIMO configuration

3-19
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Chapter 8 Detailed Description of Functions

Tx Antenna Configuration field

Input waveform pattern settings can be configured in the Tx Antenna
Configuration field (see Figure 3.1.2.2-17).

~Tx Antenna Configuration

T Antenna 1 I

Input File : IUL_RMC_'I 2 2kbpzwvi Reference
e hd Delete

RF Frequency :  [1520.00000000 [MHz]

Sampling Rate :  |11.52000000 [MHz]

Bandwidth : 3.84000000 [MHz]

Repetition : |1— I~ Maximum

Pattern Length : 102200000000 [m=]

Figure 3.1.2.2-17 Tx Antenna Configuration field

Input File
[Overview]

[Setting range]

[Remarks]

Selects a waveform pattern file to be input.
Display only

Figure 3.1.2.2-18 is displayed when a waveform pattern
file is selected.

B
Flease “OK" button to read the file shown below.
Import file type: ASCI3

i il e frafion¥Qpr oducer¥F adne¥ Data¥ TES T Lixt
@ data file name: ation¥ICproducer¥Fadine¥Data¥ TEST Qtxt
Marker data fle name: [stion¥IdproducerkFadine¥ Data¥ TEST M 1<t

Peak value: 1634000000
RMS value: 1634.0000
Leneth 2560000

Cancel

Figure 3.1.2.2-18 Reading confirmation window
(when an ASCII3 is selected)

The Peak value, RMS value, and the number of samples
of the specified input waveform pattern file can be
confirmed on this window.

Clicking the [OK] button sets the waveform pattern, and
clicking the [Cancel] button cancels the setting.
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Input File (file type selection)

[Overview] Sets the type of the file to be input.

[Default] wvl

[Setting range]  wvi, ASCII1, ASCII2, ASCII3

[Remarks] Refer to Section 4.5.6 “Input file format” in the

MG3700A/MG3710A Vector Signal Generator MG3740A
Analog Signal Generator Operation Manual
(IQproducer™) for details on the file types.

RF Frequency

[Overview] Sets the center frequency.
[Default] 10000.00000000
[Unit] MHz

[Setting range] 0.25000000 to 6000.00000000
Setting resolution: 0.00000001

[Remarks] The set value applies to Tx Antenna 1 to Tx Antenna 4.
The Doppler frequency is recalculated when the RF
Frequency setting is changed.

Sampling Rate

[Overview] Sets and displays the sampling rate.
[Default] 0.02000000
[Unit] MHz
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[Setting range]  Display only (when a wvi file is selected)
0.02000000 to 160.00000000 (Except for MG3740A)
(when an ASCII1, ASCII2, or ASCIIS file is selected)

0.02000000 to 8.00000000 (MG3740A)
(when an ASCII1, ASCII2, or ASCIIS file is selected)

Display resolution: 0.00000001

[Remarks] When a wvi file is selected in Input File, the sampling
rate of the selected wvi file is displayed and cannot be
edited.

Bandwidth

[Overview] Sets and displays the bandwidth.

[Default] 0.02000000

[Unit] MHz

[Setting range]  Display only (when a wvi file is selected)
0.02000000 to Sampling Rate (when an ASCII1, ASCII2,
or ASCIIS file is selected)
Setting resolution: 0.00000001
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[Remarks] When a wvi file is selected in Input File, the sampling
rate of the selected wvi file is displayed and cannot be
edited.

Repetition

[Overview] Sets the number of repetition for the waveform pattern.

[Default] See Remarks.

[Setting range] Maximum, or the range from the default value to the

maximum value of memory capacity

[Remarks] The default value is the minimum number of repetitions
in which data points of the waveform pattern number
are 1000 samples or more.

When Maximum is set, the waveform pattern is
repeated continuously until the maximum value of

memory capacity is reached.

Pattern length
[Overview] Displays the waveform pattern length after generation.
[Unit] ms
[Setting range] Display only
Display resolution: 0.0000001
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Channel Setting field
The fading profile, moving speed, and Doppler frequency can be set for
each channel in the Channel Setting field (see Figure 3.1.2.2-19).
Doppler Frequency IDDDD [Hz] HSDP &

AWMIGN B,
C/N:
[¥ Round Fading Pattern H3UPA

COMADDIMS?
Random Geed: |1 GOMAZ000(ES)
TO-50DMA

i~ Channel Setting

Channell IChanne\E | Ghanneld | Channeld | Channels | Channels | Chan 4|

Fading Profile : |Defauu Setting (SElest Profie il
Gs

Moving Speed : |00 Beméh]  W-GDMAMS)
W-GOMAIBS)

1xEVDO

WLAN

Mobile WitdAx
MIMO Mabile Wit A3
DVE-T

LTE(MS!

LTE(BS)

MIMO LTE

Default Settine

Figure 3.1.2.2-19 Channel Setting field

Fading Profile

[Overview] Displays the fading profile.
[Default] Default Setting
[Remarks] Click the [Select Profile] button to display the profile

list, and select a system to set the corresponding
parameters. Refer to Appendix B for details.
The channel settings are restored to their initial values

)
[}
ﬁ
2]
=P
@
ol
)
D
)]
Q
]
bd o
=}
=
o
=}
o
=
=
c
=}
Q
=
o
=}
[)]

when Default Setting is selected.

Moving Speed

[Overview] Sets the moving speed.
[Default] 0.0
[Unit] km/h

[Setting range] 0.0 to 5000.0
Setting resolution: 0.1
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Doppler Frequency

[Overview] Sets the Doppler frequency.
[Default] 0.000

[Unit] Hz

[Setting range] The smaller value between 0.000 to (Sampling Rate)/2
and the value calculated by the following equation is
set.

1000 RF Frequency
X
3600 c

5000 x

c' Speed of light (299,792,458 m/s)
Setting resolution: 0.001

Round Fading Pattern

[Overview] Selects whether to make the start and end of
fading-processed waveform patterns consecutive.

[Default] Select

[Setting range]  Select/clear

[Remarks] The start and end of fading-processed waveform
patterns are consecutive when the check box is selected.
The waveform patterns may not be consecutive if the

Doppler frequency is low. Settings may also affect

processing time.

Random Seed
[Overview] Sets a random seed used for fading processing.
[Default] 1 (Channell), 2 (Channel2), ..., 16 (Channel16)
[Setting range] 1 to 255

Setting resolution: 1

[Remarks] Changing the random seed changes the fading
inclination of the waveform pattern to be generated.
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Rx Antenna Configuration field
Items of an output waveform pattern file can be set in the Rx Antenna
Configuration field (see Figure 3.1.2.2-20).

— Rz Antenna Gonfiguration

Rz Antenna 1
SG Master/Slave Setting : Im
AGN

AWGN Bandwidth : (101000000 [MHz]

GiN: IU.DD [4E]
Marker 1 I 3
Marker 2 I
Marker 3 |
Pattern Sync Marker : INot Uze LI

Figure 3.1.2.2-20 Rx Antenna Configuration field

SG Master/Slave Setting

[Overview] Specifies master or slave when multiple SG units are
connected in the SIMO or MIMO configuration.
[Default] Not Use

[Setting range]

Not Use, Master, Slave (Slavel to Slave3)

[Remarks] Refer to Appendix C for how to connect multiple SG
units.

AWGN

[Overview] Sets AWGN On or Off.

[Default] Cleared (Off)

[Setting range]  Select/clear

[Remarks]

AWGN addition is enabled when the check box is
selected.

AWGN Bandwidth

[Overview] Sets the bandwidth of AWGN.
[Default] 0.01000000
[Unit] MHz

[Setting range]

0.01000000 to (Sampling Rate)/2
Setting resolution: 0.00000001
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Chapter 8 Detailed Description of Functions

C/N

[Overview] Sets the C/N.
[Default] 0.00

[Unit] dB

[Setting range] —40.00 to +40.00
Setting resolution: 0.01

Marker 1 to Marker 3
[Overview] Sets the marker name.

[Setting range] Up to 31 one-byte alphanumeric characters.

Pattern Sync Marker

[Overview] Sets the marker to output the Pattern Sync Marker.
[Default] Not Use

[Setting range] Not Use, Marker1, Marker2, Marker3

[Remarks] Refer to Section 3.5 “Marker Output” for details.
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3.1.3 Channel tab window
Figure 3.1.3-1 shows the Channel tab window.

' Fading I0producer for MG3700

Eile Edit Transfer Settine  Simulation
T
Bl

Gaommon  Channel 17 Charinel 2 |

Channel n Parameter
field (n =1to 4)

Channel 1 Parameter Power Delay Profile
Ihput File | 000—
Fading Profil Default Settine .
=itk ofies | = Power Delay Profile
RF Fi . [fo00500a000 [MHz] 2
| : "o graph 3
Sampling Rate : [1.02000000 [MHz] < co00
Bandwidth [nozoo0000 [MHz] _ano0
Pattern Length : (10000000 e 20000 02000 Q4800 05000 08000 10000
Delay [us] U
Full Soal [¢"]
e | Path parameters &
Path | Fading Type Delay [us] | P ot [dB] | Moving Speed [kmih] | Doppler Frequency [Hz)| Rician K factor [dB « ,':
1 Rayleigh 0.0000 0.00 i @
[m] o,
]
o )
= @
o o
m} ]
| =
D U
=
u} 5
O
m] B
O o
m] L)
u] = =
RV [ c
=}
Q
(8
o o
5
Figure 3.1.3-1 Channel tab window 12
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This section describes the parameters on the Channel tab window.

Channel n Parameter fields (n = 1 to 16)

The Tx Antenna settings corresponding to Channel n (n = 1 to 16) are

displayed in the Channel n Parameter field (see Figure 3.1.3-2).

Input File
[Overview]

[Setting range]

[Remarks]

Fading Profile
[Overview]

[Setting range]

[Remarks]

RF Frequency
[Overview]

[Setting range]

[Remarks]

Sampling Rate
[Overview]

[Setting range]

[Remarks]

—Channel 1 Parameter

Tnput File : |UL_RMG_1 2 Zkbpzwi

Fading Profile : IW—CDMH(ES)/CaseE/‘I 20k m/h

RF Frequency : |T 98000000000 [MHz]

Sampling Rate |11.5zuuuuuu [MHz]

Bandwidth . [384000000 [MHz]

Fattern Leneth : |T 02200000000 [tnz]

Figure 3.1.3-2 Channel n Parameter field

Displays the currently selected input file.
Display only

The parameter of the corresponding Tx Antenna is
displayed.

Displays the currently selected fading profile.
Display only

The parameter of the corresponding Tx Antenna is
displayed.

Displays the center frequency.

Display only

The parameter of the corresponding Tx Antenna is
displayed.

Displays the sampling rate.
Display only

The parameter of the corresponding Tx Antenna is

displayed.
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Bandwidth
[Overview] Displays the bandwidth of the waveform pattern.

[Setting range] Display only
[Remarks] The parameter of the corresponding Tx Antenna is
displayed.

Pattern Length
[Overview] Displays the waveform pattern length.

[Setting range] Display only

[Remarks] The parameter of the corresponding Tx Antenna is
displayed.
Path (1 to 20)
Path
[Overview] Sets the path number display to On or Off.
[Default] Cleared (Off)

[Setting range]  Select/clear

[Remarks] The Path parameters become enabled when the
corresponding check box is selected.

Fading Type
[Overview] Sets the type of single path fading.
[Default] Rayleigh
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[Setting range] Rayleigh, Rice, Constant
[Remarks]

* Rayleigh
Environment in which multiple scattering waves
arrive.
Reception level changes in accordance with the
Rayleigh distribution.

¢ Rice
Environment in which multiple scattering waves and
direct waves arrive.
Reception level changes in accordance with the Rice
distribution.

* Constant
Reception level does not change with time.
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Delay
[Overview]

[Default]
[Unit]
[Setting range]

Power
[Overview]

[Default]
[Unit]
[Setting range]

Rician K factor
[Overview]

[Default]
[Unit]
[Setting range]

[Remarks]

Angle of Arrival
[Overview]

[Default]
[Unit]
[Setting range]

[Remarks]

Phase Shift
[Overview]

[Default]
[Unit]
[Setting range]

Sets the delay.

0.0000

us

0.0000 to 2000.0000
Setting resolution: 0.0001

Sets the path power.
0.00
dB

—80.00 to 0.00
Setting resolution: 0.01

Sets the power ratio between direct waves and

scattering waves.
0.00
dB

—40.00 to 40.00
Setting resolution: 0.01

Can be set when Fading Type is Rice.

Sets the arrival angle of direct waves.
0.0
deg

0.0 to 180.0
Setting resolution: 0.1

Can be set when Fading Type is Rice.

Sets the phase shift.
0.0

deg

0.0 to 359.9

Setting resolution: 0.1
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Spectrum Shape
[Overview] Sets the shape of the Doppler spectrum.

[Default] Classical 6 dB
[Setting range]  Classical 3 dB, Classical 6 dB, Flat, and Rounded

[Details of parameter]
Figure 3.1.3-3 shows each of the spectrum shapes.

REERERY

Classical 6dE Classical 3dB Flat Rounded

Figure 3.1.3-3 Doppler spectrum shapes

[Remarks] Cannot be set when Constant is selected for Fading
Type.

Correlation Setting

suonoun,j Jo uorpdrIosa(] pafrereq

[Overview] Selects the correlation matrix setting method.

[Default] Not Use

[Setting range] Edit, Not Use, path number set in Edit.

[Remarks] Enabled when a waveform data file 1s selected in Input
File.

When a path number is selected, the settings of the
selected path will apply. Note, however, that no path
number can be selected in the case of the 1 x 1 SISO

configuration.

Correlation Coefficients (Correlation matrix setting window)
[Overview] Sets the correlation coefficients.
[Default] 0.00000

[Setting range] —1.00000 —;1.00000 to 1.00000 + j1.00000
Only the elements on the upper-right of the diagonal
components can be edited.

[Remarks] The setting resolution is 0.00001 for both real and

imaginary parts.

3-31



Chapter 8 Detailed Description of Functions

Correlation Matrix
When Edit is selected in Correlation Setting, the correlation matrix
setting window shown in Figure 3.1.3-4 is displayed (an example when
Channel Configuration = 2 x 2 MIMO) and settings for all valid paths
can be set.
With the diagonal components of the Correlation Matrix as the border,
the bottom left element is automatically set so that the upper right and
bottom left elements form a complex conjugation.

Gorrelation Matrix x|

Save, Recall File

" Eave il Fiecall File.. | Gapy To All Paths |
i~ Channel Correlation
Copy To All Paths ——————— = T e [ =
— Kronecker method
TeAntennal | TxAntenna 2
T Antenna 1 i a0
Carrelation Matrix : Ty Antenna 2 elle] i
— 1
Kronecker method
Rx Antenna 1 Rx Antenna 2
RiAntenna 1 i 00
R Garrelation Matriz RxAntenna 2 ag i
Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 7 -0.23660 +j0.43120 068830 +j012110 -0.21507-j0.26814
Channel 2 -0.23660-§ 0.43120 i -0.11063-0.32544 058830 +) 012110
Channel 3 068830-/ 012740 011063 + j.32544 i -0.23660 +j0.43120
Channel 4 -0.29307 + j0.26814 0.66830-j0.12710 -0.23660-50.43120 i

|

Correlation Matrix ———

oK | Cancel

Figure 3.1.3-4 Correlation Matrix setting window (2 x 2 MIMO configuration)

The element count of the matrix depends on the system
configuration; the correspondence between the system
configuration and the displayed element count is shown
in Table 3.1.3-1.
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3.1 Screen Details

Table 3.1.3-1 Correspondence between system configuration
and displayed element count

System Configuration Displayed Element Count

1 x 2 SIMO, 2 x 1 MISO 2 x 2 matrix

1 x 3 SIMO, 3 x 1 MISO 3 x 3 matrix

1 x 4 SIMO, 4 x 1 MISO , 4 x 4 matrix

2 x 2 MIMO

2 x 3 MIMO, 3 x 2 MIMO 6 x 6 matrix

2 x 4 MIMO, 4 x 2 MIMO 8 x 8 matrix

3 x 3 MIMO 9 x 9 matrix

3 x 4 MIMO, 4 x 3 MIMO 12 x 12 matrix

4 x 4 MIMO 16 x 16 matrix

When a matrix element is selected in the Correlation
Matrix setting window, the Input Complex Data window
shown in Figure 3.1.3-5 is displayed and numeric values

can be input.

Input Complex Data x|

Ihput Complex Data

I 000000+ I 0.0000¢
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Figure 3.1.3-5 Input Complex Data window

Kronecker Method
[Overview] Sets Kronecker Method to On or Off.

[Default] Cleared (Off)
[Setting range] Select/clear

[Remarks] The Kronecker product of Tx Correlation Matrix and Rx
Correlation Matrix is displayed in the correlation matrix

when this checkbox is selected.

Click the [Save File...] button to save the Correlation Matrix parameters
of a valid path into a CSV file.

Click the [Recall File...] button to load a CSV file and set Correlation
Matrix parameters.

Click the [Copy To All Paths] button to copy the parameters of the set
path to all other valid paths.
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Power Delay Profile graph

In the Power Delay Profile graph, the horizontal and vertical axes are
Delay and Power, respectively, and the valid paths are displayed. All
paths can be displayed by clicking the [Full Scale] button.

1
1 [Full Scale] buttan
1

Figure 3.1.3-6 Power Delay Profile graph

As shown in Figure 3.1.3-7, a part of the graph can be enlarged by
dragging the mouse to select the area.

Prwwer Dislay Prodile
i | S
ET ; Area to enlarge

g
g-qum
“-enm

-E000

[ I
200 250

Full Zcalke

1 [
ong 050 D:lw[:fll

Figure 3.1.3-7 Selecting area to enlarge

Figure 3.1.3-8 shows the graph after it is enlarged.

Poweer Delary Profile

=1000—

=500 —

E-mm—'

eg-.mm-

-E000 -

—£000—
-Tm- i | i [ i | 1 | ] i
030 03 D040 D45 O0OBD OB OG0 OB QM Q%

Delay[ue]
Full seale |

Figure 3.1.3-8 Enlarged area

3-34
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3.1.4 Moving Propagation tab window

The Moving Propagation tab window is displayed when System
Configuration is 1 x 1 SISO and Fading Profile is Moving Propagation.
In moving propagation, the delay of Path2 to Path1 changes accordingly

with the following equation.

At = B+§(1+sm(@.t))

K

Figure 3.1.4-1 shows the Moving Propagation tab window.

fiki Fading Idproducer for MG3700

File Edit Transfer Setting ~ Simulation

. = i - | P Cighiy
Byl e S oA A 3E H
Gommon  Maving Propagation ‘

B4 RA
4 Ar -
E > At:B+g(1+sin(omega-t))

4 i

Moving Propagation conditions

Path Power [dB] | Alus) B [us] Omenga [1/s]
i o Q o 4]
2 0.00 g 1 0.04

suonoun,j Jo uorpdrIosa(] pafrereq

Figure 3.1.4-1 Moving Propagation tab window
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This section describes the parameters in the Moving Propagation tab

window.

The initial values for Path1 are all fixed to O.

Power
[Overview]

[Default]
[Unit]
[Setting range]

A (Offset)
[Overview]

[Default]
[Unit]
[Setting range]

B (Variation)
[Overview]
[Default]

[Unit]

[Setting range]

Omega
[Overview]

[Default]
[Unit]
[Setting range]

Sets the power of Path2.
0.00
dB

—80.00 to 0.00
Setting resolution: 0.01

Sets the offset for Path2.
5

us

0 to 500

Setting resolution: 1

Sets amount of change in delay for Path2.
1

us

0 to 500

Setting resolution: 1

Sets Omega.
0.04
Hz

0.00 to 1.00
Setting resolution: 0.01
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3.1.5 Birth-Death Propagation tab window

The Birth-Death Propagation tab window is displayed when System
Configuration is 1 x 1 SISO and Fading Profile is Birth-Death
Propagation. At Birth-Death Propagation, delay of two paths switches

randomly.

Figure 3.1.5-1 shows the Birth-Death Propagation tab window.

filf Fadine I0producer for MG3700

Eile Edit Transfer Settine  Simulation

K

Gommon  Birth-Death Propagation |

»
-

Birth-Death Propagation

Path Power [dB] ‘ Mazimum Delay [us] | Delay Resolution [us] ‘ Dwell time [ms]
i 0.00 10 1 191.000
2 0.00 10 1 191.000
Fath filtemate Setting - |Random = | Element Path Delay [us] ﬂ

suonoun,j Jo uorpdrIosa(] pafrereq

Figure 3.1.5-1 Birth-Death Propagation tab window
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This section describes the parameters in the Birth-Death Propagation

tab window.

Power

[Overview] Sets the path power.
[Default] 0.00

[Unit] dB

[Setting range] —80.00 to 0.00
Setting resolution: 0.01

Maximum Delay

[Overview] Sets the maximum delay.
[Default] 10
[Unit] us

[Setting range] 1 to 400
Setting resolution: Delay Resolution

[Remarks] The same value applies to Pathl and Path2. When
Delay Resolution is changed, the maximum delay is
rounded to an integer multiple of Delay Resolution.

Delay Resolution

[Overview] Sets the delay resolution.
[Default] 1
[Unit] us

[Setting range] 1 to Maximum Delay
Setting resolution: 1

[Remarks] The same value applies to Pathl and Path2. When
Maximum Delay is changed to a value lower than the
setting value of Delay Resolution, the setting value of

Delay Resolution is set to the same value as Maximum

Delay.
Dwell time
[Overview] Sets the dwell time.
[Default] 191.000
[Unit] ms

[Setting range] 0.001 to 200.000
Setting resolution: 0.001
(Note that the set value is rounded according to the

sampling rate.)

[Remarks] The same value applies to Path1l and Path2.
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Path Alternate Setting

[Overview] Sets the path alternate setting.

[Default] Random

[Setting range] Random, Sequence

[Remarks] When Random is set, Pathl and Path2 alternate
randomly.

When Sequence is set, the path to be alternated and the

delay can be set.

Path

[Overview] Sets the path to be alternated.

[Default] 1

[Setting range] 1, 2, Termination

[Remarks] Enabled when Sequence is selected in Path Alternate
Setting.

Delay

[Overview] Sets the delay of the path.

[Default] us

[Setting range] 0 to Maximum Delay
Setting resolution: Delay Resolution

[Remarks] Enabled when Sequence is selected in Path Alternate
Setting and the preceding Element is not set to
Termination.
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Chapter 8 Detailed Description of Functions

3.1.6 High Speed Train tab window

fi&f Fadine I0producer for MGZ700

File Edit Transfer Setting Simulation

The High Speed Train tab window is displayed when System
Configuration is set to 1 x 1 SISO and Fading Profile is set to High Speed
Train.

In the case of High Speed Train for W-CDMA (BS), Scenariol to
Scenario3 can be selected. Scenariol and Scenario3 are non-fading
channels and Scenario?2 is a Rice fading channel for Path1. Scenario 1
and Scenario 2 can be set for LTE (BS).

Figs. 3.1.6-1 to 3.1.6-3 show the High Speed Train tab windows for
W-CDMA (BS), and Figure 3.1.6-4 shows the High Speed Train tab
window for W-CDMA (MS).

o B ol w M4 W AR
Gommon High Speed Train |

Scenariol : Open space

T\ [F ﬁ\ [F A

|
\L ]
7 1 Q7 | ¢

I Timeise)

o

Dappler Shif (2]
B

|

| Path \ Ds [m] \ Drmin [m] | Rician K factor [dB] | Moving Speed [kinih] | Maximum Doppler Frequency [Hz] |
|1 | 1000 a0 350.0 1340000

Figure 3.1.6-1 High Speed Train tab window (Scenario1)
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A Fadine IQproducer for MG3700

Eile Edit Transfer Setting  Simulation

o Byl e M A @ 32 H

Common  High Speed Train l

Scenario? : Tunnel with leaky cable

Path | Ds [m] \ Dimin [m] \ Rician K factor [dB] \ Maving Speed [kinih] | Maximurm Dappler Frequency [Hz] |
1 | Iniiniy 10.00 3000 1150.000

K

Figure 3.1.6-2 High Speed Train tab window (Scenario2)

A Fadine IQproducer for MG3700

Eile  Edit Transfer Setting  Simulation

By fe M 4 o & H

Common  Hieh Speed Train l

suonoun,j Jo uorpdrIosa(] pafrereq

Scenariod : Tunnel for multi-antennas

)i

Doppler Shift (He)

3 L I
o
[ Time(ses)
Path | Ds[m] | Dmin [m] \ Rician K factor [dB] | Moving Speed [km/h] \ Maximum Doppler Frequency [Hz] |
1 | 300 2 3no.o 1150.000

Figure 3.1.6-3 High Speed Train tab window (Scenario3)
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A Fadine IQproducer for MG3710

Eile Edit Transfer Setting Simulation

YT EEFEEELEL

Common  High Speed Train l

JAt)
— r l r ul

=

& o

1

3

— e ) [ -y
I Timegse)
Path ‘ Ds [m] | Dmin [m] | Rician k factar [d8] ‘ Moving Speed [km/h] ‘ Maximurm Doppler Frequency [Hz] ‘
1 ‘ 300 2 - 300.0 G00.000

Figure 3.1.6-4 High Speed Train tab window (W-CDMA (MS))

This section describes the parameters on the High Speed Train tab

window.

Ds

[Overview] Sets (the default value of the distance between BS and
train) x 2.

[Default] 1000 (Scenariol), Infinity (Scenario2), 300 (Scenario3,
W-CDMA(MS), and LTEMS))

[Unit] m

[Setting range] 0 to 2000
Setting resolution: 1

Dmin

[Overview] Sets the distance between BS and rail.

[Default] 50 (Scenariol), 2 (Scenario3, W-CDMA(MS), and
LTEMS)), invalid (Scenario2)

[Unit] m

[Setting range] 1 to 100
Setting resolution: 1
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Rician K factor

[Overview] Sets the ratio between direct waves and scattering waves.
[Default] 10.00
[Unit] dB

[Setting range] —40.00 to 40.00
Setting resolution: 0.01

Moving Speed
[Overview] Sets the moving speed.

[Default] 350.0 (Scenariol), 300.0 (Scenario2, Scenario3,
W-CDMA(MS), and LTE(MS))

[Unit] km/h
[Setting range] 0.0 to 5000.0

Setting resolution: 0.1
Maximum Doppler Frequency

[Overview] Sets the maximum Doppler frequency.

[Default] 1340 (Scenariol), 1150 (Scenario2 and Scenario3), 600
(W-CDMAMYS)), 750(LTE(MS) )

[Unit] Hz

[Setting range] 0.000 to 2000.000
Setting resolution: 0.001
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3.1.7 Export File window

This section describes the Export File window.

The Export File window is used to set the package name, file name,
comment, etc., of the waveform pattern. The Export File window is
displayed when [Calculation] is selected from the [Edit] menu or the

W | button is clicked. The number of waveform patterns to be

generated changes depending on the Channel Configuration setting.
Table 3.1.7-1 shows the correspondence between the Channel
Configuration setting and the number of waveform patterns to be

generated.

Table 3.1.7-1 Correspondence between Channel Configuration setting
and number of waveform patterns

Channel Configuration Setting Number of Waveform Patterns
1 x 1 SISO

1 x 2 SIMO

1 x 3 SIMO

1 x 4 SIMO

2 x 1 MISO

2 x 2 MIMO

2 x 3 MIMO

2 x 4 MIMO

3 x 1 MISO

3 x 2 MIMO

3 x 3 MIMO

3 x 4 MIMO

4 x 1 MISO

4 x 2 MIMO

4 x 3 MIMO

B (N[ [ [N [ [ [N [N

4 x 4 MIMO

When one to four waveform patterns are generated, the waveform
pattern names corresponding to Rx Antennal to Rx Antenna4 have “ 17,
“ 27, “ 37, and “_4” suffixed, respectively, to the specified export file

name.

Figs. 3.1.7-1 to 3.1.7-4 show an example where the number of waveform
patterns to be generated is one to four, respectively. In the Comment
field, the RF frequency value and AWGN setting are initially displayed
in the first and second text boxes, respectively.
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3.1 Screen Details

Eport File El

Export destination path ———_

Eeport Pafc [G#Frogram Files¥ Pnritoy Gorporstcnilapro: E\\
Fackage name S ! Browse button for

Full Path:  [FilesBArritsu Gorporationiproducer¥Fodng#Dein export destination
Excpert Fike Hame: | folder selection
Export file name T e
i+ FMS Vahs i Culpal Gar

I~ futn Satiice I &®
RMS and Output Gain settings T

Comemant:
Comment ——" [AF Froqme = 000000 M

K

[AWGN : OFF = Rl

il Carcel
| | S
H.
2.
Figure 3.1.7-1 Export File window (when generating one waveform pattern) 5
o
S
@
x @
Euport Path mmau Fimplrw rigu Cooporstord iproc @ E .
Pk | =
agm (=
Fuill Pathy [Files¥ s Comor sfiond K couceriF adne i {Lats g
Export Fils Hares: | o
Rs Anterra 1. | ;;
R Antenna setting iterms . c
Scalng }3
= FM5 Waks ™ Outgal Gan S—b'-
™ Butn Setiire = @mm 5
115} g
Camerant

[ Fresgusrcy=1 DO0CUOUOON MHE

[RWGH - OFF = Axl, Ra2

o Carcel

Figure 3.1.7-2 Export File window (when generating
two waveform patterns)
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[Expors File x|
Espart Paiy [EiFroeran Fiest A it Gorporatordlro: E
Pachaes [

Full Fath [FileeiBre sy Gorpaatron ¥ Kiprockacer #7 adma¥ Dista
Export Fils Hame: [
Fix Anbeona 1. |
Fx Antenna setting items — el
Fix Aobnna 3 [
Snlng
MG Vakm I Cuitpast Giain
I Auto Sating  — |
L
Demment:
[FF Freguency=1 (00 MO0000 HH:

[AiiH OFF = Ao FeZ. Reed

0 Carcel

Figure 3.1.7-3 Export File window (when generating
three waveform patterns)

[Emari File |
Export Pt [CWFvanam Fimsvder fou Coporatieniope:. (]
Packaes [

Ful Parts : [Filai e 1 Colapcr W Kb F illogW Dl
Expart Fils Mame: |
Rt Bedarna 1 |

Rx Antenna setting items — " =,

P frtmrns 3 |

Pl Arlerv 4 |
Sealing
i MG Ve ™ Darigud Clsen
[ Aue Settne = m=

1157

Camment:
[FF Fraguency=1000 OO0 MH:

JAWGH ™ OFF = Rl o Rl ot

oK Careze] I

Figure 3.1.7-4 Export File window (when generating
four waveform patterns)

The Scaling setting is used to set the level of the generated waveform
pattern.

When RMS Value is selected, the waveform pattern amplitude is
normalized so that the output waveform pattern has the specified RMS
value.

Conversely, when Output Gain is selected, the gain of the output data
corresponding to the input data can be set (+0.0 to —10.0 dB). The output
power is found by summing the powers on the assumption that there is

no correlation for each channel and path.
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3.1 Screen Details

RMS Value
[Overview] Sets the RMS value.
[Default] 1157

[Setting range] 1 to 1634

Setting resolution: 1

[Remarks] In addition to manual setting, the RMS value can also be
set automatically by selecting the Auto Setting check box.
When the Auto Setting check box is selected to enable the
automatic RMS value setting function, the RMS value is

automatically adjusted and set so that the peak of the

generated waveform pattern is not clipped. When the
RMS value is 1 or less, however, clipping is performed
setting the RMS value to 1.

Auto Setting
[Overview] Selects the automatic RMS value setting On/Off.

[Default] When selected:
[Setting range] Select/clear

[Remarks] The RMS value is automatically set when the check box is
selected.
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Chapter 8 Detailed Description of Functions

Output Gain
[Overview]

[Default]
[Unite]

[Setting range]

[Remarks]

Gain Offset display

Sets the output gain.
0.0
dB

0.0 to —10.0
Setting resolution: 0.1

At Output Gain, processing is performed so the average
level of the output data after fading processing matches
the average level of the input data. (However, this
assumes there is no correlation with each path and
channel.)

The coefficient used at this time is displayed as Gain
Offset in Comment of the MG3700A/MG3710A/MG3740A
setting screen (Figure 3.1.7-5). Actually, the next step
adjusts the output level of the waveform data output from
the SG according to the Output Gain setting.

A1 MG, 20010 0AET 1552429

1 000 000 00000
-, 1000

File Select @ [ SNSRI | MM Fimping S Trig

Hauafarm
- Restart
FF Ot put

Detall Informatjion

Figure 3.1.7-5 Gain Offset display
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3.1 Screen Details

When the browse button for export destination folder selection is clicked,
the folder selection window shown in Figure 3.1.7-6 is displayed. Select

the export destination folder here.

Browse for Folder ed [

Select Folder

..... 103 AWaEN ;I
..... ) CCOF

..... D Clipping
----- i) Corvert
..... {3 DVB-T_H
[=1+5) Fading
(R0t

i--{7) FadingProfile

{3 Tp
..... i) FFT
-5 HSDPA
EH) LTE &l

[+ A= L TE Thn

oK I Cancel |

K

Figure 3.1.7-6 Export destination folder selection window

If an export destination folder is not selected, the generated waveform

pattern will be saved in the following folder:

X:A\IQproducer\Fading\Data
(X:\IQproducer is the folder in which IQproducer™ is installed)

One-byte alphanumeric characters and the symbols shown below can be

used for the package name and file name:

'"%&O+="{}_-r@l]

suonoun,j Jo uorpdrIosa(] pafrereq

The characters entered in the comment are displayed in the comment
field on the MG3700A screen. The comment field may be left blank.

Clicking the [OK] button starts waveform pattern generation. Note that
all items other than comment must be set.
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3.1.8 Calculation window
Clicking Calculation & Load, Calculation & Play, or the OK button on

the Export File window will start the waveform generation.

The Calculation window shown in Figure 3.1.8-1 is displayed when the
waveform pattern generation is started.

Generation prOCGSS Creating Parameter File... ;I
d|Sp|ay WindOW Calculating fading waveform.

Progress bar
% -

[CanCe|] button T e Cancel |

Figure 3.1.8-1 Calculation window (during waveform generation)

Waveform pattern generation can be cancelled by clicking the [Cancel]
button. Cancelling closes the Calculation window and returns to the
main screen.

When the waveform pattern generation is completed, “Calculation
Completed” is displayed and the [Cancel] button changes to the [OK]
button.

When the generation is complete, you can return to the setting screen by
clicking the OK button. After waveform generation, two files with .wvi

and .wvd extension are output.

Galculation

Aligning RMS value,
... End RMS walue alignment.

RMS : 1157
Peak Yalue : 7051

Calculation Completed.

.

Figure 3.1.8-2 Calculation window
(when waveform generation is completed)

At this time, the RMS value, peak value, whether clipping was done, and

if so, the sample count, of the generated waveform pattern are displayed.




3.1 Screen Details

Note:
When using this software on MG3710A/MG3740A and selecting
Calculation & Load or Calculation & Play, the waveform
generation ends without displaying the above screen.

When multiple waveform patterns are generated, the window shown in
Figure 3.1.8-3 is displayed at the completion of the waveform pattern
generation. In this window, Level Offset shows the level ratio of signal
generators (two signal generators in this example). Set the output level

of the signal generators to these values when using multiple signal

K

generators. The signal generator output levels are adjusted according to

the RMS power of the generated waveform pattern.

Galculation

R Artenna 2 :I
RFMS : 1157

Peak “alue : 5650

Level Offset

DL_MIMO_MatrixB_1 : -1 .33dB

DL_MIMO_MatrixB_2 : 0.00dB

Calculation Completed. -

Figure 3.1.8-3 Calculation window with Level Offset display

suonoun,j Jo uorpdrIosa(] pafrereq
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3.1.9 Calculation & Load
Note:

This function is available only when this software is used on
MG3710A/MG3740A.

When Calculation & Load is selected, the Load Setting screen will
display after waveform generation.

Wave Fattern

Package Kiproducer
|:> SG1 / Memary
Pattern Name ‘WaveformPattern

/
‘\ oK [|/ i |
/

Button for selecting load destination /

Figure 3.1.9-1 Load Setting Screen

The Select Memory screen will display after clicking the load destination

in the Load Setting screen.

Select Memory g'

SiG1
Memory & Memory B

5G2

e moryd ‘ Memory B ‘

oK Cancel ‘

Figure 3.1.9-2 Select Memory Screen

After selecting the load destination of generated waveform in the Select
Memory screen and clicking the OK button, the Load Setting screen will

be shown again. Click the OK button in the Load Setting screen, and
then the loading of waveform starts.

Note:

To exit this screen without loading the waveform pattern, click the

Cancel button in the Load Setting screen.
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3.1 Screen Details

3.1.10 Calculation & Play
Note:

This function is available only when this software is used on
MG3710A/MG3740A.

When Calculation & Play is selected, after waveform creation is
completed, the created waveform is loaded into memory, selected and

output.

When the 2nd Vector Signal Generator (option) is installed, the Select
SG screen is displayed before the start of waveform generation. This

K

screen 1s used to select the signal generator for outputting the created

waveform pattern.

. sa ‘ G2 ‘

Figure 3.1.10-1 Select SG Screen

suonoun,j Jo uorpdrIosa(] pafrereq
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Chapter 8 Detailed Description of Functions

3.2 Saving/Reading Parameters

The numeric values and settings for each item can be saved in a
parameter file by using this software.

3.2.1 Saving a parameter file

When running on PC
1. Select [Save Parameter File] from the [File] menu or click the e

tool button to display the parameter file saving screen.

saveas 21|
Save i I i) Fading j - I'j‘ =

| iData
|"IFadingProfile

_Tmp
FadingIQpro_Initial.xml

File name: | Save I
Save as tupe: | Setting Files [*xmi) =l Cancel |
i

Figure 3.2.1-1 Parameter file saving screen

2. Enter a file name in the [File name] text box, and click [Save] to
save the parameter file.
If the parameter file saving destination is not changed in [Save in],
the parameter file will be saved in the following destination:
X:\IQproducer\Fading\ Entered file name.xml
(X:\IQproducer is the folder in which IQproducer™ is installed)

When running on MG3710A or MG3740A
1. Click the [Save Parameter File] button in [File] menu or click the
2 | button to display the parameter file saving screen.
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3.2 Saving/Reading Parameters

ave
Drives  Windons? (¢) - File Name

Directories File List

= 1Qproducer =l [Fading.bmp
“1xEVDO _FWD Eﬂgi"g exe
. ading.ini
_k\(NEC\;/SO’RVS J FadinglQpro Initial.xml
-CCDF
-Clipping
‘Convert
‘DVB-T H e
' G¥Anritsu¥ [Oproducer¥Fading®
‘FFT
HSDPA
IQproducer
LTE |
I TF TN =l Default Root OK GCancel

Figure 3.2.1-2 Parameter file saving screen (MG3710A/MG3740A)

2. Select the folder to store the file in the [Directories] field, and then
enter the name of the file using the [File Name] box. Click [OK] to
save the parameter file. To initialize the setting in the [Directories]
field, click the [Default Root] button.

3.2.2 Reading a parameter file
When running on PC
1. Select [Recall Parameter File] from the [File] menu or click the
ﬂ tool button to display the parameter file reading screen.

open 21|
Look ik I_.'! Fading j L] |‘=j< v

| CiData
|__IFadingProfile

) Tmp
FadingIQpra_Initial.xml

)
[}
ﬁ
2]
"-_‘:
@
ol
)
D
)]
Q
]
bd o
=}
=
o
=}
o
=
=
c
=}
Q
=
o
=}
[)]

File name: || Open I
Files of type: ISetting Filez [* =ral] j Cancel |
4

Figure 3.2.2-1 Parameter file reading screen

2. Select a parameter file to be read from the file list, and then click
[Open] to read the selected parameter file.
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When running on MG3710A or MG3740A
1. Select [Recall Parameter File] from the [File] menu or click the

& tool button to display the parameter file reading screen.

X

ecal
Drives  |windons? 1) -

Directories File List
IQproducer =l [FadinglQpro_ Initial.xml
1xEVDO_FWD J

1xEVDO_RVYS
AWGN

CCDF
Clipping
Convert
DVB-T_H
FFT

HSDPA
[Qproducer
LTE

I TF TNN ~| Default Root OK Cancel

Figure 3.2.2-2 Parameter file reading screen (MG3710A/MG3740A)

2.  Select the directory where the files to be loaded is stored in the
[Directories] field. Click the desired file from the [File List], and
click [OK]. To initialize the setting in the [Directories] field, click the
[Default Root] button.
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3.8 Waveform Pattern Generation Procedure

3.3 Waveform Pattern Generation Procedure

This section describes how to generate a waveform pattern, using the

Fading waveform pattern as an example.

3.3.1 1 x 1 SISO waveform generation
How to generate a Multi Path waveform pattern for W-CDMA BS

measurement reception is described below, using the MG3700A standard

waveform pattern UL_RMC_12.2kbps as an example.

K

<Procedure>
1. Start this software.

2.  Set Common parameters.
(1) Setting in System Configuration field
Select “1 x 1 SISO” from the Channel Configuration list box.

-~ Bystem Confieuration

Channel Configuration

Tx Rx
AWGN
Ghannel r
R
Tx Antenna 1 Rx Antenna 1

suonoun,j Jo uorpdrIosa(] pafrereq

Figure 3.3.1-1 System Configuration (1 x 1 SISO)

(2) Setting in Tx Antenna Configuration field

Select “wvi” from the list box, and then click the [Reference]

button to select a waveform pattern file to be input.

21 x|
Look jn: | 2 '-COMA(BS) | « @k E-
BN RMC 12 2kbps. i

File name:  [UL_RMC_12_2kbps.wvi Open |
Files of type:  [\w/aveform file (% =] Cancel |
&

Figure 3.3.1-2 Waveform pattern file selection window (1 x 1 SISO)

3-57



Chapter 8 Detailed Description of Functions

Next, set “1980 MHz” for RF Frequency and “1” for Repetition.
Figure 3.3.1-3 shows the screen after setting.

Tx Aevtenna Cordipuration

T Aniznna 1 |

Tnput Fibs: [HIC M 12 Zhbps e Fiederence I
el - Delete |

FF Frequercy | 198000000000 [MHe]

Samplre Fate - [ECoOOODD  [Meg]

Badwit . [RS4000000 D]

Repetition : f T Maimum

Pattern Length - [OEZ00000000  [ma]

Figure 3.3.1-3 Settings in Tx Antenna Configuration field

(3) Setting in Channel Setting field

Click the [Select Profile] button and select the fading profile
“W-CDMA(BS)/Case3/120km/h.”

Chanrai Satling
HH Bandeits : [0 0000
Charrell |
o R =] o i
i Frafik g == ey .]
; W-CIMANED .
M 2 " T e
Doppler Fisguency  [ITE0 [H:]  HSDFA v Camal ¥
HELFA B,
F Forul Tuling ilian ODMACIONNG? b Caed v
Fandar Gead fi O DMAIEES] b Mreed Propagstion 166k
TO-5C0HA b Brit-Death Propssstion s T
TaEWD b Hign Speed Tewn L v LT
WLAN ¥
Mobile WikAN v
MING Hotile WiEAS ®
OvE-T '
LTEIHE v
LTE(EE} [
MM LTE .
Detsl Sering

Figure 3.3.1-4 Selecting fading profile

Figure 3.3.1-5 shows the screen after the profile is selected.

Charrel Settira
Charwmll |
Fading Profile . [W-GOMABE) Cased/ 10/ Select Prafile |
Moving Speed :  [1200 [kms]
[oppler Fraquncy : [Z0752 [Hel
¥ Pourd Fadng Fatterm
Rudom Seed - |1

Figure 3.3.1-5 Settings in Channel Setting field
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3.8 Waveform Pattern Generation Procedure

(4) Setting in Rx Antenna Configuration field

Configure the settings as shown in Figure 3.3.1-6.

R Antenns Conlparation
Fx Antenns 1 |

EG Wagter Slien Batlrn it L ¥

I AWGH

ARG Bardwmicin - |11 [Mez]
M I e

Maikins 1 |F|ar|: Ok

Markar 2 [Faut Siock

Patkier 3 I

Palters Syne Marker @ [Rior Lhis =l

Figure 3.3.1-6 Settings in Rx Antenna Configuration field

(5) Setting in Channel 1 Parameter field

Confirm that the settings configured in the Channel Setting
field are displayed in the Channel 1 Parameter field on the
Channel 1 tab window.

{il§ Fadine IQproducer for MG3700

File Edit Transfer Setting  Simulation

- B "EREE

Common  Ghannel 1 |

b2
>

Channel 1 Parameter Power Delay Profile
Input File UL_RMG 12 2kbps i 000
Fading Profile : [W-GDMALBS)/ Cased/120kmh _on0g
—
2 =
RF Frequency : [198000000000 [MHz] -0
Sampling Rate : [1152000000 [MHz] € o
Bandwidth 400000 [hH=] e
| | | | |
Pattern Length : [10220.0000000 [m=] 00000 02000 04000 08000 08000
Delaylus]
Full Scale
Path | Fading Twpe Delay [us] | Paower [dB] | Maving Speed [knih] |DDpp\erFreuuency [Hz]| Rician K factor [dB =
1 Rayleigh 0.0000 ooo 1200 220142 1
2 Rayleigh 0.2600 -2.00 1200 220152
3 Rayleigh 0.5210 -6.00 1200 220152
4 Rayleigh 0.7810 -9.00 1200 220152
a
a
[m]
a
[m]
a
[m]
a
[m]
a
a -
K| E]

Figure 3.3.1-7 Channel parameter setting screen (1 x 1 SISO)
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Chapter 8 Detailed Description of Functions

3.

Confirm that the parameters are correctly set.

Table 3.3.1-1 shows the parameters and their settings in this

example.

Table 3.3.1-1 W-CDMA (BS) parameter settings

Parameter

Setting

System Configuration

Channel Configuration

| 1x18ISO

Tx Antenna Configuration

Input File UL_RMC_12_2kbps.wvi
RF Frequency 1980 MHz

Sampling Rate 11.52 MHz

Bandwidth 3.84 MHz

Repetition 1

Pattern Length 10220.0 ms

Channel Setting

Fading Profile W-CDMA(BS)/Case3/120km/h
Moving Speed 120 km/h

Doppler Frequency 220.152 Hz

Round Fading Pattern Selected

Random Seed

1 (Default)

Rx Antenna Configuration

AWGN

| Cleared
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3.8 Waveform Pattern Generation Procedure

5.

Start calculation to generate the waveform.

Select [Calculation] from the [Edit] menu or click the 4L | button
to display the Export File window shown in Figure 3.3.1-8. Set the

package name and export file name, and then click the [OK] button.
Calculation is started and the waveform is generated.

Eapini File

x|

Ecpn® Pich EﬂDmm-ﬂn: Sl Dertiergs Ma 1 IODDGF 720 _I
Fickiai fe-COMAES A Test)
Fudl Path [T 2 5T = IV oo B e learsed F ad we W Dl

FFT Graph Monitor

Export Filt Mame [&-COMAMESE: Cased 130

Scalng
i AN ke ™ Output Gan
[ Ao Sattes (25
L
Camment

FF Fraqusncy=1350 00000000 W H:

[WWGH | OFF = Fal

Figure 3.3.1-8 Export File window

Figure 3.3.1-9 shows the spectrum of the generated waveform data.

A=
File  Edit
Legend 10—

= —
’ri
,(-7..

Amplitude (E)

FFT Points 262144
Sampli
A 0 - | eeeas

Data Leneth 117734400

Delete |

- 1
Frequency (MHz)

Cursor

Seale

e 67600 = 57600 b
2
100 - 1200
B

Full Scale

Quick Add Mode Mouse Interaction

Frequency

00000
{MHz)
-58242 B

Add ‘ Gursor

Amplitude

Amplitude

Figure 3.3.1-9 Spectrum (W-CDMA Case3 120km/h)
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Chapter 8 Detailed Description of Functions

3.3.2 Moving Propagation waveform generation

How to generate a Moving Propagation waveform pattern for W-CDMA
BS measurement reception is described below, using the MG3700A
standard waveform pattern UL_RMC_12.2kbps as an example.

<Procedure>
1. Start this software.

2.  Set Common parameters.
(1) Setting in System Configuration field
Select “1 x 1 SISO” from the Channel Configuration list box.

Tt Dol i gtoe

S| Dol T -

Te Fis
ANGH
Chains| L
JrE——8—*T
Tz Anterna 1 Foi Ambaiwa 1

Figure 3.3.2-1 System Configuration (1 x 1 SISO)

(2) Setting in Tx Antenna Configuration field

Select “wvi” from the list box, and then click the [Reference]

button to select a waveform pattern file to be input.

2l
Lagk in: | 2 W-CDMA(BS) ~] « @ ok '

File: name: IUL_HME_1 2_2kbps.wvi Open I
Filez of type: IWavefnrm fille: [ w] j Cancel |
&

Figure 3.3.2-2 Waveform pattern selection window
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3.8 Waveform Pattern Generation Procedure

Next, set “1980 MHz” for RF Frequency and “1” for Repetition.
Figure 3.3.2-3 shows the screen after setting.

Tx Aevtenna Cordipuration

T Anterna 1 |
Trput Fils [UL_RHC, 12 2hbps weri Relariing
C— Blets
FF Frequercy | 198000000000 [Mr]
Sampive Fate- [iiGcoo0ood Dl
Barchicith [re4000000 [M:]
Fepetition I I Masidum 3
Patterm Lerth [mz]

Figure 3.3.2-3 Settings in Tx Antenna Configuration field

(3) Setting in Channel Setting field

Click the [Select Profile] button and select the fading profile
“W-CDMA(BS)/Moving Propagation.”

Channa| Saiteg
Chamed] |

AMON Bendwiiy: IO
oM E

el
Fadwa Profis |D-I|ul:&||u | ket et

Worvi G0 fon] _WCOHAME

Dopester: Fraguarsy : [10000 [Hz] A
[+ Found Feding Patiem COMEINME)
Fandom Seed | COMAHONES]
TD-SC0MHA Eirth-Dseadh Propagaion

T=ENTDD High Gpseasd Tram

)
[}
ﬁ
2]
"-_‘:
@
ol
)
D
)]
Q
]
bd o
=}
=
o
=}
o
=
=
c
=}
Q
=
o
=}
[)]

Figure 3.3.2-4 Selecting fading profile

Figure 3.3.2-5 shows the screen after the profile is selected.

—Channs| Seitirg
Channall |
Fading Prcfile . [WGOMMEG) Mg Propadation || Belect Profile |
Mervieg Spaed : [0 T hil
Coppler qu.ﬂ'urr:l‘ | [Hz]
= ' re Pattier
Fandom Seed : |

Figure 3.3.2-5 Settings in Channel Setting field (Moving Propagation)
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(4) Setting in Rx Antenna Configuration field

Configure the settings as shown in Figure 3.3.2-6.
R Antenns Conlparation

Bchm1|

EG Wagter Slien Batlrn

I AWGH

ARG Bardwmicin - |11

M

Marker 3

f

]

[Frame Cleck

|1--n| Clock

Palters Syne Marker @ [Rior Lhis

=

Figure 3.3.2-6 Settings in Rx Antenna Configuration field

3. Set Path parameters on the Moving Propagation tab window.

Set the Path parameters as shown in Table 3.3.2-1.

Table 3.3.2-1 Path parameter settings (Moving Propagation)
Path Power [dB] A [us] B [us] Omega [Hz]
0 0 0 0 0
1 0.00 5 1 0.04

#i4 Fading IQproducer for MG3700

Eile Edit Transfer Setting  Simulation

b Byl

Common  Moving Propagation |

R4 R A

2

Moving Propagation conditions

> Ar= B+§(1+sin(amega-t))

FPower [dB] [ Alus]

B [us] Omega [1/s] |

a o

Path |
v a 0
2 0.00 5

0.04

Figure 3.3.2-7 Moving Propagation tab window
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3.8 Waveform Pattern Generation Procedure

4. Confirm that the parameters are correctly set.

Table 3.3.2-2 shows the parameters and their setting in this
example.

Table 3.3.2-2 W-CDMA (BS) Moving Propagation parameter settings

Parameter Setting
System Configuration
Channel Configuration | 1 x 1 SISO
Tx Antenna Configuration
Input File UL_RMC_12_2kbps.wvi 3
RF Frequency 1980 MHz
Sampling Rate 11.52 MHz
Bandwidth 3.84 MHz
Repetition 1
Pattern Length 10220.0 ms
Channel Setting
Fading Profile | W-CDMA(BS)/Moving Propagation
Rx Antenna Configuration
AWGN | Cleared

5. Start calculation to generate the waveform.

Select [Calculation] from the [Edit] menu or click the 4k | button
to display the Export File window shown in Figure 3.3.2-8. Set the

package name and export file name, and then click the [OK] button.
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Calculation is started and the waveform is generated.
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Figure 3.3.2-8 Export File window
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6. Spectrum
Figure 3.3.2-9 shows an FFT graph of the generated waveform data.
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Figure 3.3.2-9 Spectrum (Moving Propagation)
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3.8 Waveform Pattern Generation Procedure

3.3.3 Birth-Death Propagation waveform generation

How to generate a Birth-Death Propagation waveform pattern for
W-CDMA BS measurement reception is described below, using the
MG3700A standard waveform pattern UL_RMC_12.2kbps as an

example.

<Procedure>
1. Start this software.

2.  Set Common parameters.

K

(1) Setting in System Configuration field
Select “1 x 1 SISO” from the Channel Configuration list box.

Trtrs Jon W

St Condrnaivn R -

T Ra
AWCH
Chaimel L
FE——+8 T
Tz Antmona 1 Ha Beberma 1

Figure 3.3.3-1 System Configuration (1 x 1 SISO)
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(2) Setting in Tx Antenna Configuration field

Select “wvi” from the list box, and then click the [Reference]
button to select a waveform pattern file to be input.

Loak jr: | 3 %-COMA(BS) <] « @ ok B

File narme: IUL_HME_1 2 2kbpewavi Open I
Files of lype: I'Waveform file [ wrwi] j Cancel |
A

Figure 3.3.3-2 Waveform pattern selection window
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Chapter 8 Detailed Description of Functions

Next, set “1980 MHz” for RF Frequency and “1” for Repetition.
Figure 3.3.3-3 shows the screen after setting.

Tx Aevtenna Cordipuration

T Anterna 1 |

Tnput Fibs: [HIC M 12 Zhbps e Fiederence I
CR— poite_|

RF Frequency : 152000000000 (W]

Sampive Fate- [iiGcoo0ood Dl

Blardvicith [re4000000 [MHe]

Repetition : f ™ Maimum

Patiemn Length - [IOEZ000000D0  [ma

Figure 3.3.3-3 Settings in Tx Antenna Configuration field

(3) Setting in Channel Setting field

Click the [Select Profile] button and select the fading profile
“W-CDMA(BS)/Birth Death Propagation.”

Charewl Balting |

Charell |

Fadeg Frofile:  [Belall Sittng |EFP?EI'T=']|-- L
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Fandurm Sead fi G OMACIOAES]
TS0 A
1=ELD0
WLaH
Mobils WiMAX
M1 Mokele WiIMAK
IWE-T
LTEMS)
LTEZES)
MM LTE
Detaull Setiirm

i

Figure 3.3.3-4 Selecting fading profile

Figure 3.3.3-5 shows the screen after the profile is selected.

~ Charre Setting
Cranned] 1
Fading Profile . [WEGTMATBE/ Brih-Dssh Fropagatio [ Saiaci Paaile |
Moving Speed - [ et}
Topgher Froueny < [1000 [Hz]
B o]
Fandom Seed . |

Figure 3.3.3-5 Settings in Channel Setting field (Birth-Death
Propagation)
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3.8 Waveform Pattern Generation Procedure

(4) Setting in Rx Antenna Configuration field

Configure the settings as shown in Figure 3.3.3-6.

R Antenns Conlparation
Fx Antenns 1 |

EG Wlagter Slaes Sabivg ) =

I AWGH

ARG Bardwmicin - |11 [Mez]
M I e

Maikins 1 |F|ar-: Ok

Marker 2 |1--n| ok

K

Patkier 3 I

Faltarn Syne WMarksr | |MIII.- :!

Figure 3.3.3-6 Settings in Rx Antenna Configuration field

3. Set Path parameters on the Birth Death Propagation tab window.
Set the Path parameters as shown in Table 3.3.3-1.

Table 3.3.3-1 Path parameter settings (Birth-Death Propagation)

Path Power [dB] Minimum Delay [us] | Delay Resolution [us] | Dwell time [ms]
0.00 10 1 191.000
0.00 10 1 191.000
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fit# Fading IQproducer for MG2700
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Birth-Death Propagation

Path Power [dB] ‘ Maximum Delay [us] | Delay Resolution [us] ‘ Dweell time [ms]
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2 o.oo 10 i 191.000
Path Altemate Setting © [Random R Element Path Delay [us] ﬂ

Figure 3.3.3-7 Birth-Death Propagation tab window
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Chapter 8 Detailed Description of Functions

In this example, the waveform pattern generation procedure when
Random is selected for Path Alternate Setting is provided below.

The path delay changes randomly when Random 1is selected for Path
Alternate Setting, while the path can be alternated in a desired pattern

when Sequence is selected.

Fath Ahiermate Setting i [Sequence =] Elemeri Pat [ Delavs) |
Vntial Dielss i i
initial Dty z z |
1 1 3
= 1 4
3 1 5
£ 1 E
5 1 7
£ 1 [
T Termination

Figure 3.3.3-8 Example when Sequence is selected

4. Confirm that the parameters are correctly set.
Table 3.3.3-2 shows the parameters and their setting in this

example.

Table 3.3.3-2 W-CDMA (BS) Birth-Death Propagation parameter

settings

Parameter Setting
System Configuration
Channel Configuration 1 x 1 SISO
Tx Antenna Configuration
Input File UL_RMC_12_2kbps.wvi
RF Frequency 1980 MHz
Sampling Rate 11.52 MHz
Bandwidth 3.84 MHz
Repetition 1
Pattern Length 10220.0 ms
Channel Setting
Fading Profile ‘ W-CDMA(BS)/Birth-Death Propagation
Rx Antenna Configuration
AWGN | Cleared
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3.8 Waveform Pattern Generation Procedure

5. Start calculation to generate the waveform.

Select [Calculation] from the [Edit] menu or click the 4L | button
to display the Export File window shown in Figure 3.3.3-9. Set the

package name and export file name, and then click the [OK] button.

Calculation is started and the waveform is generated.

Epori Fils x|
Esport Path [FE¥Proan Flesfrritsy Comoationiidon: - |
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Eiafrg
i+ AME Vale ™ Cartpat Gan
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[dE]
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[FF Frequency=1500D0000) MH:

|AWEH | OFF = Rl

e ]

Figure 3.3.3-9 Export File window

6. Spectrum

Figure 3.3.3-10 shows the spectrum of the generated waveform data.
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Figure 3.3.3-10 Spectrum (Birth-Death Propagation)
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3.3.4 High Speed Train waveform generation
How to generate a High Speed Train waveform pattern for W-CDMA BS

measurement reception is described below, using the MG3700A standard
waveform pattern UL_RMC_12.2kbps as an example.

<Procedure>
1. Start this software.

2.  Set Common parameters.
(1) Setting in System Configuration field
Select 1 x 1 SISO from the Channel Configuration list box.

Twitern Cowl i moe

| sl T =]

Te Ra
AW
Chaims| L
Jr—>8—*T
Tx Anteena 1 Fu Absraa 1

Figure 3.3.4-1 System Configuration (1 x 1 SISO)

(2) Setting in Tx Antenna Configuration field
Select the input file (wvi).

21
Look in: [ 3 W-CDMAS Rixtest] ~| & = ek E-
(FJL_pmC_12 k... :
File pame:  [UL_RMC_12_2khps wi Open |
Files af lype: IWaveform files [ i) j Cancel |/
3

Figure 3.3.4-2 Waveform pattern file selection window
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3.8 Waveform Pattern Generation Procedure

Next, set 1980 MHz for RF Frequency and “1” for Repetition.
Figure 3.3.4-3 shows the screen after setting.

Tx Artenna Condipuration
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Figure 3.3.4-3 Tx Antenna Configuration

(3) Setting in Channel Setting field

Click the Select Profile and select the fading profile
“W-CDMA(BS)/High Speed Train/Scenariol.”
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Figure 3.3.4-4 Selecting fading profile

Figure 3.3.4-5 shows the screen after the profile is selected.
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Figure 3.3.4-5 Settings in Channel Setting field
(High Speed Train)
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Chapter 8 Detailed Description of Functions

(4) Setting in Rx Antenna Configuration field
Configure the settings as shown in Figure 3.3.4-6.

P Anterns Conlaparation
Fo: Antenra 1 |

50 Wagter/Slavw Gatlrg
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ARG Bardwich - | 11100 [miz]
G I 8]

Marker 1 |F|-:m: Dok

Markar 2 [t Clack

Marker 3 I

Faltern Syne Marker © ot Lios =l

Figure 3.3.4-6 Settings in Rx Antenna Configuration field

3. Set Path parameters on the High Speed Train tab window.
Set the Path parameters as shown in Table 3.3.4-1.

Table 3.3.4-1 Path parameter settings (High Speed Train)

Ds [m]

Dmin [m] | Rician K factor [dB] | Moving Speed [km/h] | Maximum Doppler Frequency [Hz]

1000

50 - 350.0 1340.000

i Fadine IQproducer for MG3700

Eile Edit Transfer Settine  Simulation

R v sy O N
o Bl fm 8 4 M B K
Gommen ~High Speed Train |

Scenariol : Open space

N[ 1y 1y

o

[ 1
|

Doppler Shif (He )

|
|
)\ |
O T 97 [ |

i Time(ses)

Dz [m] ‘ Dmin [m] | Rician K factor [dB] | Moving Speed [km/h] | Maximum Doppler Freguency [Hz] |

[ Path ]|
3500 1340.000

[ | 1ooo 50

Figure 3.3.4-7 High Speed Train tab window (Scenario1)
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3.8 Waveform Pattern Generation Procedure

4. Confirm that the parameters are correctly set.
Table 3.3.4-2 shows the parameters and their setting in this

example.

Table 3.3.4-2 W-CDMA(BS)/High Speed Train/Scenario1 parameter

settings
Parameter Setting
System Configuration
Channel Configuration 1 x 1 SISO
Tx Antenna Configuration
Input File UL_RMC_12_2kbps.wvi
RF Frequency 1980 MHz
Sampling Rate 11.52 MHz
Bandwidth 3.84 MHz
Repetition 1
Pattern Length 10220.0 ms
Channel Setting
Fading Profile | W-CDMA(BS)/High Speed Train/Scenariol
Rx Antenna Configuration
AWGN | Cleared

5. Start calculation to generate the waveform.

Select [Calculation] from the [Edit] menu or click the 4L | button
to display the Export File window shown in Figure 3.3.4-8. Set the

package name and export file name, and then click the [OK] button.
Calculation is started and the waveform is generated.

Eaport Fils x|
Esport Path [ Frogran Flesiarritoy Copoationtiipm:__ |
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Figure 3.3.4-8 Export File window
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7. Spectrum

Figure 3.3.4-9 shows the spectra of the generated waveform data.
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Figure 3.3.4-9 Spectrum (High Speed Train (Scenario1))
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3.8 Waveform Pattern Generation Procedure

3.3.5 2 x 2 MIMO waveform generation

How to generate a 2 x 2 MIMO waveform pattern is described below,
using the Mobile WIMAX waveform pattern as an example.

In the example, “DL_MIMO_MatrixB_1.wvi” is created as the waveform
pattern corresponding to Tx Antennal, and “DL._MIMO_MatrixB_2.wvi”
as the waveform pattern corresponding to Tx Antenna2.

<Procedure>
1. Start this software.

2. Set Common parameters.
(1) Setting in System Configuration field
Select “2 x 2 MIMO” from the Channel Configuration list box.

St Jor] st ion

Chamma Contgrsnon . SRR -]

Tz B

i —0—>1_
Tz Antena 1 =l v Az Antmna 1
= S
Tz Antmsna 2 Ax Anloana 2

Figure 3.3.5-1 System Configuration (2 x 2 MIMO)

(2) Setting for Tx Antenna 1 and Tx Antenna 2 in Tx Antenna

Configuration field

Select “wvi” from the list box, and then click the [Reference]

button to select a waveform pattern file to be input.

2 x|
Loak in: | () Mwibax <] « @ ok B

DL MIMOD MatrizE_0,wvi
|®] DL_MIMO_MatrixB_1 wwi

File narme: I Open I
Files af type:  |\wavefom file [ wvi) =l Cancel |
4

Figure 3.3.5-2 Waveform pattern file selection window (2 x 2 MIMO)
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(3

Next, set “2400 MHz” for RF Frequency and “1” for Repetition
on the Tx Antenna 1 tab window and the Tx Antenna 2 tab

window. Figs. 3.3.5-3 and 3.3.5-4 show the screen after setting.

Tx Antenna Configuration

Tx Antenna 1 ]Tx fntenna 2 ]

Input File :

RF Frequency :

Sampling Rate :

Eandwidth :

Repetition :

Fattern Length :
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Wi hd
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‘22.40000000

‘1 0.00000000

‘1

‘E.DDDDDDD

[MHz]
[MHz]
[MHz]
[~ Maximum

[me]

Feference..
Delete

Figure 3.3.5-3

Settings on Tx Antenna 1 tab window

T Antenna Configuration

T Antenna 1

Ihput File :

RF Frequency :

Sampling Rate :

Eandwidth :
Repetition :

Fattern Length

Tx Antenna 2 ]

|DL_MIMO_Matrix B _1.mvi

Wi hd
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[MHz]

|22.4DDDDDDD

[MHz]

|‘I 0.00000000

[MHz]

|1

[~ Maximum

: |5.UUUUUUD

[mz]

Reference...
Delete

Figure 3.3.5-4

Settings in Channel Setting field

Settings on Tx Antenna 2 tab window

Configure the settings for Channel 1 to Channel 4. On each
Channel tab window, click the [Select Profile] button and select
the fading profile “MIMO Mobile WiMAX/2x2 MIMO/ITU
Vehicular A/Medium Correlation.”
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Setting in Channel Setting field
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3.8 Waveform Pattern Generation Procedure

Figure 3.3.5-6 shows the Channell tab window after the profile
is selected as an example.
Charnral Seling
Charnell | Shaneet? | Channet | Charneld |
Far Protie [P0 Mibie ViS22 WO/ |l Pt |
Movre Speed 1 [0 Dimh

Doppler Fréguency ||!'313 (=] [He]
¥ Round Fsdira Patiem
Farudom Seed - 1

Figure 3.3.5-6 Settings on Channel1 tab window

(4) Setting for Rx Antenna 1 and Rx Antenna 2 in Rx Antenna
Configuration field
Configure the settings as shown in Figs. 3.3.5-7 and 3.3.5-8.
Ree Anterra Configurstion
P Anterna 1 | B Anterna 2 |

65 MassrSave Sattie T =
™ AWON
AWGN Bandwidth | [171 00000 imbiz]
/N | ]

Marker T |rr-:m-e Pips

Marker 2 [Uplirk Subirame Fulse

Markes 2 {RF Gats

Fatters Syre Marker © [Pt Liss =

Figure 3.3.5-7 Settings on Rx Antennal tab window
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Figure 3.3.5-8 Settings on Rx Antenna2 tab window
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(5) Setting in Channel n parameter field (n = 1 to 4)

Confirm that the settings configured in the Channel Setting

field are displayed in the Channel Parameter field on each

Channel tab window.

il Fading I@producer for MG3700

File Edit Transfer Setting Simulation

o Byl

Gommon Channel 1 | Ghannel 2 | Channel 3 | Ghannel 4 |

Chaninel 1 Parameter

Pawer Delay Profils

Input File DL_MIMO_MatrixB D 000
Fading Profile : [MIMO Mabile WiMAX/2x2 MIMOATTU _onon
=
=

RF Frequency : |2400.00000000 [MHz] 3-<m

Sampling Rate : (2240000000 [MHz] =

Bandwidth 10.00000000 [MHz] —8000

> 1 1 1 | | 1
fiatternlene HiAEN000000 fims] 00000 05000 1.0000 15000 20000 25000
Delay[us]
Full Scale
Path \ Fading Type Delay [us] Paower [dB] \ Maving Speed [kmih] |Dupp|erFreuuency [Hz]\ Rician K factor [dB «

1 Rayleigh 0.0000 0.00 60.0 133.428 -
2 Rayleigh 0.3100 -1.00 i} 133.426

3 Rayleigh 0.7100 -9.00 0.0 133.426

4 Rayleigh 1.0800 -10.00 0.0 133.426

5 Rayleigh 1.7300 -15.00 0.0 133.426

B Rayleigh 25100 -20.00 60.0 133.428

] F i

a

[m]

[m]

[m]

[m]

[m]

]

[m] -
‘4 »

Figure 3.3.5-9 Channel parameter setting screen (2 x 2 MIMO)

Select Correlation Setting of Path1, select Edit to display the
Correlation matrix setting window, and then configure the settings.

The configured settings commonly apply to Channels 1 to 4.

Figure 3.3.5-10 shows the Correlation Matrix setting window after

setting.
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Figure 3.3.5-10 Correlation Matrix setting window
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3.

Confirm that the parameters are correctly set.

Table 3.3.5-1 shows the parameters and their setting in this

example.

Table 3.3.5-1 Mobile WiMAX parameter settings

Parameter

Setting

System Configuration

Channel Configuration

| 2 x 2 MIMO

Tx Antenna Configuration (Tx Antennal and Tx Antenna2)

Input File (Tx Antennal)

DL_MIMO_MatrixB 1.wvi

Input File (Tx Antenna2)

DL_MIMO_MatrixB_2.wvi

RF Frequency 2400 MHz

Sampling Rate 22.4 MHz

Bandwidth 10 MHz

Repetition 1

Pattern Length 5 ms

Channel Setting (Channel 1 to Channel 4)

Fading Profile MIMO Mobile WiMAX/2x2

MIMO/ITU Vehicular A/Medium

Correlation
Moving Speed 60 km/h
Doppler Frequency 133.426 Hz
Round Fading Pattern Selected

Random Seed

Initial value

Rx Antenna Configuration (Rx Antennal and Rx Antenna2)

AWGN

| OFF

Channel (1 to 4) setting

Spectrum Shape

| Classical 6 dB

Correlation Setting (Path 1 to Path 6)

(Medium correlation)

Channel1 Channel2 Channel3 Channel4
Channell 1 0.0 0.7264 0.0
Channel2 0.0 1 0.0 —0.7264
Channel3 0.7264 0.0 1 0.0
Channel4 0.0 —0.7264 0.0 1
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3.8 Waveform Pattern Generation Procedure

Start calculation to generate the waveform.

Select [Calculation] from the [Edit] menu or click the 4L | button
to display the Export File window shown in Figure 3.3.5-11. Set the

package name and export file name, and then click the [OK] button.
Calculation is started and the waveform is generated.

[Eewi Filn g1
Enpuwt Path [EWFrogram FileshAre fsn Corporatmekiagno D
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For, Aavierea 1 |ﬁ[_m_mh-ﬂ_'l
R Anienea 2 DL MO Nav B 2

K
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= FWE Wk " Cartpust G
™ Futn Getting [uE]
1167
o et

T Fremesnoy=od i OO0 W

[5G o F = R, o

i et |
Figure 3.3.5-11 Export File window
When the waveform generation is completed, the window shown in

Figure 3.3.5-12 is displayed. In this window, Level Offset shows the

level ratio of two signal generators. Set the output level of the signal

suonoun,j Jo uorpdrIosa(] pafrereq

generators to these values when using two signal generators.
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Figure 3.3.5-12 Window when waveform generation is completed
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5. Figs. 3.3.5-13 and 3.3.5-14 show the spectra of the generated

waveform data, for Rx Antennal and Rx Antenna2, respectively.
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3.4 Displaying Graph

3.4 Displaying Graph
The generated waveform pattern can be displayed in a CCDF or FFT
graph by using this software. Refer to Sections 4.3 “CCDF Graph
Display” and 4.4 “FFT Graph Display” in the MG3700A/MG3710A Vector
Signal Generator MG3740A Analog Signal Generator Operation Manual
(IQproducer™) for details on displaying graphs.

Displaying CCDF graph

1. Generate a Fading waveform pattern by executing “Calculation.”

2. Select [CCDF] from the [Simulation] menu or click the ‘ S tool
button. The CCDF Graph Monitor screen shown in Figure 3.4-1 is

K

displayed with the trace of the generated waveform pattern. g
ﬁ
&
[
-
)
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Figure 3.4-1 CCDF Graph Monitor screen

When a waveform pattern is generated by changing parameters and
executing “Calculation” while other traces are displayed in the
CCDF Graph Monitor screen, the trace of the waveform pattern
newly generated can be displayed in either of the following two
methods:

e Displaying the new trace in the same screen as the previous
traces
e Deleting the previous traces to display the new trace

3-85



Chapter 8 Detailed Description of Functions

A CCDF graph and an FFT graph cannot be generated at the same
time. When both graphs are to be displayed, complete one graph

generation before generating the other graph.

B When displaying a new trace in the same screen with the previous

traces:

1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF
Graph Monitor screen.

2. Select [CCDF] from the [Simulation] menu or click the ‘ A tool
button. The trace of the waveform pattern newly generated is
additionally displayed in the CCDF Graph Monitor screen.

Up to eight traces can be displayed by repeating this procedure.

B When deleting the previous traces to display a new trace:

1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF
Graph Monitor screen.

2. Select [CCDF] from the [Simulation] menu or click the ‘ S tool
button. The confirmation message shown in Figure 3.4-2 below

appears:

The request for drawing a trace.

There iz a request from the other Idproducer application for drawing a trace.
Delete the displaved trace and draw a new trace®

il |

Figure 3.4-2 Confirmation message

Click [Yes]. The previous traces are deleted from the CCDF Graph
Monitor screen, and the trace of the waveform pattern newly

generated is displayed.
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3.4 Displaying Graph

Displaying FFT graph
1. Generate a Fading waveform pattern by executing “Calculation”.
2. Select [FFT] from the [Simulation] menu or click the /i tool
button. The FFT Graph Monitor screen shown in Figure 3.4-3 is
displayed with the trace of the generated waveform pattern.

FFT Graph Monitor

K

Amplitude (B}
L

FFT Points 131072
Sampl
Rt 0 - | 1etom

Data Length 153600

Guick Add Mode Mause Interaction Soale Cursor

Frequency |3 6s00 = 76300 o Frequency
add Gursar ‘ : e
Amplitude
Full Soals R aw

Figure 3.4-3 FFT Graph Monitor screen

suonoun,j Jo uorpdrIosa(] pafrereq

When a waveform pattern is generated by changing parameters and
executing “Calculation” while other traces are displayed in the FFT
Graph Monitor screen, the trace of the waveform pattern newly
generated can be displayed in either of the following two methods:

e Displaying the new trace in the same screen as the previous

traces
e Deleting the previous traces to display the new trace

A CCDF graph and an FFT graph cannot be generated at the same
time. When both graphs are to be displayed, complete one graph

generation before generating the other graph.
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1.

When displaying a new trace in the same screen with the previous
traces:
Set [Add] for [Quick Add Mode] on the lower-left of the FFT Graph
Monitor screen.
Select [FFT] from the [Simulation] menu or click the /i  tool
button. The trace of the waveform pattern newly generated is
additionally displayed in the FFT Graph Monitor screen.
Up to four traces can be displayed by repeating this procedure.

When deleting the previous traces to display a new trace:
Set [Clear] for [Quick Add Mode] on the lower-left of the FFT Graph
Monitor screen.
Select [FFT] from the [Simulation] menu or click the /il  tool
button. The confirmation message shown in Figure 3.4-4 below

appears:

The reguest for draming a trace.

There i= a request fram the other Iproducer application for drawing a trace.
Delete the dizplaved trace and draw a new trace?

Mo |

Figure 3.4-4 Confirmation message

Click the [Yes] button. The previous traces are deleted from the FFT
Graph Monitor screen, and the trace of the waveform pattern newly

generated is displayed.
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3.6 Marker Output

3.5 Marker Output

This software sets the marker as follows.

e 1 x 1 SISO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to the Rx Antennal waveform pattern.

e 1 x 2 SIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to Rx Antennal and Rx Antenna2 waveform patterns.

e 1 x 3 SIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to Rx Antennal to Rx Antenna3 waveform patterns.

e 1 x4 SIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to Rx Antennal to Rx Antenna4 waveform patterns.

e 2 x 1 MISO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to the Rx Antennal waveform pattern.
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e 2 x 2 MIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, and the marker signal
of the waveform pattern set for Tx Antenna2 is output to the Rx

Antenna2 waveform pattern.

e 2 x 3 MIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, and the marker signal
of the waveform pattern set for Tx Antenna2 is output to the Rx

Antenna2 and Rx Antenna3 waveform patterns.

e 2 x 4 MIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal and Rx Antenna2 waveform patterns, and
the marker signal of the waveform pattern set for Tx Antenna2 is

output to the Rx Antenna3 and Rx Antenna4 waveform patterns.
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3 x 1 MISO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to the Rx Antennal waveform pattern.

3 x 2 MIMO configuration

The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, and the marker signal
of the waveform pattern set for Tx Antenna2 is output to the Rx

Antenna2 waveform pattern.

3 x 3 MIMO configuration

The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, the marker signal of
the waveform pattern set for Tx Antenna2 is output to the Rx
Antenna2 waveform pattern, and the marker signal of the waveform
pattern set for Tx Antenna3 is output to the Rx Antenna3 waveform

pattern.

3 x 4 MIMO configuration

The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, the marker signal of
the waveform pattern set for Tx Antenna2 is output to the Rx
Antenna2 waveform pattern, and the marker signal of the waveform
pattern set for Tx Antenna3 is output to the Rx Antenna3 and Rx

Antenna4 waveform patterns.

4 x 1 MISO configuration
The marker signal of the waveform pattern set for Tx Antennal is

output to the Rx Antennal waveform pattern.

4 x 2 MIMO configuration

The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, and the marker signal
of the waveform pattern set for Tx Antenna2 is output to the Rx

Antenna2 waveform pattern.

4 x 3 MIMO configuration

The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, the marker signal of
the waveform pattern set for Tx Antenna2 is output to the Rx
Antenna2 waveform pattern, and the marker signal of the waveform
pattern set for Tx Antenna3 is output to the Rx Antenna3 waveform

pattern.
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3.6 Marker Output

e 4 x 4 MIMO configuration
The marker signal of the waveform pattern set for Tx Antennal is
output to the Rx Antennal waveform pattern, the marker signal of
the waveform pattern set for Tx Antenna2 is output to the Rx
Antenna2 waveform pattern, the marker signal of the waveform
pattern set for Tx Antenna3 is output to the Rx Antenna3 waveform
pattern, and the marker signal of the waveform pattern set for Tx
Antenna4 is output to the Rx Antenna4 waveform pattern.

For the marker set in Pattern Sync Marker on the Marker Setting
window, the marker signal is overwritten and output to the head of the

waveform pattern as shown in Figure 3.5-1.
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Figure 3.5-1 Pattern Sync Marker signal and RF output
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Chapter 4 How to Use Waveform Patterns

The following operations are required to output a modulated signal from
this equipment using the waveform pattern generated by this software:

e Transferring waveform pattern to internal hard disk

e Loading waveform patterns from the hard disk to the waveform
memory

e Selecting a waveform pattern to be output from this equipment

This chapter explains the details of these operations.

41  For MG3700A, MG3710A or MG3740A .......cccee....... 4-2
4.1.1 Transferring waveform pattern

to internal hard disk ... 4-2

4.1.2 Loading to Waveform Memory ...................... 4-4

4.1.3 Selecting Waveform Pattern..............cc.co....... 4-5
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Chapter 4 How to Use Waveform Patterns

41 For MG3700A, MG3710A or MG3740A

This section describes how to download a waveform pattern created for
the MG3700A/MG3710A/MG3740A to the hard disk of the
MG3700A/MG3710A/MG3740A and output the pattern.

4.1.1 Transferring waveform pattern to internal hard disk

The waveform pattern created with this software can be transferred to
the internal hard disk in the following ways:

Note:
This operation is not necessary if you are using
MG3710A/MG3740A and have generated waveform patterns on
MG3710A/MG3740A.

For MG3700A
e LAN
e CompactFlash Card

For MG3710A or MG3740A
e LAN
e External device such as USB Memory

M Transferring from PC via LAN (MG3700A, MG3710A, MG3740A)
Two IQproducer™ tools can be used to transfer a waveform pattern to
the MG3700A/MG3710A/MG3740A via a LAN.

e Transfer & Setting Wizard
Start this wizard by clicking the Transfer & Setting Wizard button of
this software or by selecting Simulation & Utility tab — Transfer &
Setting Wizard from the IQproducer™ after creating a waveform
pattern. For details, refer to Section 4.7 “File Transfer and Loading to
Memory Using Transfer & Setting Wizard” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™),
Transferring a waveform pattern to the internal hard disk of the
MG3700A/MG3710A/MG3740A, loading the waveform from the hard
disk to the waveform memory, and then outputting the waveform

pattern can be done using this wizard.




4.1 For MG3700A, MG3710A or MG3740A

e Transfer & Setting Panel
This function is loaded by selecting Transfer & Setting Panel in the
Simulation & Utility tab of the IQproducer™. For details, refer to
Section 5.2 “Transferring Waveform Pattern” in the
MG3700A/MG3710A MG3740A Analog Signal GeneratorOperation
Manual IQproducer™.
Specify the folder that contains the waveform pattern to transfer to
the MG3700A/MG3710A/MG3740A in the PC-side tree of Transfer &
Setting Panel.

H Transferring using a CF card (MG3700A)
Copy the waveform pattern (*** wvi and ***.wvd files) to be downloaded
to the MG3700A to the root directory of a CF card.

Insert the CF card into the card slot on the front panel of the MG3700A,
and then copy the file to the hard disk. For details about how to use a CF
card to transfer a waveform pattern, refer to (1) Loading waveform file in
memory in Section 3.5.2 of the MG3700A Vector Signal Generator

Operation Manual (Mainframe).

M Transferring via external device such as USB memory (MG3710A,
MG3740A)

For details about how to transfer a waveform pattern created using this
software to the hard disk of the MG3710A/MG3740A, refer to Section
7.3.6 “Copying external waveform pattern: Copy” in the “MG3710A
Vector Signal Generator MG3740A Analog Signal Generator Operation
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41.2 Loading to Waveform Memory

To output a modulated signal using a waveform pattern, it is necessary to
load the waveform pattern that was transferred to the internal hard disk
of the MG3700A/MG3710A/MG3740A (described in Section 4.1.1
“Transferring waveform pattern to internal hard disk”) to the waveform
memory. A waveform pattern can be loaded into the waveform memory in

the following two ways.

M Configuring using the mainframe
A waveform pattern can be loaded into the waveform memory by using
the instruction panel of the MG3700A/MG3710A/MG3740A or by using a

remote command.
For operation using the front panel, refer below:

e Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A
Vector Signal Generator Operation Manual (Mainframe)

e Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A
Vector Signal Generator MG3740A Analog Signal
GeneratorOperation Manual (Mainframe)

For operation using remote commands, refer below:

e Chapter 4 “Remote Control” in the MG3700A Vector Signal
Generator Operation Manual (Mainframe)

e Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A
Vector Signal Generator MG3740A Analog Signal Generator

Operation Manual (Mainframe)

B Using Transfer & Setting Panel of IQproducer™

A waveform pattern can be loaded from the LAN-connected PC to the
memory by using Transfer & Setting Panel, which can be opened from
the Simulation & Utility tab. For details, refer to Section 4.6 “File
Transfer and Loading to Memory Using Transfer & Setting Panel” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (IQproducer™).




4.1 For MG3700A, MG3710A or MG3740A

4.1.3 Selecting Waveform Pattern

Select a waveform pattern to use for modulation from the waveform
patterns loaded into the waveform memory of the
MG3700A/MG3710A/MG3740A according to Section 4.1.2 “Loading to
waveform memory”. A waveform pattern can be selected in the following

two ways.

M Configuring using the MG3700A/MG3710A/MG3740A
Waveform patterns to be used for modulation can be selected by
operating the equipment panel or by using a remote command.

For operation using the front panel, refer below:

e Section 3.5.2 (4) “Outputting pattern loaded in Memory A for
modulation in Edit mode” in the MG3700A Vector Signal Generator

Operation Manual (Mainframe)

e Section 7.3.5 “Selecting output waveform pattern: Select” in the
MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)

For operation using remote commands, refer below:

e Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator
Operation Manual (Mainframe)

e Section 7.3.5 “Selecting output waveform pattern: Select” in the
MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
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B Using Transfer & Setting Panel of IQproducer™

A waveform pattern can be loaded from the LAN-connected PC to the
memory, and also selected for modulation. This is done by using Transfer
& Setting Panel, which can be opened from the Simulation & Utility tab.
For details, refer to Section 4.6 “File Transfer and Loading to Memory
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector
Signal Generator MG3740A Analog Signal Generator Operation Manual
(IQproducer™).
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Appendix A FError Messages

A list of error messages is shown below.

In this list, x, n;, and n2

indicate a numeric value, and sindicates a character string.

Table A-1

Error messages

Error Message

Description

The Setting value is out of range.(“s= x(nn; — n2)")

The value of x set in parameter s is out of the
setting range between n; and na.

Cannot write file

Data cannot be written to the file.

Cannot read file

The file cannot be read.

Cannot open file.

The file cannot be opend.

Cannot write file(“s").

Data cannot be written to file s.

Input File is not found(“s”).

File s cannot be found.

Invalid file format.

The file format is invalid.

Invalid file format. (s)

The format of file s1is invalid.

Input Package Name.

Input a package name.

Input Export File Name.

Input an export file name.

Input File 1s not selected.

An input file has not been selected.

Cannot calculate because all paths are disable in
some channels.

Calculation cannot be done because there is a
channel with all its paths disabled.

Wrong pattern license.

The license for the waveform pattern selected is
invalid.

Out of Range: Sampling Rate (kHz) (20-8000)

The sampling rate is out of the range of 20 to
8000 kHz.

Out of Range: Sampling Rate (MHz) (0.02-8)

The sampling rate is out of the range of 0.02 to 8
MHz.

Sampling Rate is mismatch.

The sampling rate of the waveform pattern set in
Tx Antenna do not match.

Data Points is mismatch.

The number of data points of the waveform
pattern set in Tx Antenna do not match.

Spectrum is mismatch.

The waveform spectrum set in Tx Antenna does
not match.

This pattern cannot use. Because “Internal FIR”
1s used.

Calculation cannot be done because “Internal

FIR” is used in the selected pattern file.

The number of samples is over 256M samples.

The waveform pattern size after generation is
over 256 Msamples.

The number of samples is over 512M samples.

The waveform pattern size after generation is
over 512 M samples.

Not enough hard disk space.
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A list of warning messages is shown below.

Table A-2 Warning messages

Warning Message

Description

Input waveform pattern include some licensed
patterns.

A waveform pattern that requires a license has
been selected.

Clipping was done.

The clipping has been completed.

n; samples were clipped.

n: sample(s) have been clipped.

If you change Input File Format, the file
information currently opened will be discarded.
Are you sure to change Input File Format?

Current information will be lost if the input file
format is changed.

Are you sure you want to change the input file
format?




Appendix B Fading Profile Details

Table B-1 GSM [1]

Fading Profile Path Type Delay [us] Power [dB]
1 Rice 0.0 0.0
Rural Area 6 tap 2 Rayleigh 0.1 -4.0
(Moving Speed = 130 km/h 3 Rayleigh 0.2 -8.0
Rician K factor = 6.89 dB 4 Rayleigh 0.3 -12.0
Angle of Arrival = 45 deg) 5 Rayleigh 0.4 -16.0
6 Rayleigh 0.5 -20.0
Rural Area 4 tap 1 Rice 0.0 0.0
(Moving Speed = 130 km/h 2 Rayleigh 0.2 -2.0
Rician K factor = 8.26 dB 3 Rayleigh 0.4 -10.0
Angle of Arrival = 45 deg) 4 Rayleigh 0.6 -20.0
1 Rayleigh 0.0 -10.0
2 Rayleigh 0.1 -8.0
3 Rayleigh 0.3 -6.0
4 Rayleigh 0.5 -4.0 >
5 Rayleigh 0.7 0.0 3
Hilly Terrain 12 tap-1 6 Rayleigh 1.0 0.0 a
(Moving Speed 100 = km/h) 7 Rayleigh 1.3 -4.0 X
8 Rayleigh 15.0 -8.0 >
9 Rayleigh 15.2 -9.0 g
10 Rayleigh 15.7 -10.0 g
11 Rayleigh 17.2 -12.0 =
12 Rayleigh 20.0 -14.0 ;
1 Rayleigh 0.0 -10.0
2 Rayleigh 0.2 -8.0
3 Rayleigh 0.4 -6.0
4 Rayleigh 0.6 -4.0
5 Rayleigh 0.8 0.0
Hilly Terrain 12 tap-2 6 Rayleigh 2.0 0.0
(Moving Speed = 100 km/h) 7 Rayleigh 2.4 -4.0
8 Rayleigh 15.0 -8.0
9 Rayleigh 15.2 -9.0
10 Rayleigh 15.8 -10.0
11 Rayleigh 17.2 -12.0
12 Rayleigh 20.0 -14.0
1 Rayleigh 0.0 0.0
2 Rayleigh 0.1 -1.5
Hilly Terrain 6 tap-1 3 Rayleigh 0.3 -4.5
(Moving Speed = 100 km/h) 4 Rayleigh 0.5 -7.5
5 Rayleigh 15.0 -8.0
6 Rayleigh 17.2 -17.7
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Table B-1  GSM [1] (Cont'd)

Fading Profile Path Type Delay [us] Power [dB]
1 Rayleigh 0.0 0.0
2 Rayleigh 0.2 -2.0
Hilly Terrain 6 tap-2 3 Rayleigh 0.4 -4.0
(Moving Speed = 100 km/h) 4 Rayleigh 0.6 -7.0
5 Rayleigh 15.0 -6.0
6 Rayleigh 17.2 -12.0
1 Rayleigh 0.0 -4.0
2 Rayleigh 0.1 -3.0
3 Rayleigh 0.3 0.0
4 Rayleigh 0.5 -2.6
5 Rayleigh 0.8 -3.0
Urban Area 12 tap-1 6 Rayleigh 1.1 -5.0
(Moving Speed = 100 km/h) 7 Rayleigh 1.3 -7.0
8 Rayleigh 1.7 -5.0
9 Rayleigh 2.3 -6.5
10 Rayleigh 3.1 -8.6
11 Rayleigh 3.2 -11.0
12 Rayleigh 5.0 -10.0
1 Rayleigh 0.0 -4.0
2 Rayleigh 0.2 -3.0
3 Rayleigh 0.4 0.0
4 Rayleigh 0.6 -2.0
5 Rayleigh 0.8 -3.0
Urban Area 12 tap-2 6 Rayleigh 1.2 -5.0
(Moving Speed = 100 km) 7 Rayleigh 1.4 -7.0
8 Rayleigh 1.8 -5.0
9 Rayleigh 2.4 -6.0
10 Rayleigh 3.0 -9.0
11 Rayleigh 3.2 -11.0
12 Rayleigh 5.0 -10.0
1 Rayleigh 0.0 -3.0
2 Rayleigh 0.2 0.0
Urban Area 6 tap-1 3 Rayleigh 0.5 -2.0
(Moving Speed = 100 km/h) 4 Rayleigh 1.6 -6.0
5 Rayleigh 2.3 -8.0
6 Rayleigh 5.0 -10.0
1 Rayleigh 0.0 -3.0
2 Rayleigh 0.2 0.0
Urban Area 6 tap-2 3 Rayleigh 0.6 -2.0
(Moving Speed = 100 km/h) 4 Rayleigh 1.6 -6.0
5 Rayleigh 2.4 -8.0
6 Rayleigh 5.0 -10.0




Appendix B Fading Profile Details

Table B-1 GSM [1] (Cont’d)
Fading Profile Path Type Delay [us] Power [dB]
1 Rayleigh 0.0 0.0
2 Rayleigh 3.2 0.0
Equalization Test 6 tap 3 Rayleigh 6.4 0.0
(Moving Speed = 100 km/h) 4 Rayleigh 9.6 0.0
5 Rayleigh 12.8 0.0
6 Rayleigh 16.0 0.0
Typical small cell 2 tap 1 Rayleigh 0.0 0.0
(Moving Speed = 5 km/h) 2 Rayleigh 0.4 0.0
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Appendix B Fading Profile Details

Table B-2 W-CDMA (MS) [2]

Fading Profile Path Type Delay [us] Power [dB]

Case 1 .
2.3 km/h (Moving Speed = 2.3 km/h) ! Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) .
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 ~10.0
8 km/h (Moving Speed = 8 km/h)
Case 2 ( ) 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h .
3 km/h (Moving Speed = 3 km/h) 2 Rayleigh 0.976 0.0
4.1 km/h (Moving Speed = 4.1 km/h)
7 km/h (Moving Speed = 7 km/h) 3 Rayleigh 20 0.0
8 km/h (Moving Speed = 8 km/h)
Case 3 1 Rayleigh 0.0 0.0
92 km/h (Moving Speed = 92 km/h) ) Rayleigh 0.26 -3.0
120 km/h (Moving Speed = 120 km/h) . B
166 km/h (Moving Speed = 166 km/h) 5 Rayleigh 0.521 6.0
282 km/h (Moving Speed = 282 km/h) 4 Rayleigh 0.781 9.0
320 km/h (Moving Speed = 320 km/h)
Case 4 .
2.3 km/h (Moving Speed = 2.3 km/h) 1 Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) .
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 0.0
8 km/h (Moving Speed = 8 km/h)
Case 5 .
38 km/h (Moving Speed = 38 km/h) 1 Rayleigh 0.0 0.0
50 km/h (Moving Speed = 50 km/h)
69 km/h (Moving Speed = 69 km/h) .
118 km/h (Moving Speed = 118 km/h) 2 Rayleigh 0.976 -10.0
133 km/h (Moving Speed = 133 km/h)
Case 6 1 Rayleigh 0.0 0.0
192 km/h (Moving Speed = 192 km/h) 2 Rayleigh 0.26 ~3.0
250 km/h (Moving Speed = 250 km/h) .

3 Rayleigh 0.521 -6.0
345 km/h (Moving Speed = 345 km/h) ayele
583 km/h (Moving Speed = 583 km/h) 4 Rayleigh 0.781 ~9.0
688 km/h (Moving Speed = 688 km/h)
Moving propagation Refer to Sections 3.1.4 “Moving Propagation tab window,”
Birth-Death propagation 3.1.5 “Birth-Death Propagation tab window,” and 3.1.6 “High
High Speed Train Speed Train tab window.”
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Table B-3 W-CDMA (BS) [3]

Fading Profile Path Type Delay [us] Power [dB]
Casel .
2.3 km/h (Moving Speed = 2.3 km/h) ! Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) )
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 ~10.0
8 km/h (Moving Speed = 8 km/h)
Case2 ( ) Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h .
3 km/h (Moving Speed = 3 km/h) 2 Rayleigh 0.976 0.0
4.1 km/h (Moving Speed = 4.1 km/h)
7 km/h (Moving Speed = 7 km/h) 3 Rayleigh 20 0.0
8 km/h (Moving Speed = 8 km/h)
Case3 1 Rayleigh 0.0 0.0
92 km/h (Moving Speed = 92 km/h) 92 Rayleigh 0.26 3.0
120 km/h (Moving Speed = 120 km/h) :
3 Rayleigh 0.521 -6.0
166 km/h (Moving Speed = 166 km/h) ayele >
280 km/h (Movmg Speed =280 km/h) 4 Rayleigh 0.781 9.0 5
320 km/h (Moving Speed = 320 km/h) o
Case4 1 Rayleigh 0.0 0.0 %
192 km/h (Moving Speed = 192 km/h) 2 Rayleigh 0.260 3.0
250 km/h (Moving Speed = 250 km/h) .
3 Rayleigh 0.521 -6.0
345 km/h (Moving Speed = 345 km/h) e g
583 km/h (Moving Speed = 583 km/h) 4 Rayleigh 0.781 ~9.0 S
668 km/h (Moving Speed = 668 km/h) 2.
. . o
Moving propagation Refer to Sections 3.1.4 “Moving Propagation tab window,” w4
Birth-Death propagation 3.1.5 “Birth-Death Propagation tab window,” and 3.1.6 “High e
High Speed Train Speed Train tab window.”
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Table B-4 HSDPA [2]

8 km/h (Moving Speed = 8 km/h)

Fading Profile Path Type Delay [us] Power [dB]
Casel .
2.3 km/h (Moving Speed = 2.3 km/h) 1 Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) .
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 -10.0
8 km/h (Moving Speed = 8 km/h)
Case2 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) :
3 km/h (Moving Speed = 3 km/h) 2 Rayleigh 0.976 0.0
4.1 km/h (Moving Speed = 4.1 km/h)
7 km/h (Moving Speed = 7 km/h) 3 Rayleigh 20 0.0
8 km/h (Moving Speed = 8 km/h)
Case3 1 Rayleigh 0.0 0.0
92 kﬁl/l’; h(lz/[l\c/iving Sgeedd= 92 krri{/h)/h) 2 Rayleigh 0.26 ~3.0
120 km oving Speed = 120 km . B
166 km/h (Moving Speed = 166 km/h) 5 Rayleigh 0.521 6.0
282 km/h (MOV}ng Speed = 282 km/h) 4 Rayleigh 0.781 9.0
320 km/h (Moving Speed = 320 km/h)
Case4 .
2.3 km/h (Moving Speed = 2.3 km/h) 1 Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) .
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 0.0
8 km/h (Moving Speed = 8 km/h)
Caseb .
38 km/h (Moving Speed = 38 km/h) 1 Rayleigh 0.0 0.0
50 km/h (Moving Speed = 50 km/h)
69 km/h (Moving Speed = 69 km/h) )
118 km/h (Moving Speed = 118 km/h) 2 Rayleigh 0.976 -10.0
133 km/h (Moving Speed = 133 km/h)
Case6 1 Rayleigh 0.0 0.0
192 km/h EMoving Speed =192 km/h; 9 Rayleigh 0.26 _3.0
250 km/h (Moving Speed = 250 km/h - B
345 km/h (Moving Speed = 345 km/h) |—— Rayleigh 0.521 6.0
583 km/h (Moving Speed = 583 km/h) 4 Rayleigh 0.781 ~9.0
688 km/h (Moving Speed = 688 km/h)
Case8 .
23 km/h (Moving Speed = 23 km/h) 1 Rayleigh 0.0 0.0
30 km/h (Moving Speed = 30 km/h)
41 km/h (Moving Speed = 41 km/h) .
71 km/h (Moving Speed = 71 km/h) 2 Rayleigh 0.976 -10.0
80 km/h (Moving Speed = 80 km/h)
ITU Pedestrian A 1 Rayleigh 0.0 0.0
2.1{1 k;l}ll/}(l]_\/([MOVing Spe;fd = li.B/l}{lI)m/h) 2 Rayleigh 0.11 9.7
3 km oving Speed = 3 km : _
4.1 km/h (Moving Speed = 4.1 km/h) 5 Rayleigh 0.19 19.2
7 km/h (Moving Speed = 7 km/h) 4 Rayleigh 0.41 _99.8
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Table B-4 HSDPA [2] (Continued)

Fading Profile Path Type Delay [us] Power [dB]

ITU Pedestrian B 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) 2 Rayleigh 0.2 ~0.9
3 km/h (Moving Speed = 3 km/h) 3 Rayleigh 0.8 -4.9
4.1 km/h (Moving Speed = 4.1 km/h) 4 Rayleigh 1.2 -8.0
7 img %0"@% Speeg =17 im% 5 Rayleigh 2.3 7.8
8 km/h (Moving Speed = 8 km 6 Rayleigh 3.7 ~93.9
ITU Vehicular A 1 Rayleigh 0.0 0.0
2.13 k;l}ll/?N([Moving Spi‘fd = l2{.3/1}(11)11/h) ) Rayleigh 0.31 -1.0
3 km oving Speed = 3 km Ravleich 1 B
4.1 km/h (Moving Speed = 4.1 km/h) 3 ay e?g 0.7 9.0
7 km/h (Moving Speed = 7 km/h) 4 Rayle?gh 1.09 ~10.0
23 km/h (Moving Speed = 23 km/h) 5 Rayleigh 1.73 -15.0

30 km/h (Moving Speed = 30 km/h)
41 km/h (Moving Speed = 41 km/h)
71 km/h (Moving Speed = 71 km/h)
80 km/h (Moving Speed = 80 km/h)
92 km/h (Moving Speed = 92 km/h) 6 Rayleigh 2.51 -20.0
120 km/h (Moving Speed = 120 km/h)
166 km/h (Moving Speed = 166 km/h)
282 km/h (Moving Speed = 282 km/h)
320 km/h (Moving Speed = 320 km/h)
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Table B-5 HSUPA [3]

Fading Profile Path Type Delay [us] Power [dB]

Casel .
2.3 km/h (Moving Speed = 2.3 km/h) 1 Rayleigh 0.0 0.0
3 km/h (Moving Speed = 3 km/h)
4.1 km/h (Moving Speed = 4.1 km/h) .
7 km/h (Moving Speed = 7 km/h) 2 Rayleigh 0.976 -10.0
8 km/h (Moving Speed = 8 km/h)
Case2 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) :
3 km/h (Moving Speed = 3 km/h) 2 Rayleigh 0.976 0.0
4.1 km/h (Moving Speed = 4.1 km/h)
7 km/h (Moving Speed = 7 km/h) 3 Rayleigh 20 0.0
8 km/h (Moving Speed = 8 km/h)
Case3 1 Rayleigh 0.0 0.0
92 km/h (Moving Speed = 92 km/h) ) Rayleigh 0.26 -3.0
120 km/h (Moving Speed = 120 km/h) . _
166 km/h (Moving Speed = 166 km/h) 5 Rayleigh 0.521 6.0
280 km/h (Moving Speed = 280 km/h) 4 Rayleigh 0.781 9.0
320 km/h (Moving Speed = 320 km/h)
Case4 1 Rayleigh 0.0 0.0
192 km/h (Moving Speed = 192 km/h) 2 Rayleigh 0.26 ~3.0
250 km/h (Moving Speed = 250 km/h) - B
345 km/h (Moving Speed = 345 km/h) |—— Rayleigh 0.521 6.0
583 km/h (Moving Speed = 583 km/h) 4 Rayleigh 0.781 ~9.0
668 km/h (Moving Speed = 668 km/h)
ITU Pedestrian A 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) 2 Rayleigh 0.11 9.7
3 km/h (Moving Speed = 3 km/h) .

3 Rayleigh 0.19 -19.2
4.1 km/h (Moving Speed = 4.1 km/h) ayee
7 km/h (Moving Speed = 7 km/h) 4 Rayleigh 0.41 _99.8
8 km/h (Moving Speed = 8 km/h)
ITU Pedestrian B 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) 2 Rayleigh 0.2 ~0.9
3 km/h (Moving Speed = 3 km/h) 3 Rayleigh 0.8 —4.9
4.1 km/h (Moving Speed = 4.1 km/h) 4 Rayleigh 1.2 -8.0
7 km/h (Moving Speed = 7 km/h) 5 Rayleigh 2.3 78
8 km/h (Moving Speed = 8 km/h) 5 Rayloigh 3.7 239
ITU Vehicular A 1 Rayleigh 0.0 0.0
23 km/h (Moving Speed = 23 km/h) . ~
30 km/h (Moving Speed = 30 km/h) 2 Rayle?gh 0.31 1.0
41 km/h (Moving Speed = 41 km/h) 3 Rayleigh 0.71 -9.0
71 km/h (Moving Speed = 71 km/h) 4 Rayleigh 1.09 ~10.0
80 km/h (Moving Speed = 80 km/h) .
92 km/h (Moving Speed = 92 km/h) 5 Rayleigh 1.73 ~15.0
120 km/h (Moving Speed = 120 km/h)
166 km/h (Moving Speed = 166 km/h) - B
282 km/h (Moving Speed = 282 km/h) 6 Rayleigh 2:51 200
320 km/h (Moving Speed = 320 km/h)
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Table B-6 CDMA2000 (MS) [4]

Fading Profile Path Type Delay [us] Power [dB]

Case 1 1 Rayleigh 0.0 0.0
(Moving Speed = 8 km/h) 2 Rayleigh 2.0 0.0
Case 2 1 Rayleigh 0.0 0.0
14 km/h (Moving Speed = 14 km/h)
30 km/h (Moving Speed = 30 km/h) 2 Rayleigh 2.0 0.0
Case 3 . 0.0
(Moving Speed = 30 km/h) 1 Rayleigh 0.0

1 Rayleigh 0.0 0.0
Case 4 2 Rayleigh 2.0 0.0
(Moving Speed = 100 km/h) yee : :

3 Rayleigh 14.5 -3.0
Case 5 1 Rayleigh 0.0 0.0
(Moving Speed = 0 km/h) 2 Rayleigh 2.0 0.0
Case 6 . 0.0
(Moving Speed = 3 km/h) 1 Rayleigh 0.0

Table B-7 CDMA2000 (BS) [5]
Fading Profile Path Type Delay [us] Power [dB]

Case 1 .
(Moving Speed = 3 km/h) ! Rayleigh 0.0 0.0
Case 2 1 Rayleigh 0.0 0.0
(Moving Speed = 8 km/h) Rayleigh 2.0 0.0
Case 3 .
(Moving Speed = 30 km/h) ! Rayleigh 0.0 0.0

1 Rayleigh 0.0 0.0
Case 4 2 Rayleigh 2.0 0.0
(Moving Speed = 100 km/h) - - -

3 Rayleigh 14.5 -3.0
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Appendix B Fading Profile Details

Table B-8 TD-SCDMA [6]

Fading Profile Path Type Delay [us] Power [dB]
Case 1 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h)
3 km/h (Moving Speed = 3 km/h) 2 Rayleigh 2.928 -10.0
Case 2 1 Rayleigh 0.0 0.0
2.3 km/h (Moving Speed = 2.3 km/h) 2 Rayleigh 2.928 0.0
3 km/h (Moving Speed = 3 km/h) 3 Rayleigh 12.0 0.0
Case 1 Rayleigh 0.0 0.0
92 km/h (Moving Speed = 92 km/h) 2 Rayleigh 0.781 5.0
120 km/h (Moving Speed = 120 km/h) |3 Rayleigh 1.563 —6.0
4 Rayleigh 2.344 -9.0
ITU Pedestrian A 1 Rayleigh 0.0 0.0
2.3 knf/he(sl\/f(l)ililng Speed = 2.3 km/h) 2 Rayle?gh 0.11 9.7
3 km/h (Moving Speed = 3 km/h) 3 Rayleigh 0.19 ~19.2
4 Rayleigh 0.41 -22.8
1 Rayleigh 0.0 0.0
ITU Pedostrian B 2 Rayleigh 0.2 -0.9
2.3 knf/he(sl\/f(l)ililng Speed = 2.3 km/h) 3 Rayle?gh 0.8 4.9
3 km/h (Moving Speed = 3 km/h) 4 Rayleigh 1.2 -8.0
5 Rayleigh 2.3 ~7.8
6 Rayleigh 3.7 -23.9
1 Rayleigh 0.0 0.0
ITU Vehicular A 2 Rayleigh 0.31 ~1.0
23 km/h (Moving Speed = 23 km/h) 3 Rayleigh 071 9.0
30 km/h (Moving Speed = 30 km/h) -
92 km/h (Moving Speed = 92 km/h) 4 Rayleigh 1.09 ~10.0
120 km/h (Moving Speed = 120 km/h) 5 Rayleigh 1.73 -15.0
6 Rayleigh 2.51 -20.0
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Table B9 1xEVDO [7]

Fading Profile Path Type Delay [us] Power [dB]
Configuration 1 1 Rayleigh 0.0 0.0
8 km/h (Moving Speed = 8 km/h)
15 km/h (Moving Speed = 15 km/h) 2 Rayleigh 2.0 0.0
Configuration 2
3 km/h (Moving Speed = 3 km/h) 1 Rayleigh 0.0 0.0

6 km/h (Moving Speed = 6 km/h)

Configuration 3
30 km/h (Moving Speed = 30 km/h) 1 Rayleigh 0.0 0.0
58 km/h (Moving Speed = 58 km/h)

Configuration 4 1 Rayleigh 0.0 0.0
100 km/h (Moving Speed = 100 km/h) 2 Rayleigh 2.0 0.0
192 km/h (Moving Speed = 192 km/h) 3 Rayleigh 14.5 ~3.0
Configuration 5 1 Rayleigh 0.0 0.0
(Moving Speed = 0 km/h) 2 Rayleigh 2.0 -0.0
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Table B-10 WLAN [8]

Fading Profile Path Type Delay [us] Power [dB]
1 Rayleigh 0.000 0.0
2 Rayleigh 0.010 -0.9
3 Rayleigh 0.020 -1.7
4 Rayleigh 0.030 -2.6
5 Rayleigh 0.040 -3.5
6 Rayleigh 0.050 -4.3
7 Rayleigh 0.060 -5.2
8 Rayleigh 0.070 -6.1
Model A 9 Rayleigh 0.080 -6.9
(Moving Speed = 10.8 km/h) 10 Rayleigh 0.090 -7.8
11 Rayleigh 0.110 -4.7
12 Rayleigh 0.140 -7.3
13 Rayleigh 0.170 -9.9
14 Rayleigh 0.200 -12.5
15 Rayleigh 0.240 -13.7
16 Rayleigh 0.290 -18.0
17 Rayleigh 0.340 -22.4
18 Rayleigh 0.390 -26.7
1 Rayleigh 0.000 -2.6
2 Rayleigh 0.010 -3.0
3 Rayleigh 0.020 -3.5
4 Rayleigh 0.030 -3.9
5 Rayleigh 0.050 0.0
6 Rayleigh 0.080 -1.3
7 Rayleigh 0.110 -2.6
8 Rayleigh 0.140 -3.9
Model B 9 Rayleigh 0.180 -3.4
(Moving Speed = 10.8 km/h) 10 Rayleigh 0.230 -5.6
11 Rayleigh 0.280 =7.7
12 Rayleigh 0.330 -9.9
13 Rayleigh 0.380 -12.1
14 Rayleigh 0.430 -14.3
15 Rayleigh 0.490 -15.4
16 Rayleigh 0.560 -18.4
17 Rayleigh 0.640 -20.7
18 Rayleigh 0.730 -24.6
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Table B-10 WLAN [8] (Cont’d)

Fading Profile Path Type Delay [us] Power [dB]

1 Rayleigh 0.000 -3.3
2 Rayleigh 0.010 -3.6
3 Rayleigh 0.020 -3.9
4 Rayleigh 0.030 -4.2
5 Rayleigh 0.050 0.0
6 Rayleigh 0.080 -0.9
7 Rayleigh 0.110 -1.7
8 Rayleigh 0.140 -2.6

Model C 9 Rayleigh 0.180 -1.5

(Moving Speed = 10.8 km/h) 10 Rayleigh 0.230 -3.0
11 Rayleigh 0.280 -4.4
12 Rayleigh 0.330 -5.9
13 Rayleigh 0.400 -5.3
14 Rayleigh 0.490 -7.9 >
15 Rayleigh 0.600 9.4 3
16 Rayleigh 0.730 -13.2 a
17 Rayleigh 0.880 ~16.3 X
18 Rayleigh 1.050 -21.2 >
1 Rayleigh 0.000 0.0 g
2 Rayleigh 0.010 -10.0 g
3 Rayleigh 0.020 -10.3 e
4 Rayleigh 0.030 -10.6 ;
5 Rayleigh 0.050 -6.4
6 Rayleigh 0.080 -7.2
7 Rayleigh 0.110 -8.1
8 Rayleigh 0.140 -9.0

Model D 9 Rayleigh 0.180 -7.9

(Moving Speed = 10.8 km/h) 10 Rayleigh 0.230 -94
11 Rayleigh 0.280 -10.8
12 Rayleigh 0.330 -12.3
13 Rayleigh 0.400 -11.7
14 Rayleigh 0.490 -14.3
15 Rayleigh 0.600 -15.8
16 Rayleigh 0.730 -19.6
17 Rayleigh 0.880 —22.7
18 Rayleigh 1.050 -27.6
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Table B-10 WLAN [8] (Cont’d)

Fading Profile Path Type Delay [us] Power [dB]

1 Rayleigh 0.000 -4.9
2 Rayleigh 0.010 -5.1
3 Rayleigh 0.020 -5.2
4 Rayleigh 0.040 -0.8
5 Rayleigh 0.070 -1.3
6 Rayleigh 0.100 -1.9
7 Rayleigh 0.140 -0.3
8 Rayleigh 0.190 -1.2

Model E 9 Rayleigh 0.240 -2.1

(Moving Speed = 10.8 km/h) 10 Rayleigh 0.320 0.0
11 Rayleigh 0.430 -1.9
12 Rayleigh 0.560 -2.8
13 Rayleigh 0.710 -5.4
14 Rayleigh 0.880 -7.3
15 Rayleigh 1.070 -10.6
16 Rayleigh 1.280 -13.4
17 Rayleigh 1.510 -17.4
18 Rayleigh 1.760 -20.9
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Table B-11  Mobile WiMAX [9]
Fading Profile Path Type Delay [us] Power [dB]
1 Rayleigh 0.0 0.0
2 Rayleigh 0.2 -0.9
ITU Pedestrian B 3 Rayleigh 0.8 -4.9
(Moving Speed 3 = km/h) 4 Rayleigh 1.2 -8.0
5 Rayleigh 2.3 -7.8
6 Rayleigh 3.7 -23.9
1 Rayleigh 0.0 0.0
2 Rayleigh 0.31 -1.0
ITU Vehicular A 3 Rayleigh 0.71 -9.0
(Moving Speed = 60 km/h) 4 Rayleigh 1.09 -10.0
5 Rayleigh 1.73 -15.0
6 Rayleigh 2.51 -20.0
1 Rayleigh 0.0 0.0
2 Rayleigh 0.31 -1.0
Large delay spread channel 3 Rayleigh 0.71 -9.0
(Moving Speed = 120 km/h) 4 Rayleigh 1.09 -10.0
5 Rayleigh 1.73 -15.0
6 Rayleigh 10.0 -20.0
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Table B-12 2 x 2 MIMO Mobile WiMAX [9]

Correlation Matrix (2 x 2 MIMO)

ITU Pedestrian B 3km/h

High
correlation

Path 1 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.1468 + 0.41561 0.0303 + 0.70641 -0.298 - 0.091111
Channel 2 | -0.1468 — 0.41561 1.00000 0.28913 — 0.116291 0.0303 + 0.70641
Channel 3 0.0303 — 0.70641 0.28913 + 0.116291 1.00000 -0.1468 + 0.41561
Channel 4 | -0.29803 + 0.09111i 0.0303 — 0.70641 —0.1468 — 0.41561 1.00000

Path 2 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 —0.4467 + 0.42271 —-0.4007 - 0.60731 0.4357 + 0.101911
Channel 2 | -0.4467 — 0.42271 1.00000 -0.07771 - 0.440661 | -0.4007 — 0.60731
Channel 3 | -0.4007 +0.60731 | -0.07771 — 0.44066i1 1.00000 —-0.4467 + 0.42271
Channel 4 | 0.4357 - 0.101911 -0.4007 + 0.60731 —0.4467 - 0.42271 1.00000

Path 3 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.2906 + 0.43471 -0.6664 + 0.2621 0.07976 — 0.365821
Channel 2 | -0.2906 — 0.4347i 1.00000 0.30755 + 0.213551 —-0.6664 + 0.2621
Channel 3 —-0.6664 — 0.2621 0.30755 — 0.213551 1.00000 -0.2906 + 0.43471
Channel 4 | 0.07976 + 0.36582i -0.6664 — 0.2621 —0.2906 — 0.43471 1.00000

Path 4 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.4273 + 0.42591 -0.6522 + 0.20881 0.18976 — 0.3671
Channel 2 | -0.4273 - 0.42591 1.00000 0.36761 + 0.188551 -0.6522 + 0.20881
Channel 3 | -0.6522 — 0.2088i 0.36761 — 0.188551 1.00000 —-0.4273 + 0.42591
Channel 4 0.18976 + 0.3671 -0.6522 — 0.2088i1 -0.4273 - 0.42591 1.00000

Path 5 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 —-0.7026 - 0.33951 -0.5378 — 0.48661 0.21266 + 0.524471
Channel 2 | -0.7026 + 0.33951 1.00000 0.54306 + 0.15931 —0.5378 — 0.48661
Channel 3 | -0.5378 + 0.48661 0.54306 — 0.15931 1.00000 —-0.7026 — 0.33951
Channel 4 | 0.21266 — 0.52447i -0.5378 + 0.48661 -0.7026 + 0.33951 1.00000

Path 6 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.45 + 0.4222 1 —0.4564 — 0.56551 0.44413 + 0.061781
Channel 2 -0.45 - 0.422i1 1.00000 -0.03337 + 0.447171 | -0.4564 — 0.56551
Channel 3 | -0.4564 + 0.56551 | —0.03337 — 0.447171 1.00000 -0.45 + 0.42221
Channel 4 | 0.44413 - 0.061781 -0.4564 + 0.56551 —-0.45 - 0.42221 1.00000
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Table B-12 2 x 2 MIMO Mobile WiMAX [9] (Cont’d)

Correlation Matrix (2 x 2 MIMO) ITU Pedestrian B 3km/h
lc\gifelailal}clion P;g;hl go Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 0.7264 0.00000
Channel 2 0.00000 1.00000 0.00000 -0.7264
Channel 3 0.7264 0.00000 1.00000 0.00000
Channel 4 0.00000 -0.7264 0.00000 1.00000
Low Path 1 Channel 1 Channel 2 Channel 3 Channel 4
correlation | Channel 1 1.00000 0.00000 0.02201 + 0.51313i 0.00000
Channel 2 0.00000 1.00000 0.0000 -0.02201 - 0.513131
Channel 3 | 0.02201 - 0.51313i1 0.00000 1.00000 0.00000
Channel 4 0.00000 -0.02201 + 0.513131 0.00000 1.00000
Path 2 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0000 0.0000 -0.29107 — 0.441141 0.0000
Channel 2 0.0000 1.0000 0.0000 0.29107 + 0.441141
Channel 3 | -0.29107 + 0.441141 0.0000 1.0000 0.0000
Channel 4 0.0000 0.29107 — 0.441141 0.0000 1.0000
Path 3 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 -0.48407 + 0.190321 0.00000
Channel 2 0.00000 1.00000 0.00000 0.48407 — 0.190321
Channel 3 | -0.48407 — 0.19032i 0.00000 1.00000 0.00000
Channel 4 0.00000 0.48407 + 0.190321 0.00000 1.00000
Path 4 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 -0.47376 + 0.151671 0.00000
Channel 2 0.00000 1.00000 0.00000 0.47376 — 0.151671
Channel 3 | -0.47376 — 0.151671 0.00000 1.00000 0.00000
Channel 4 0.00000 0.47376 + 0.151671 0.00000 1.00000
Path 5 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 -0.39066 — 0.353471 0.00000
Channel 2 0.00000 1.00000 0.00000 0.39066 + 0.353471
Channel 3 | -0.39066 + 0.353471 0.00000 1.00000 0.00000
Channel 4 0.00000 0.39066 — 0.353471 0.00000 1.00000
Path 6 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 —-0.33153 — 0.410781 0.00000
Channel 2 0.00000 1.00000 0.00000 0.33153 + 0.410781
Channel 3 | -0.33153 + 0.41078i1 0.00000 1.00000 0.00000
Channel 4 0.00000 0.33153 — 0.410781 0.00000 1.00000
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Table B-12 2 x 2 MIMO Mobile WiMAX [9] (Cont’d)

Correlation Matrix (2 x 2 MIMO)

ITU Vehicular A 60km/h, Large delay spread channel

High
correlation

Path 1 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.2366 + 0.43121 0.6883 + 0.12111 —-0.21507 - 0.268141
Channel 2 | -0.2366 — 0.4312i 1.00000 -0.11063 — 0.325441 0.6883 + 0.12111
Channel 3 0.6883 — 0.12111 -0.11063 + 0.325441 1.00000 -0.2366 + 0.43121
Channel 4 | -0.21507 + 0.26814i 0.6883 — 0.12111 -0.2366 — 0.43121 1.00000

Path 2 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.1388 + 0.23431 —-0.3508 — 0.59261 0.09016 + 0.164451
Channel 2 0.1388 — 0.23431 1.00000 —-0.1875 - 0.000061 —-0.3508 - 0.59261
Channel 3 | -0.3508 +0.59261 | -0.18754 + 0.000061 1.00000 0.1388 + 0.23431
Channel 4 | 0.09016 + 0.16445i1 -0.3508 + 0.59261 0.1388 — 0.23431 1.00000

Path 3 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.6443 + 0.3651 0.3884 — 0.56041 -0.0457 + 0.502831
Channel 2 —0.6443 — 0.3651 1.00000 —-0.45479 + 0.21931 0.3884 — 0.56041
Channel 3 0.3884 + 0.56041 -0.45479 - 0.21931 1.00000 -0.6443 + 0.3651
Channel 4 | -0.0457 — 0.50283i 0.3884 + 0.56041 —0.6443 — 0.3651 1.00000

Path 4 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 —0.362 + 0.43311 0.1899 + 0.67951 —0.36304 — 0.163731
Channel 2 -0.362 - 0.43311 1.00000 0.22555 — 0.328231 0.1899 + 0.67951
Channel 3 0.1899 — 0.67951 0.22555 + 0.328231 1.00000 -0.362 + 0.43311
Channel 4 | -0.36304 + 0.163731 0.1899 — 0.67951 -0.362 - 0.43311 1.00000

Path 5 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 -0.7074 + 0.33721 —-0.3933 - 0.5651 0.46874 + 0.267061
Channel 2 | -0.7074 - 0.3372i 1.00000 0.0877 + 0.53231 —-0.3933 - 0.5651
Channel 3 -0.3933 + 0.5651 0.0877 — 0.53231 1.00000 -0.7074 + 0.33721
Channel 4 | 0.46874 — 0.267061 -0.3933 + 0.5651 -0.7074 - 0.33721 1.00000

Path 6 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 —0.4405 + 0.42381 —0.4383 — 0.581 0.43888 + 0.069741
Channel 2 | -0.4405 - 0.4238i1 1.00000 -0.05273 + 0.441241 —-0.4383 - 0.581
Channel 3 —0.4383 + 0.581 -0.05273 — 0.441241 1.00000 -0.4405 + 0.42381
Channel 4 | 0.43888 — 0.06974i -0.4383 + 0.581 -0.4405 - 0.4238i1 1.00000
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Table B-12 2 x 2 MIMO Mobile WiMAX (Cont’d)

Correlation Matrix (2 x 2 MIMO) ITU Vehicular A 60km/h, Large delay spread channel
lc\gifelailal}clion P;g;hl go Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 0.7264 0.00000
Channel 2 0.00000 1.00000 0.00000 -0.7264
Channel 3 0.7264 0.00000 1.00000 0.00000
Channel 4 0.00000 -0.7264 0.00000 1.00000
Low Path 1 Channel 1 Channel 2 Channel 3 Channel 4
correlation | Channel 1 1.00000 0.00000 0.49998 + 0.08797i 0.00000
Channel 2 0.00000 1.00000 0.00000 —0.49998 — 0.087971
Channel 3 | 0.49998 — 0.087971 0.00000 1.00000 0.00000
Channel 4 0.00000 —0.49998 + 0.087971 0.00000 1.00000
Path 2 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 —0.25482 — 0.430461 0.00000
Channel 2 0.00000 1.00000 0.00000 0.25482 + 0.430461
Channel 3 | -0.25482 + 0.430461 0.00000 1.00000 0.00000
Channel 4 0.00000 0.25482 — 0.430461 0.00000 1.00000
Path 3 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 0.28213 — 0.407071 0.00000
Channel 2 0.00000 1.00000 0.00000 -0.28213 + 0.407071
Channel 3 | 0.28213 + 0.407071 0.00000 1.00000 0.00000
Channel 4 0.00000 —-0.28213 — 0.407071 0.00000 1.00000
Path 4 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0000 0.0000 0.13794 + 0.493591 0.0000
Channel 2 0.0000 1.0000 0.0000 -0.13794 — 0.493591
Channel 3 | 0.13794 — 0.49359i 0.0000 1.0000 0.0000
Channel 4 0.0000 -0.13794 + 0.493591 0.0000 1.0000
Path 5 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.00000 0.00000 —-0.28569 — 0.410421 0.00000
Channel 2 0.00000 1.00000 0.00000 0.28569 + 0.410421
Channel 3 | -0.28569 + 0.41042i 0.00000 1.00000 0.00000
Channel 4 0.00000 0.28569 — 0.410421 0.00000 1.00000
Path 6 Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0000 0.0000 —0.31838 — 0.421311 0.0000
Channel 2 0.0000 1.0000 0.0000 0.31838 + 0.421311
Channel 3 | -0.31838 + 0.42131i 0.0000 1.0000 0.0000
Channel 4 0.0000 0.31838 — 0.421311 0.0000 1.0000
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Appendix B Fading Profile Details

Table B-13 DVB-T [10]
Fading Profile Path Type Delay [us] Power [dB]
1 Rayleigh 0.0 -3.0
2 Rayleigh 0.2 0.0
. 3 Rayleigh 0.5 -2.0
T 1 Urban (TU6
ypical Urban (TUG) 4 Rayleigh 1.6 6.0
5 Rayleigh 2.3 -8.0
6 Rayleigh 5.0 -10.0
1 Rice 0.0 0.0
2 Rayleigh 0.1 -4.0
. 3 Rayleigh 0.2 -8.0
T 1 Rural A RAG6
ypical Rural Area (RAG) 4 Rayleigh 0.3 212.0
5 Rayleigh 0.4 -16.0
6 Rayleigh 0.5 -20.0
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Table B-14 LTE (MS) (BS) [11][12]

Fading Profile Path Type Delay [us] Power [dB]

1 Rayleigh 0.00 0.0
2 Rayleigh 0.03 -1.0
3 Rayleigh 0.07 -2.0

Extended Pedestrian A (EPA) 4 Rayleigh 0.09 -3.0
5 Rayleigh 0.11 -8.0
6 Rayleigh 0.19 -17.2
7 Rayleigh 0.41 -20.8
1 Rayleigh 0.00 0.0
2 Rayleigh 0.03 -1.5
3 Rayleigh 0.15 -1.4
4 Rayleigh 0.31 -3.6

Extended Vehicular A (EVA) 5 Rayleigh 0.37 -0.6
6 Rayleigh 0.71 -9.1
7 Rayleigh 1.09 -7.0
8 Rayleigh 1.73 -12.0
9 Rayleigh 2.51 -16.9
1 Rayleigh 0.00 -1.0
2 Rayleigh 0.05 -1.0
3 Rayleigh 0.12 -1.0
4 Rayleigh 0.20 0.0

Extended Typical Urban 5 Rayleigh 0.23 0.0
6 Rayleigh 0.50 0.0
7 Rayleigh 1.6 -3.0
8 Rayleigh 2.3 -5.0
9 Rayleigh 5.0 -7.0

High Speed Train

Refer to 3.1.6 “High Speed Train tab window.”
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Appendix B Fading Profile Details

Table B-15 2 x 2 MIMO LTE [11] [12]

Correlation Matrix( 1x2 SIMO )
R_high Channel 1 Channel 2
Channel 1 1.0 0.9
Channel 2 0.9 1.0
R_low Channel 1 Channel 2
Channel 1 1.0 0.0
Channel 2 0.0 1.0
Table B-15 2 x 2 MIMO LTE [11] [12] (Cont’d)
Correlation Matrix (2 x 2 MIMO)
R_high Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0 0.9 0.9 0.81
Channel 2 0.9 1.0 0.81 0.9
Channel 3 0.9 0.81 1.0 0.9
Channel 4 0.81 0.9 0.9 1.0
R_medium Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0 0.9 0.3 0.27
Channel 2 0.9 1.0 0.27 0.3
Channel 3 0.3 0.27 1.0 0.9
Channel 4 0.27 0.3 0.9 1.0
R_low Channel 1 Channel 2 Channel 3 Channel 4
Channel 1 1.0 0.0 0.0 0.0
Channel 2 0.0 1.0 0.0 0.0
Channel 3 0.0 0.0 1.0 0.0
Channel 4 0.0 0.0 0.0 1.0
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Table B-15 MIMO LTE [11][12] (Cont’d)

Correlation Matrix( 4x2 MIMO )

R_ Ch1 Ch2 Ch3 Ch4 Ch5 Ché Ch7 Ch8
high Chl 1 0.8999 | 0.9883 | 0.8894 | 0.9542 | 0.8587 | 0.8999 | 0.8099
Ch2 | 0.8999 1 0.8894 | 0.9883 | 0.8587 | 0.9542 | 0.8099 | 0.8999
Ch3 | 0.9883 | 0.8894 1 0.8999 | 0.9883 | 0.8894 | 0.9542 | 0.8587
Ch4 | 0.8894 | 0.9883 | 0.8999 1 0.8894 | 0.9883 | 0.8587 | 0.9542
Ch5 | 09542 | 0.8587 | 0.9883 | 0.8894 1 0.8999 | 0.9883 | 0.8894
Ch6 | 0.8587 | 0.9542 | 0.8894 | 0.9883 | 0.8999 1 0.8894 | 0.9883
Ch7 | 0.8999 | 0.8099 | 0.9542 | 0.8587 | 0.9883 | 0.8894 1 0.8999
Ch8 | 0.8099 | 0.8999 | 0.8587 | 0.9542 | 0.8894 | 0.9883 | 0.8999 1
R_me Ch1 Ch2 Ch3 Ch4 Ch5 Ché Ch7 Ch8
dum - eont 1 09 | 08748 | 0.7873 | 0.5856 | 05271 | 0.3 0.27
Ch2 0.9 1 0.7873 | 0.8748 | 05271 | 0.5856 | 0.27 0.3
Ch3 | 0.8748 | 0.7873 1 09 | 08748 | 0.7873 | 0.5856 | 0.5271
Ch4 | 07873 | 08748 | 0.9 1 0.7873 | 0.8748 | 0.5271 | 0.5856
Ch5 | 05856 | 05271 | 0.8748 | 0.7873 1 0.9 | 08748 | 0.7873
Ch6 | 05271 | 05856 | 0.7873 | 0.8748 | 0.9 1 0.7873 | 0.8748
Ch7 0.3 027 | 05856 | 0.5271 | 0.8748 | 0.7873 1 0.9
Ch8 | o027 03 | 05271 | 0.5856 | 0.7873 | 08748 | 0.9 1
R_low Ch1 Ch2 Ch3 Ch4 Ch5 Ché Ch7 Ch8
Chl 1 0 0 0 0 0 0 0
Ch2 0 1 0 0 0 0 0 0
Ch3 0 0 1 0 0 0 0 0
Chd4 0 0 0 1 0 0 0 0
Chb 0 0 0 0 1 0 0 0
Ché 0 0 0 0 0 1 0 0
Ch7 0 0 0 0 0 0 1 0
Chs8 0 0 0 0 0 0 0 1
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Appendix B Fading Profile Details

Table B-15 MIMO LTE [11][12] (Cont’d)

Correlation Matrix( 4x4 MIMO )

high

Ch1 Ch2 Ch3 Ch4 Ch5 Ché Ch7 Chs
Chl 1 0.9882 | 0.9541 | 0.8999 | 0.9882 | 0.9767 | 0.943 | 0.8894
Ch2 | 0.9882 1 0.9882 | 0.9541 | 0.9767 | 0.9882 | 0.9767 | 0.943
Ch3 | 0.9541 | 0.9882 1 0.9882 | 0.943 | 0.9767 | 0.9882 | 0.9767
Ch4 | 08999 | 09541 | 0.9882 1 0.8894 | 0.943 | 0.9767 | 0.9882
Ch5 | 09882 | 09767 | 0943 | 0.8894 1 0.9882 | 0.9541 | 0.8999
Ch6 | 09767 | 09882 | 0.9767 | 0943 | 0.9882 1 0.9882 | 0.9541
Ch7 | 0943 | 09767 | 0.9882 | 0.9767 | 0.9541 | 0.9882 1 0.9882
Ch8 | 0.8894 | 0943 | 09767 | 0.9882 | 0.8999 | 0.9541 | 0.9882 1
Ch9 | 09541 | 0943 | 09105 | 0.8587 | 0.9882 | 0.8999 | 0.9541 | 0.9882
Ch10 | 0943 | 09541 | 0943 | 0.9105 | 0.9767 | 0.9882 | 0.9767 | 0.943
Chll | 09105 | 0943 | 09541 | 0.943 | 0.943 | 0.9767 | 0.9882 | 0.9767
Chl2 | 0.8587 | 09105 | 0.943 | 0.9541 | 0.8894 | 0.943 | 0.9767 | 0.9882
Ch13 | 0.8999 | 0.8894 | 0.8587 | 0.8099 | 0.9541 | 0.943 | 0.9105 | 0.8587
Chl4 | 08894 | 0.8999 | 0.8894 | 0.8587 | 0.943 | 0.9541 | 0.943 | 0.9105
Chl5 | 0.8587 | 0.8894 | 0.8999 | 0.8894 | 0.9105 | 0.943 | 0.9541 | 0.943
Ch16 | 0.8099 | 0.8587 | 0.8894 | 0.8999 | 0.8587 | 0.9105 | 0.943 | 0.9541

Ch9 Ch10 | Chll | Chi2z | Ch13 | Chl4 | Chis | Chl6
Chl | 09541 | 0943 | 09105 | 0.8587 | 0.8999 | 0.8894 | 0.8587 | 0.8099
Ch2 | 0943 | 09541 | 0943 | 09105 | 0.8894 | 0.8999 | 0.8894 | 0.8587
Ch3 | 09105 | 0943 | 09541 | 0943 | 0.8587 | 0.8894 | 0.8999 | 0.8894
Ch4 | 0.8587 | 0.9105 | 0.943 | 0.9541 | 0.8099 | 0.8587 | 0.8894 | 0.8999
Ch5 | 09882 | 09767 | 0943 | 0.8894 | 0.9541 | 0.943 | 0.9105 | 0.8587
Ch6 | 08999 | 09882 | 09767 | 0943 | 0943 | 0.9541 | 0.943 | 0.9105
Ch7 | 09541 | 09767 | 0.9882 | 0.9767 | 0.9105 | 0.943 | 0.9541 | 0.943
Ch8 | 09882 | 0943 | 09767 | 0.9882 | 0.8587 | 0.9105 | 0.943 | 0.9541
Ch9 1 0.9882 | 0.9541 | 0.8999 | 0.9882 | 0.9767 | 0.943 | 0.8894
Ch10 | 0.9882 1 0.9882 | 0.9541 | 0.9767 | 0.9882 | 0.9767 | 0.943
Chll | 09541 | 0.9882 1 0.9882 | 0.943 | 0.9767 | 0.9882 | 0.9767
Chl2 | 0.8999 | 09541 | 0.9882 1 0.8894 | 0.943 | 0.9767 | 0.9882
Ch13 | 09882 | 09767 | 0.943 | 0.8894 1 0.9882 | 0.9541 | 0.8999
Chl4 | 09767 | 09882 | 0.9767 | 0.943 | 0.9882 1 0.9882 | 0.9541
Ch15 | 0943 | 09767 | 0.9882 | 0.9767 | 0.9541 | 0.9882 1 0.9882
Ch16 | 08894 | 0943 | 09767 | 0.9882 | 0.8999 | 0.9541 | 0.9882 1
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Table B-15 MIMO LTE [11][12] (Cont’d)

R _medi
um

Correlation Matrix( 4x4 MIMO )
Ch1 Ch2 Ch3 Ch4 Chb Ché Ch7 Ch8
Chl 1 0.9882 | 0.9541 | 0.8999 | 0.8747 | 0.8645 | 0.8347 | 0.7872
Ch2 | 0.9882 1 0.9882 | 0.9541 | 0.8645 | 0.8747 | 0.8645 | 0.8347
Ch3 0.9541 | 0.9882 1 0.9882 | 0.8347 | 0.8645 | 0.8747 | 0.8645
Ch4 0.8999 | 0.9541 | 0.9882 1 0.7872 | 0.8347 | 0.8645 | 0.8747
Chb 0.8747 | 0.8645 | 0.8347 | 0.7872 1 0.9882 | 0.9541 | 0.8999
Ché 0.8645 | 0.8747 | 0.8645 | 0.8347 | 0.9882 1 0.9882 | 0.9541
Ch7 0.8347 | 0.8645 | 0.8747 | 0.8645 | 0.9541 | 0.9882 1 0.9882
Ch8 0.7872 | 0.8347 | 0.8645 | 0.8747 | 0.8999 | 0.9541 | 0.9882 1
Ch9 0.5855 | 0.5787 | 0.5588 0.527 0.8747 | 0.8645 | 0.8347 | 0.7872
Ch10 0.5787 | 0.5855 | 0.5787 | 0.5588 | 0.8645 | 0.8747 | 0.8645 | 0.8347 >
Chll 0.5588 | 0.5787 | 0.5855 | 0.5787 | 0.8347 | 0.8645 | 0.8747 | 0.8645 %
Ch12 0.527 0.5588 | 0.5787 | 0.5855 | 0.7872 | 0.8347 | 0.8645 | 0.8747 é—.
Ch13 0.3 0.2965 | 0.2862 0.27 0.5855 | 0.5787 | 0.5588 0.527
Ch14 0.2965 0.3 0.2965 | 0.2862 | 0.5787 | 0.5855 | 0.5787 | 0.5588 %>
Ch15 | 02862 | 0.2965 0.3 0.2965 | 0.5588 | 0.5787 | 0.5855 | 0.5787 E
Chi6 | 027 | 02862 | 0.2965 0.3 0.527 | 0.5588 | 0.5787 | 0.5855 E‘-
Ch9 Ch10 Ch11 Chi12 Ch13 Ch14 Chi5 Chi16 ws)
Ch1 0.5855 0.5787 0.5588 0.527 0.3 0.2965 0.2862 0.27
Ch2 0.5787 0.5855 0.5787 0.5588 0.2965 0.3 0.2965 0.2862
Ch3 0.5588 0.5787 0.5855 0.5787 0.2862 0.2965 0.3 0.2965
Ch4 0.5627 0.5588 0.5787 0.5855 0.27 0.2862 0.2965 0.3
Chb 0.8747 0.8645 0.8347 0.7872 0.5855 0.56787 0.5588 0.527
Ché 0.8645 0.8747 0.8645 0.8347 0.56787 0.5855 0.56787 0.5588
Ch7 0.8347 0.8645 0.8747 0.8645 0.5588 0.56787 0.5855 0.56787
Ch8 0.7872 0.8347 0.8645 0.8747 0.527 0.5588 0.56787 0.5855
Ch9 1 0.9882 0.9541 0.8999 0.8747 0.8645 0.8347 0.7872
Ch10 0.9882 1 0.9882 | 0.9541 | 0.8645 | 0.8747 | 0.8645 | 0.8347
Chil 0.9541 | 0.9882 1 0.9882 | 0.8347 | 0.8645 | 0.8747 | 0.8645
Ch12 0.8999 | 0.9541 | 0.9882 1 0.7872 | 0.8347 | 0.8645 | 0.8747
Ch13 0.8747 | 0.8645 | 0.8347 | 0.7872 1 0.9882 | 0.9541 | 0.8999
Ch14 0.8645 | 0.8747 | 0.8645 | 0.8347 | 0.9882 1 0.9882 | 0.9541
Ch15 0.8347 | 0.8645 | 0.8747 | 0.8645 | 0.9541 | 0.9882 1 0.9882
Ch16 0.7872 | 0.8347 | 0.8645 | 0.8747 | 0.8999 | 0.9541 | 0.9882 1
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Table B-15 MIMO LTE [11][12] (Cont’d)

Correlation Matrix( 4x4 MIMO )

Ch8

Chl6

Ch7

Ch1b

Ché6

Ch14

Ch5

Ch13

Ch4
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Ch3

Ch11

Ch2

Ch10

Chl

0
0
0
0
0
0
Ch9

0
0
0
0
0
0

0
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Appendix C Connecting Multiple MG37004/10A/4
0A Units

A different RF signal must be separately input to two Rx antenna input

connectors to implement a 2 x 2 MIMO configuration.

There are two ways to synchronize signals when connecting multiple
MG3700A, MG3710A or MG3740A units. One is to use an external
Start/Frame Trigger, the other is to use one
MG3700A/MG3710A/MG3740A unit as Master and a second
MG3700A/MG3710A/MG3740A unit as Slave.

C.1 Connecting Multiple MG3700As

Using external Start/Frame Trigger

In this method, signals are synchronized by supplying an external
Start/Frame Trigger to multiple MG3700A units. . Fig. C.1-1 shows a
connection diagram.

10 MHz buffered output I 10 MHz reference input l _g

= ill \ji= = N °

] o 5 o

: == S%T & = gg“l 3

: o=les 113 o=l e =

S| MG3700A#1 (o S8 \’ 2| MG3700A#2 | Sods o l] x
: o 225 IE o 225

S o 5500 5‘2] S o 5500 ‘5‘2] %>

Start/Frame Trigger T Start/Frame Trigger E

=7

P

Pulse Generator (TTL) Q

Antenna 1 Antenna 2

DUT

Figure C.1-1 Multiple MG3700A connection (external Start/Frame Trigger)

Synchronizing baseband signals

Input a TTL-level pulse signal to the Start/Frame Trigger connector on
the MG3700A #1 as well as the MG3700A #2.

Next, configure the settings as follows for these two MG3700A units.

Start/Frame Trigger:
Trigger = ON
Mode = Start




Appendix C Connecting Multiple MG3700A Units or MG3710A Units

Synchronization between baseband signals is established within one
sampling clock of the waveform pattern with Delay = 0 (excluding an
external cable delay error). . Fig. C-2 shows the synchronization
relationship of the two signal generators. . Sampling clock a is
determined by the sampling rate of the waveform pattern that is
generated.

When the sampling rate is 20 MHz or lower:

a= sampling rate x 2" (n is a value where 80M < a < 160M)

When the sampling rate is higher than 20 MHz:

a = sampling rate

Note that the delay adjustment resolution changes, depending on the

sampling rate. Refer to the following for details.

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
3.5.3 “Setting up external input/output”

The MG3700A waits for the trigger to be input once the Waveform
Restart function key is pressed. . Input the trigger after both of the
MG3700A units are in this state.

Synchronizing RF signals

The RF frequencies of the two MG3700A units are synchronized using a
10 MHz reference clock.

Modify the Phase Adjust setting of either unit when changing the phase
relation of the RF signal.

Start/Frame Trigger

MG3700A#1 Output

MG3700A#2 Output

—>

<1 sampling clock

Figure C.1-2 Synchronization-baseband signals when using external
Start/Frame Trigger




C.1 Connecting Multiple MG3700As

Using Master/Slave

In this method, signals are synchronized by sending a Start/Frame
Trigger from the Master to Slave, where MG3700A#1 is the Master and
MG3700A#2 is the Slave. Master and Slave must be set when generating
waveforms, before the waveform patterns can be used, because the
waveform pattern that is output from the MG3700A set as the Slave side
produces a one frame lag to the Master side when Delay = 0. For the
MX370107A on the Master side, set SG Master/Slave Setting to Master
and select Pattern Sync Marker from Marker 1 to Marker 3, as shown in
Fig. C-3. For the Slave side, SG Master/Slave Setting is automatically set
to Slave.

— R Aintenna Configuration

R fintenna 1 | Rx Antenna 2 I
SG Master/Shve Setting : [Vaster =] |
B |V
AWGHN Bandwidth : |D.D1 000000 [MHz] _g
G : oo [4E] B
=2
Marker 1 IPattern Sync Marker 9:
arker 2 |Up|ink Subframe Pulze X
Marker 2 RF Gate
: Fattern Sync Marker : |Marker1 LI :

Figure C.1-3 Setting example of Master side

>
=]
4]
@
B
[oF
[y
e
aQ

Fig. C.1-4 shows the connection, and Fig. C.1-5 shows the
synchronization relationship of the two signal generators. Compared to
the method using an external Start/Frame Trigger, the synchronization
error between the Master output and Pattern Sync Marker is greater
when using Master/Slave. Refer to the following manual(s) for details on
the operation when the Start/Frame trigger is input.

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
3.5.4 “To output the signal in synchronization with the external
trigger signal.”




Appendix C Connecting Multiple MG3700A Units or MG3710A Units

10 MHz buffered output |

10 MHz reference input *

H @ @ Eé i
(l 5 | MG3700A#1 e MG3700A#2 ST ﬂ'
© S gg22 3 f

@ QPO @ _[m
@ e effgdoo D_;fj

Master Slave f
Start/Frame Trigger
V¥ Antenna 1 Antenna 2y
DUT

Figure C.1-4 Multiple MG3700A connection (Master/Slave)

1 1
1 1
MG3700A#1 Output _<| !
1 T
1 1
1
1
1
1

Start/Frame Trigger ——m—m———u—u—y

MG3700A#2 Output

—|—>:

T'"?R""""""' B

< 1 sampling clock

Figure C.1-5 Synchronization relationship of baseband signals
when using Master/Slave




C.2 Connecting Multiple MG3710A/MG3740As

C.2 Connecting Multiple MG3710A/MG3740As

Using external Start/Frame Trigger

In this method, signals are synchronized by supplying an external
Start/Frame Trigger to multiple MG3710A units. Fig. C.2-1 shows a

connection diagram.
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' Anitsy ' ' Anitsy '
= 0 oo y \ e 0 oo y
Uoomeaaa -0 EEeEEE =0
9 > 8@@@@@ o 9 > 8@@@@@ o
= MG3710A#1  SISSSISEENO) =l MG3710A%2 [SISSSISEERO)
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Figure C.2-1 Multiple MG3710A connection (external Start/Frame Trigger)
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Synchronizing baseband signals

Input a TTL-level pulse signal to the Start/Frame Trigger connector on
the MG3710A #1 as well as the MG3710A #2.

Next, configure the settings as follows for these two MG3710A units.

Start/Frame Trigger:
Trigger = ON
Mode = Start

Synchronization between baseband signals is established within one
sampling clock of the waveform pattern with Delay = 0 (excluding an
external cable delay error). Fig. C.2-2 shows the synchronization

relationship of the two signal generators.

Note that the delay adjustment resolution changes, depending on the
sampling rate. Refer to the following manual(s) for details.

e MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
7.3.8 “Start/Frame Trigger”
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The MG3710A waits for the trigger to be input once the Waveform
Restart function key is pressed. Input the trigger after both of the
MG3710A units are in this state.

Synchronizing RF signals

The RF frequencies of the two MG3710A units are synchronized using a
10 MHz reference clock.

Modify the Phase Adjust setting of either unit when changing the phase
relation of the RF signal.

Start/Frame Trigger

MG3710A#1 Output

)

MG3710A#2 Output

X

1 1
1 1

<1 sampling clock

Figure C.2-2 Synchronization-baseband signals when using external
Start/Frame Trigger




C.2 Connecting Multiple MG3710A/MG3740As

Using Master/Slave

In this method, signals are synchronized by sending a Start/Frame
Trigger from the Master to Slave, where MG3710A#1 is the Master and
MG3710A#2 is the Slave. Master and Slave must be set when generating
waveforms, before the waveform patterns can be used, because the
waveform pattern that is output from the MG3710A set as the Slave side
produces a one frame lag to the Master side when Delay = 0. For the
MX370107A on the Master side, set SG Master/Slave Setting to Master
and select Pattern Sync Marker from Marker 1 to Marker 3, as shown in
Fig. C.2-3. For the Slave side, SG Master/Slave Setting is automatically
set to Slave.

— R Aintenna Configuration

R fintenna 1 | Rx Antenna 2 I
SG Master/Shve Setting : [Vaster =] |
B |V
AWGHN Bandwidth : |D.D1 000000 [MHz] _g
G : oo [4E] B
=2
Marker 1 IPattern Sync Marker 9:
arker 2 |Up|ink Subframe Pulze X
Marker 2 RF Gate
: Fattern Sync Marker : |Marker1 LI :

Figure C.2-3 Setting example of Master side

>
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@
B
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e
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Fig. C.2-4 shows the connection, and Fig. C.2-5 shows the
synchronization relationship of the two signal generators. Compared to
the method using an external Start/Frame Trigger, the synchronization
error between the Master output and Pattern Sync Marker is greater
when using Master/Slave.

Refer to the following manual(s) for details on the operation when the
Start/Frame trigger is input.

e MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
7.3.8 “Start/Frame Trigger”
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Appendix D Fading Characteristic Examples

This appendix provides two fading characteristic examples, the Doppler
spectrum and an accumulated probability distribution/level crossing rate,
as the verification results of the waveform data generated by this

software.
D.1  Doppler Spectrum .........ccoooiiiiiiiiiieeiieea e D-2
D.2 Accumulated Probability Distribution/

Level Crossing Rate ... D-6
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Appendix D Fading Characteristic Examples

D.1 Doppler Spectrum

Figs. D.1-1 to D.1-8 show examples of the spectrum when the Doppler
spectrum is changed with the fading type Rayleigh and Rice.

4 Spectrum Analyzer
@ RBW 100Hz ATT 10dB
@ vBWwW 10Hz SWT 178s|

Reference Level -10.00dBm Pos & Neg

100

Center 2,000 000 000GHz Span 50.00kHz

Trace [YWrite

Figure D.1-1 Rayleigh with Classical 3 dB

4 Spectrum Analyzer [ [=]
@ RBW  100Hz ATT 10dB

@ VBW 10Hz SWT 178s

Reference Level -10.00dBm Pos & Neg

Span 50.00kHz

Center 2,000 000 000GHz

Trace [YWrite

Figure D.1-2 Rayleigh with Classical 6 dB
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D.1 Doppler Spectrum

w4 Spectrum Analyzer

@ REBW Hz
@ vBW 10Hz SWT

Reference Level -10.00dBm Pos & Neg

Center 2.000 000 000GHz Span 50.00kHz

Figure D.1-3 Rayleigh with Flat
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Center 2.000 000 000GHz Span 50.00kHz

Trace [YWrite

Figure D.1-4 Rayleigh with Rounded




Appendix D

Fading Characteristic Examples

kA Spectrum Analyzer

Reference Level -10.00dBm Pos & Neg

ot

Center 2.000 000 000GHz Span 50.00kHz

Trace [YWrite

Figure D.1-5 Rice with Classical 3 dB

kA Spectrum Analyzer

Reference Level -10.00dBm Pos & Neg
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Trace [JWrite

Figure D.1-6 Rice with Classical 6 dB




D.1 Doppler Spectrum
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Figure D.1-7 Rice with Flat
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Figure D.1-8 Rice with Rounded

>
o
-]

o

S

2
Y

Pos & Neg

{ Xtpuaddy

Span 50.00kHz

Center 2.000 000 000GHz




Appendix D Fading Characteristic Examples

D.2 Accumulated Probability Distribution/
Level Crossing Rate

This section describes a calculation example of an accumulated
probability distribution/level crossing rate when a fading processing is
performed by the MX370107A on a tone signal waveform pattern with
the same sampling frequency and length as the MG3700A or MG3710A
standard waveform pattern UL_RMC_12_2kbps.

The setting values of the parameters are as shown in table D.2-1.

Table D.2-1 Accumulated probability distribution/
level crossing rate calculation parameters

System Configuration

Channel Configuration |1 x 1 SISO

Tx Antenna Configuration (Tx Antenna 1)

RF Frequency 2000.00000000 MHz
Sampling Rate 11.52 MHz
Repetition 1
Pattern Length 10220 ms
Channel Setting (Channel 1)
Moving Speed 2.3, 50, 120, 250, 583 km/h
Doppler Frequency 4.262, 92.657, 222.376, 463.283,
1080.377 Hz
Round Fading Pattern Clear
Random Seed 1
Rx Antenna Configuration (Rx Antenna 1)
AWGN | Clear

Reference
[1] IEC 60489-6, Annex C (1999)




D.2 Accumulated Probability Distribution/Level Crossing Rate Example

At Moving Speed = 2.3 km/h
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Figure D.2-2 Level crossing rate (Moving Speed = 2.3 km/h)
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At Moving Speed = 50 km/h
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Figure D.2-3 Accumulated probability distribution (Moving Speed = 50 km/h)
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Figure D.2-4 Level crossing rate (Moving Speed = 50 km/h)
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At Moving Speed = 120 km/h
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At Moving Speed = 250 km/h
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At Moving Speed = 583 km/h

100

Probability (%)

01 |-~

Rayleigh Distribution

0.01

Rayleigh Distribution(+2 dB shift)
Rayleigh Distribution(-2 dB shift)
Moving Speed = 583 (km/h)

10000 ¢

Level Crossing Rate (times/s)

1000 |

100 |

-
o

-30

Figure D.2-9 Accumulated probability distribution (Moving Speed = 583 km/h)

-27.5 -25 -22.5

-20

-17.5 -15 -12.5 -10 -7.5 -5 -2.5 0 25 5 75
Peak Power / Avg. Power (dB)

>
o
-]
o
S
2
Y

{ Xtpuaddy

Rayleigh Distribution

----- Rayleigh Distribution (+20% shift) | |
Rayleigh Distribution (-20% shift)
Moving Speed = 583 (km/h)

-25.5

-23 -20.5 -18

Figure D.2-10

-15.5 -13 -10.5 -8 -5.5 -3 -0.5 2 4.5
Peak Power / Avg. Power (dB)

Level crossing rate (Moving Speed = 583 km/h)

D-11



Appendix D Fading Characteristic Examples

D-12.



References are to page numbers.

Symbol and Numbers

1

T X T SISO e 3-57
IXEVDO B-11
2

2 X 2MIMO ..ottt 3-77
A

A (OFFSE) oo 3-36
Angle of Arrival .......cccovvviiiiiiiieee e, 3-30
AUto Setting......ooeeieeeiiiiieieeeeieeeiceeeee e, 3-47
AWGN L 3-25
AWGN Bandwidth..............coooo 3-25
B

B (Variation) .......cccccooveeeeeeveeeeeeeeeeeeeee e, 3-36
Bandwidth ......cooovvvieiiiiiiii 3-21, 3-29
Birth-Death Propagation..................... 3-37, 3-67
C

C/IN oo 3-26
Calculation & Load .........cooovvveeeiiiiiiiiiiiinnnnn. 3-52
Calculation & Play .......ccooovvvveiiieiiiiinineeneeen. 3-53
Calculation WindowW............oovvvueereeieeiiivinnnnnn. 3-50
CCDF graph.......eeeeeiiieeeiiiieieeeeeeeeecieeeee e 3-85
CDMAZ2000 ..ccoovieieiiiiiiiiiiiii B-9
Channel.......ccccoooo 3-27
Channel n Parameter fields (n =1 to 16) .... 3-28
Channel Setting field ..............ccoeevvvveeeeneennn. 3-23
COIMIMON ..ot 3-12
Correlation Coefficients ...........ccccceeveiinnnnin. 3-31
Correlation MatriX .......cooovvvveeneeiiiiiiiiiiieeeens 3-32
Correlation Setting.........cccccveeeeeeiiiiiineeeeeeeenn. 3-31
D

Delay ..o 3-30, 3-39
Delay Resolution ........ccccceeeeiiiiieieeeeecinnnnenn. 3-38
Displaying Graph ...........ccceevvvveeeieieeeicnnnnen. 3-85
DN 3-42
Doppler Frequency.....ccocooeeeeeeeeeeieeccecicecccnnnn. 3-24

Doppler spectrum ..........ccccevvvvveiiiiiiieiiienenn. D-2
DS 3-42
DVB-T oo B-20
Dwell time.....ccvvvvveeiiiiiiiiiiee e 3-38
E

Export File Window ........cccececvvivvereeenncnnnnnnn. 3-44
F

Fading Profile ........cccoovvveiiiiiiiiiinnn. 3-23, 3-28
Fading TYPe ...uveeeeeeeeiiiiiieei e, 3-29
FFT graph ... 3-87
Flat o D-3
G

GSM ..o e B-3
H

High Speed Train........ccccccceeeeevennnnnennn. 3-40, 3-72
HSDPA ...t B-6
HSUPA ... B-8
I

Input File ...oovvvvvveveiiiiiiiiiiiiiiieiiiiiiiiieii, 3-20, 3-28
Installation........ccccceeeveeiiiiiiieeeeieriiieee e 2-3
K

Kronecker Method..........cccceevveiiiiiiiiiiininnnns 3-33
L

LTE oot B-21
M

Main sereen.........ccceeeeeeveeeeeciiieeeeiee e 3-2
Marker 1 to Marker 3.........cccceeeeeevenviieennennn. 3-26
Marker OUtPut .....eeeeeeeeeeiiniieeeeeeeeeciireeeeeeeen 3-89
Master/Slave ........coeeeevviiiiiiiiiiiieeeieeeeeiinn C-3, C-7
Maximum Delay ........ccccevvvvvvvviiiiiiiiireenerennnn, 3-38
Maximum Doppler Frequency...................... 3-43
Mobile WiIMAX.......ccooviieeriieeeriieeeeereee e B-15
Moving Propagation ...........cccccceeeennnnns 3-35, 3-62
Moving Speed.......c..ccooeevvuveeeeeeeeeeennnee, 3-23, 3-43

Index-1




o
OMEZA evvveiieeeeeeeeeee e 3-36
Operating Environment...............cccoevvvveeennnn. 2-2
Output Gain.....cccvvveeeeeeieeeiieeeeee e 3-48
P
Parameter file
Reading.......ccooooviiiiiiiieee e, 3-55
SAVING ..vvvviieeeeeeeeeieeee e 3-54
Path .o, 3-29, 3-39
Path Alternate Setting........cccccceeeeeeeninnnnn... 3-39
Pattern length ........cccooeiiiiiiiiiii, 3-22
Pattern Length ......ccooooiiiiiiiiiiiiiiiiiiiiiiinn, 3-29
Pattern Sync Marker ...........ccccceeeeeeeeinnnnnennn. 3-26
Phase Shift.......cccoocviiieviiiiiiiieee e, 3-30
POWer...cooooiiiiiiiiiee 3-30, 3-36, 3-38
Power Delay Profile graph.............cccccuvvee... 3-34
Product Composition.......cccceeevevenveeeneennnnnnnnnnn. 1-5
Product overview........ccccceeveciiviieeeeeeeiiieeenn. 1-2
R
Random Seed........cccevveeiiiiiiiiiiiiieeeeee, 3-24
Repetition. ..o, 3-22
RF Frequency ...cccooeeeeeeeeeeeeeeeieeeeeeeeenn, 3-21, 3-28
Rice oo, D-4, D-5
Rician K factor....cooooeeeeeeevieiieiiiiiieeeenn, 3-30, 3-43
RMS Value ......ccoooeviviiiiiiieeiiieeee e, 3-47
Round Fading Pattern .........cccccoeeeeiiiiiinnnnnn. 3-24
Rounded .......ccoooiviiiiiiiiiiiiee, D-3
Rx Antenna Configuration field ................... 3-25
S
Sampling Rate ..........cccoevvvvveviieiieiiinnn, 3-21, 3-28
SG Master/Slave Setting...........cceeevvvveeeeennn. 3-25
Spectrum Shape ........ccooovvvveeeeeeeiiiiiineeeeeeen. 3-31
Start/Frame Trigger.......cccocceeeeeeiennnnnenn. C-1,C-5
T
TD-SCDMA......oooiiiieeeeeeeecee e B-10
Tx Antenna Configuration field.................... 3-20
U
Uninstallation.........cccocooveviiiiiniiinn, 2-3

W
Waveform Memory
Loading to......cccovvveeeiiiiieciiiieeeee e 4-4
Waveform pattern..........ccccceeeeeeeeeiiiineeeeeeeeeenn, 4-1
Generation Procedure............ccoeevvvvvenennnn. 3-57
SeleCting ...cvvvvveeieeeeiiiiiieeeee e 4-5
Transferring to internal hard disk.............. 4-2
W-CDMA ...ttt B-4
WELAN ..o B-12

Index-2.



	Cover
	Safety Symbols
	Software End-User License Agreement (EULA)
	About This Manual
	Table of Contents
	Chapter 1 Overview
	1.1 Product overview
	1.2 Product Composition

	Chapter 2 Preparation
	2.1 Operating Environment
	2.2 Installation/Uninstallation
	2.3 Starting up and exiting the software
	2.3.1 Starting Software: When installed on PC
	2.3.2 Starting Software: When installed on MG3710A/MG3740A
	2.3.3 Exiting Software


	Chapter 3 Detailed Description of Functions
	3.1 Screen Details
	3.1.1 Main screen
	3.1.2 Common tab window
	3.1.3 Channel tab window
	3.1.4 Moving Propagation tab window
	3.1.5 Birth-Death Propagation tab window
	3.1.6 High Speed Train tab window
	3.1.7 Export File window
	3.1.8 Calculation window
	3.1.9 Calculation & Load
	3.1.10 Calculation & Play

	3.2 Saving/Reading Parameters
	3.2.1 Saving a parameter file
	3.2.2 Reading a parameter file

	3.3 Waveform Pattern Generation Procedure
	3.3.1 1 ( 1 SISO waveform generation
	3.3.2 Moving Propagation waveform generation
	3.3.3 Birth-Death Propagation waveform generation
	3.3.4 High Speed Train waveform generation
	3.3.5 2 ( 2 MIMO waveform generation

	3.4 Displaying Graph
	3.5 Marker Output

	Chapter 4 How to Use Waveform Patterns
	4.1 For MG3700A, MG3710A or MG3740A
	4.1.1 Transferring waveform pattern to internal hard disk
	4.1.2 Loading to Waveform Memory
	4.1.3 Selecting Waveform Pattern


	Appendix A Error Messages
	Appendix B Fading Profile Details
	Appendix C Connecting Multiple MG3700A/10A/4
0A Units
	C.1 Connecting Multiple MG3700As
	C.2 Connecting Multiple MG3710A/MG3740As

	Appendix D Fading Characteristic Examples
	D.1 Doppler Spectrum
	D.2 Accumulated Probability Distribution/Level Crossing Rate

	Index

